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About This Guide

About This Guide

This guide describes how to install, configure, and use the webMethods SWIFT FIN
Module.

To use this guide effectively, you should:

Have a basic knowledge of SWIFT, SWIFT FIN, and SWIFT terminology. For more
information, go to_http://www.swift.com.

Have installed all necessary SWIFT software. You must work with SWIFT to
determine the appropriate software needs for your company.

Have installed webMethods Integration Server, webMethods Developer,
webMethods Trading Networks, webMethods Modeler, webMethods Monitor, and
the webMethods SWIFT FIN Module. For more information about installing these
components, see the webMethods Integration Platform Installation Guide and Chapter 2,
“Installing the webMethods SWIFT FIN Module”.

Be familiar with the webMethods Integration Server, the Server Administrator, and
webMethods Developer and understand the concepts and procedures described in
the webMethods Integration Server Administrator’s Guide and the webMethods Developer
User’s Guide.

Be familiar with Trading Networks Console and understand the concepts and
procedures described in the webMethods Trading Networks Concepts Guide and
webMethods Trading Networks User’s Guide.

Be familiar with webMethods Modeler and understand the concepts and procedures
described in the webMethods Modeler User’s Guide and Getting Started with webMethods
Business Process Management.

Be familiar with webMethods Monitor and understand the concepts and procedures
described in:

®  For webMethods Monitor 6.0.1, the webMethods Monitor User’s Guide

®m  For webMethods Monitor 6.1, the webMethods Integration Platform Installation
Logging and Monitoring Guide

Be familiar with webMethods Workflow and understand the concepts and
procedures described in the webMethods Workflow Concepts Guide and the webMethods
Workflow User’s Guide.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 9
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About This Guide

Document Conventions

Convention

Description

Bold

Identifies elements on a screen.

Italic

Identifies variable information that you must supply or change based
on your specific situation or environment. Identifies terms the first
time they are defined in text. Also identifies service input and output
variables.

Narrow font

Identifies storage locations for services on the webMethods
Integration Server using the convention folder.subfolder:service.

Typewriter
font

Identifies characters and values that you must type exactly or
messages that the system displays on the console.

UPPERCASE

Identifies keyboard keys. Keys that you must press simultaneously are
joined with the “+” symbol.

Directory paths use the “\” directory delimiter unless the subject is
UNIX-specific.

[]

Optional keywords or values are enclosed in [ ]. Do not type the [ ]
symbols in your own code.

Additional Information

The webMethods Advantage Web site at http://advantage.webmethods.com provides you
with important sources of information about your webMethods Integration Platform:

M Troubleshooting Information. The webMethods Knowledge Base provides
troubleshooting information for various webMethods components.

B Documentation Feedback. To provide documentation feedback to webMethods,
complete the Documentation Feedback Form on the webMethods Bookshelf.

B Additional Documentation. All of the webMethods documentation is available on the
webMethods Bookshelf.

10
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CHAPTER 1 Concepts

What Is the SWIFT Network?

SWIFT and its networks provide a secure, global financial IP-based messaging platform
that enables financial institutions to exchange formatted financial information and
transactional data. The SWIFT networks enable you to exchange SWIFT FIN messages
using the original SWIFT Transport Network (STN) or the new SWIFT Secure IP Network
(SIPN).

For more information about SWIFT, see the documentation provided by SWIFT or go to
http://www.swift.com.

What Is a SWIFT FIN Message?

SWIFT FIN messages transmit financial information from one financial institution to
another. These messages are classified into message categories. Each category contains a
number of messages relating to a particular topic, such as Category 5, which contains
messages related to Securities.

Each SWIFT message is represented by a three-digit number (for example, MT 541). The MT
represents SWIFI’s “‘Message Type’. The first number (5) identifies the category to which
the message belongs while the second and third numbers (41) identify the particular
message.

All SWIFT FIN messages conform to a defined block structure. SWIFT FIN messages
consist of a number of blocks, including one or more reference headers, the body text of
the message, and one or more control trailers. Each block within a message contains data
of a particular type, for a particular purpose, and begins and ends with a brace character
'{' and '}'. All main blocks are numbered, and the block number, followed by a colon, is
always the first character within any block (for example, 1:).

The body of each message consists of message tags (such as, 22F: :-MI1C0), each of which
correspond to a business name (Method of Interest Computation Indicator). The
values of a message tag follow the message tag itself (for example,

22F: :MICO/A2C4EBG8/A2C4).

Sample SWIFT FIN Message, MT 541, Receive Against Payment

{1:FO1CLSAHKHHXXXX0116013185}{2: 1541CLSAHKHHXXXXN}
{3:{108:MT535 004 OF 006}}
{4:

:16R:GENL

:20C: :SEME//01430
:23G:NEWM/CODU

:98C: :PREP//19991231232359
t99B::SETT//123

16R:LINK

:22F: :LINK/A2C4E6G8/A2C4
:13A::LINK//513

:20C: :PREV//X

12
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16S:LINK

:16S:GENL
16R:-TRADDET

194B: : TRAD//EXCH/30x

:97A: :CASH//x
97A: :SAFE//X
:16S:0THRPRTY

-}
For more detailed information about SWIFI FIN messages, see the documentation
provided by SWIFT or go to http://www.swift.com.

What Is the webMethods SWIFT FIN Module?

The webMethods SWIFT FIN Module enables the webMethods Integration Server to do
the following;:

B Receive inbound SWIFT FIN messages from other systems through one of SWIFT’s
networks.

B Convert SWIFT FIN messages into your back-end format and process according to
your settings.

B Send SWIFT FIN messages to the SWIFT network with correct header information
according to your settings.

The webMethods SWIFT FIN Module interfaces with SWIFT Alliance Access (SAA)
software via MQSA, CASmf, or AFT. SAA, in turn, communicates with SWIFTNet Link.
SWIFTNETLink, in turn, sends and receives messages securely via SWIFT Secure IP
Network (SIPN). SAA and SNL software modules are provided by SWIFT and have to be
installed and configured at a customer site by a SWIFT professional or by a trained expert.

The webMethods SWIFT FIN Module provides the ability to seamlessly integrate SWIFT
FIN messages as webMethods documents into a solutions architecture and validate those
messages at the syntax and network level. Messages sent and received by the
webMethods SWIFT FIN Module are validated at the individual field level and across the
fields using network validation rules. It also supports Market Practices among partners
located in a particular market.

The following diagram presents the entire webMethods SWIFT solution as you might use
it in conjunction with your back-end systems.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 13
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webMethods SWIFT Solution Architecture
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SWIFT FIN Message Support

webMethods parses and validates all SWIFT FIN messages in version 2005. But
webMethods supports network validation rules only for the following 2005 SWIFT FIN
messages:

MT 101 Request for Transfer

MT 103 Single Customer Credit Transfer

MT 103STP Single Customer Credit Transfer
MT 202 General Financial Institution Transfer
MT 300 Foreign Exchange Confirmation

MT 320 Fixed Loan/Deposit Confirmation

MT 502 Order to Buy or Sell

MT 515 Client Confirmation of Purchase or Sale

MT 535 Statement of Holdings

14 webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1
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MT 536 Statement of Transactions

MT 537 Statement of Pending Transactions

MT 540 Receive Free

MT 541 Receive Against Payment

MT 542 Deliver Free

MT 543 Deliver Against Payment

MT 544 Receive Free Confirmation

MT 545 Receive Against Payment Confirmation
MT 546 Deliver Free Confirmation

MT 547 Deliver Against Payment Confirmation
MT 548 Settlement Status and Processing Advice
MT 564 Corporate Action Notification

MT 565 Corporate Action Instruction

MT 566 Corporate Action Confirmation

MT 567 Corporate Action Status and Processing Advice
MT 568 Corporate Action Narrative

MT 900 Confirmation of Debit

MT 910 Confirmation of Credit

MT 940 Customer Statement Message

MT 942 Interim Transaction Report

MT 950 Statement Message

You also may create additional network validation rules for other SWIFT FIN messages
and versions. For steps to create validation rules, see “Creating Validation Rules” on
page 75 of Chapter 7, “Creating Message Records and Validation Rules” in this guide.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1
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webMethods SWIFT FIN Module Components

The following components comprise and support the webMethods SWIFT FIN Module:

B SWIFT FIN Packages. The webMethods SWIFT FIN Module includes a number of
packages containing3 services, mappings, records, and samples for using the
webMethods SWIFT FIN Module with the webMethods Integration Server. For a
complete list of packages, see “webMethods SWIFT FIN Module Packages” on
page 17 in this chapter.

B SWIFT Interfaces. You can connect to SWIFT using one of the following interfaces:

B MQSA (MQSeries Interface for SWIFTAlliance) To communicate with SWIFT using the
MQSA, you use the webMethods WebSphere MQ Adapter. For more information
about using the WebSphere MQ Adapter with the webMethods SWIFT FIN
Module, see “Using the webMethods WebSphere MQ Adapter to Communicate
with SWIFT” on page 54

m  CASmf(Common Application Server message format) To communicate with SWIFT
using CASmf, you use the webMethods CASmf Adapter. For more information
about using the webMethods CASmf Adapter, see “Using the CASmf Adapter to
Communicate with SWIFT” on page 56.

B AFT (Automated File Transfer) To communicate with SWIFT using AFT, you use the
File Polling Listener and File Drop capabilities. For more information about using
AFT with the webMethods SWIFT FIN Module, see “Using AFT to Communicate
with SWIFT” on page 62 of Chapter 5, “Configuring SWIFT Interfaces” in this
guide.

For more information about these interfaces, see Chapter 5, “Configuring SWIFT
Interfaces” on page 53.

B Integration Server. This is the underlying server of the webMethods Integration
Platform. You use the web-based user interface, the Server Administrator, to manage,
configure, and administer all aspects of the Integration Server, such as users, security,
packages, and services. For more information, see the webMethods Integration Server
Administrator’s Guide.

B webMethods Trading Networks. webMethods Trading Networks enables your enterprise
to link with other financial institutions and marketplaces to form a
business-to-business trading network. For more information, see the webMethods
Trading Networks Concepts Guide and the webMethods Trading Networks User’s Guide.

B webMethods Modeler. You use webMethods Modeler to create visual models of business
processes using process models. For more information, see the webMethods Modeler
User’s Guide and Getting Started with webMethods Business Process Management.

B webMethods Monitor. You use webMethods Monitor to manage and monitor business
processes. The Monitor displays information about a business process by retrieving
information from the Process Logging Database. For more information about using

16 webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1
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webMethods Monitor 6.0.1, see the webMethods Monitor User’s Guide. For more
information about using webMethods Monitor 6.1, see the webMethods Integration
Platform Installation Logging and Monitoring Guide.

B webMethods Workflow. You use webMethods Workflow as the natural extension of
webMethods Modeler. Modeler enables you to create Workflow steps that define the
tasks that require human intervention. When you generate your process models,

Modeler generates Workflow components for you. For more information, see the
webMethods Workflow User’s Guide.

webMethods SWIFT FIN Module Packages

The webMethods SWIFT FIN Module contains several packages (sets of webMethods
services and related files) that you install on the webMethods Integration Server. The
following table describes the contents of each package. For detailed information about the
contents of a package, see Appendix A, “webMethods SWIFT FIN Module Services” in

this guide.

Package Description

WmCASmf Contains support services used to send and receive SWIFT
FIN messages using CASmf.

WmFIN Contains services used to implement and support the
SWIFT FIN-compliant functionality of the webMethods
SWIFT FIN Module.

WmFINDev Contains the records and services that enable users to
create message records, TPAs, TN document types,
validation rules, and processing rules.

WmFINMarketPractice Contains 16 common services that support Market
Practices for some Category 5 SWIFT FIN messages.

WmFINSamples Contains services that demonstrate how to send and
receive SWIFT FIN messages using the webMethods
SWIFT FIN Module.

WmFINTransport Contains the services needed to send and receive SWIFT
FIN messages using Automated File Transfer (AFT) and
MQSeries.

WmIPCore Contains generic services for using the webMethods

SWIFT FIN Module with the webMethods Integration
Server.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 17
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webMethods SWIFT FIN Module Features

The webMethods SWIFT FIN Module, which runs on top of the webMethods Integration
Server, provides the following functionality:

B Current Messages. The webMethods SWIFT FIN Module always supports the latest
release of SWIFT FIN messages. The current SWIFT FIN Module supports May 2005
(which is the latest), November 2002, and November 2003 messages.

M Data Field Dictionary. The SWIFT FIN Module provides a data field dictionary (DFD)
based on the ISO 15022 standards for SWIFT FIN messages. This enables translation of
a message tag number (for example, 22F: : SFRE) into a meaningful business name (for
example, Statement Frequency Indicator). In addition, the SWIFT FIN Module
enables you to choose how you want to display each message in webMethods
Developer:

B Tag number only (for example, 22F: : SFRE)

B Equivalent message business name only (for example, Statement Frequency
Indicator)

B Both the tag number and the equivalent message business name
(for example, “22F: : SFRE_Statement Frequency Indicator)

B XML data tag (for example, F22FSFRE)

B Archiving messages. All SWIFT FIN messages can be archived in webMethods Trading
Networks.

B SWIFT Interfaces. The webMethods SWIFT FIN Module provides out-of-box support to
interface to SWIFT using MQSA, CASmf, and AFT. For this purpose, webMethods
provides the webMethods WebSphere MQ Adapter, the webMethods CASmf
Adapter, and the File Polling Listener. For more information, see Chapter 5,
“Configuring SWIFT Interfaces” on page 53.

B BIC and BIC+ Validation and Searching. A Bank Identification Code (BIC) is a unique code
assigned to a financial institution or one of its specific departments. The BIC for the
sender and receiver of a message appears in SWIFT FIN messages in the B1 (Basic
Header). SWIFT provides a list of valid BICs for all existing SWIFT financial
institutions. All SWIFT FIN messages are validated against the BIC or BIC+ list to
make sure the sender and receiver BICs are valid. In some SWIFT FIN messages, the
BIC appears in the B4 block. In these cases, the BIC code is validated against the BIC
or BIC+. You also can search for bank information based on the BIC code and bank
description. For more information, see Chapter 6, “Working with BIC and BIC+ Lists”
on page 65.

B Syntax and Network Validation. The SWIFT FIN Module enables you to validate the
message structure, field formats, and network rules of inbound and outbound SWIFT
FIN messages. webMethods provides network validation rules for a few commonly
used message types. In addition to these rules, the webMethods SWIFT FIN Module

18 webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1
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enables you to create network, Market Practice, and usage validation rules for
additional messages as well. For more information, see Chapter 7, “Creating Message
Records and Validation Rules” on page 71 and Chapter 13, “Working with Market
Practices” on page 113.

B Market Practices. Market Practices are specific requirements for individual markets.
Using Trading Partner Agreements (TPAs), the webMethods SWIFT FIN Module
supports the customization of SWIFT FIN messages based on specific trading partner
pairs. For more information about SWIFT-related Market Practices and TPAs, see
Chapter 9, “Customizing Trading Partner Agreements” on page 87 and Chapter 13,
“Working with Market Practices” on page 113.

B Processing rule support. You can use the webMethods Trading Networks processing
rules that you can choose to create along with each SWIFT message record instead
using the Process Run Time and process models to manage the execution of SWIFT
FIN messages. For information about creating processing rules, see the webMethods
Trading Networks User’s Guide.

B Process Modeling. This feature enables webMethods Modeler users to construct
complex, end-to-end processes depicting various document exchanges using the
Process Run Time. For more information about creating and modifying process
models for SWIFT, see Chapter 11, “Creating or Modifying a Process Model” on
page 105 or see the webMethods Modeler User’s Guide.

B SWIFT Error Codes. The webMethods SWIFT FIN Module supports SWIFT error codes
for field level and network validation. The webMethods SWIFT FIN Module also
supplies resource bundles so that all error codes can be localized.

B ntegration Server and SWIFTNet Clustering. The webMethods SWIFT FIN Module
supports multiple instances of the webMethods SWIFT FIN Module talking to one
instance of SWIFTNet, as well as multiple instances of SWIFINet talking to multiple
instances of the webMethods SWIFT FIN Module.

B Subfield Parsing. The webMethods SWIFT FIN Module automatically parses messages
into blocks and fields. You can configure the SWIFT FIN Module to further parse the
fields into subfields using the subfieldFlag variable, which is included in the following
services:

®  wm.fin.dev:iimportFINIitem This service creates all items needed in a SWIFT FIN
Message transaction, including the TPA with the SubfieldFlag parameter set to
true.

®  wm.fin.dfd:convertTagFormat This service converts FIN IData from TAGONLY to a
specified format.

®m  wm.fin.dfd:convertBizNameFormat This service converts FIN IData from a specified
format to TAGONLY.

For inbound SWIFT FIN messages, setting the subfieldFlag variable to true causes the
webMethods SWIFT FIN Module to automatically parse messages to the subfield
level and then remove the SWIFT delimiter (/) from between subfields. For outbound

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 19



CHAPTER 1 Concepts

SWIFT FIN messages, setting the subfieldFlag variable to true causes the webMethods
SWIFT FIN Module to add the SWIFT delimiter (/) between subfields.

webMethods SWIFT FIN Module Architecture

The webMethods SWIFT FIN Module uses either the publish and subscribe Process Run
Time (PRT) functionality of the webMethods Integration Server, or webMethods Trading
Networks processing rules to send and receive SWIFT FIN messages. It leverages the
archiving, TPA, and document type components of the webMethods Trading Networks to
work with your enterprise to exchange SWIFT FIN messages.

webMethods SWIFT FIN Module Architecture

Back-end Applications
and Systems

! !

Back-office SWIFT FIN Packages
S <« >
Applications

webMethods

Integration Platform

Front-office : . p
- > Integration : Business Activity .
Applications Server Messaging Monitoring el fer?
Trading
View of the Networks
>
System

webMethods SWIFT FIN Module

SWIFT
SAA «——SWIFTFIN——»
STN
SAG “> SNL «SWIFTNetFIN-»>

SIPN

The webMethods SWIFT FIN Module consists of a set of design-time and run-time components, both of which are
discussed in this chapter. For information about design-time components, see “Design-Time Architecture/Com-
ponents” on page 21. For information about run-time components, see “Run-Time Architecture/Components” on
page 24.

When the webMethods SWIFT FIN Module creates an outbound document, it formats,
validates, and publishes the SWIFT message. When the webMethods SWIFT FIN Module
receives an inbound document, it parses, formats, validates, and publishes the message
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for a back-end application. To communicate with SWIFT using the SAA (SWIFT Alliance
Access), you use the webMethods WebSphere MQ Adapter to interface with MQSA, the
webMethods CASmf Adapter to interface with CASmf, or the File Polling Listener and
File Drop capabilities to interface with AFT. The following diagram illustrates the end-to-
end architecture of the webMethods SWIFT FIN Module FIN messaging solution.

webMethods SWIFT FIN Messaging Architecture

webMethods
Integration Server

webMethods
FIN Packages

| webMethods
mMa

wobMethods
CASmf

| File Polling

Design-Time Architecture/Components

The following figure illustrates the design-time architecture, components, and component
relationships of the webMethods SWIFT FIN Module, and the component relationships.
For further explanation, see the table that follows the next figure.
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Design-Time Architecture/Components
webMethods Integration Server

webMethods FIN Model
SWIFT FIN -
Module

Component Description

webMethods The webMethods SWIFT FIN Module enables you to manage the
SWIFT FIN execution of SWIFT FIN messages using either process models or
Module Trading Networks processing rules. It contains sample process

models that you can use to define new process models using
Modeler, and enables you to install processing rules.

webMethods Trading Networks enables your enterprise to link to financial
Trading institutions with whom you want to exchange SWIFT FIN
Networks messages. During design time, you define your trading partner

profiles in the Trading Networks Console. The profiles contain the
information that your system needs to exchange messages with
other financial institutions.

In addition to defining trading partner profiles in the Trading
Networks Console during design time, you also can customize the
TPAs and view the TN document types that are created when you
create your message records. For more information about Trading
Networks, trading partner profiles, TN document types, and
TPAs, see the webMethods Trading Networks User’s Guide. You also
can find information about trading partner profiles and TN XML
document types in Chapter 8, “Defining Trading Partner Profiles
and TN Document Types”, and information about TPAs in
Chapter 9, “Customizing Trading Partner Agreements” in this
guide.

TN Database Trading Networks saves trading partner profiles, TN document
types, and TPA information, among other things, to its database
and retrieves this information when needed.
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Component

Description

webMethods
Modeler

Modeler is a Java GUIL You use Modeler to create process models,
which you can base on the samples provided by webMethods. You
create a process model by specifying how the process model is to
interact with your back-end systems, specifying the services that
are invoked by the steps of the process model, and using TN
document types as inputs, among other things. When you
generate a process model, the system generates the run-time
elements (services, triggers, and process fragments). For more
information about Modeler, see the webMethods Modeler User’s
Guide. For information about customizing a process model, see
Chapter 11, “Creating or Modifying a Process Model” in this
guide.

Note: You can use webMethods Trading Networks processing rules
installed with each SWIFT message record instead of the Process
Run Time and process models to manage the execution of SWIFT
FIN messages. For information about creating processing rules, see
Chapter 4, “Sending and Receiving SWIFT Messages” in this
guide.

Modeler
Database

The Modeler database is a storage area that Modeler uses to save
process model and run-time information. For more information
about the Modeler database, see the webMethods Modeler User’s
Guide.

webMethods
Integration
Server

The Integration Server contains the documents, services, and IS
documents that you will want to access when creating your
process models.
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Run-Time Architecture/Components

The following figure illustrates the run-time architecture, components, and component
relationships of the webMethods SWIFT FIN Module. For further explanation, see the
table that follows the next figure.

Run-Time Architecture/Components

webMethods Integration Server

Annotated
webMethods Process

SWIFT FIN
Module Process

Run Time

v

Component Description

webMethods During run time, the webMethods SWIFT FIN Module receives a
SWIFT FIN message from a back-end system. It invokes a Trading Networks
Module service to recognize the message. The webMethods SWIFT FIN

Module may pass the message to the Process Run Time (PRT). For
more information about the PRT, see the Process Run Time row in
this table and the webMethods Modeler User’s Guide.

Note: You can use webMethods Trading Networks processing rules
installed with each SWIFT message record instead of the Process
Run Time and process models to manage the execution of SWIFT
FIN messages. For information about creating processing rules, see
Chapter 4, “Sending and Receiving SWIFT Messages” in this
guide.
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Component

Description

webMethods
Trading
Networks

Trading Networks enables your institution to link to the financial
institutions with whom you want to exchange messages.

During run time, the webMethods SWIFT FIN Module uses
Trading Networks services and TN document types to recognize
messages that it receives, create BizDocEnvelopes, and save
BizDocEnvelopes to the Trading Networks database. The
webMethods SWIFT FIN Module uses the trading partner profiles
in Trading Networks to identify, for example, the method by
which to send messages to other financial institutions.

You can find information about trading partner profiles and TN
document types in Chapter 8, “Defining Trading Partner Profiles
and TN Document Types”, and information about TPAs in
Chapter 9, “Customizing Trading Partner Agreements” in this
guide. For more information about Trading Networks, trading
partner profiles, TN document types, and TPAs, see the
webMethods Trading Networks User’s Guide.

TN Database

The Trading Networks database stores TN document types, TPA,
and trading partner profile information, among other things.

webMethods
Monitor

You use Monitor to manage and monitor processes. Monitor
displays information about a process by retrieving information
from the Process Logging Database. You manage a process by
performing such commands as suspend, resume, restart, and
terminate.
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Component Description
Process Run The Process Run Time (PRT) is a facility of the Integration Server
Time that manages the execution of SWIFTNet processes. The PRT

ensures the integrity, traceability, observability, and controllability
of SWIFTNet processes by performing the following functions:

B Accepting messages from Trading Networks.
B  Determining which process model to use for a given message.

B Processing a message based on the type of message received
and who sent it.

B Recording the status of the message to the Process Logging
Database.

Note: You can use webMethods Trading Networks processing rules
that you can install with each SWIFT message record instead of the
Process Run Time and process models to manage the execution of
SWIFT FIN messages. For information about creating processing

rules, see Chapter 4, “Sending and Receiving SWIFT Messages” in

this guide.
Process Logging ~ webMethods Monitor and the PRT log and retrieve audit data
Database about running processes to and from the Process Logging
Database.
webMethods The Integration Server contains the run-time elements (services,
Integration triggers, and process fragments) that were generated by the
Server automated controlled steps within the process model.
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Overview

This guide provides system requirements for the webMethods SWIFT FIN Module 6.1
(SWIFT FIN Module) and provides installation, upgrade, and uninstallation instructions.

Important! The information in this chapter might have been updated since the guide was
published. Go to the webMethods Advantage Web site at
http://advantage.webmethods.com for the latest version of the guide.

If you are installing the SWIFT FIN Module 6.1 with other webMethods components such
as the webMethods Integration Server, see the webMethods Installation Guide for
instructions on installing those components.

Requirements

This section describes the requirements that must be met before you can install the
webMethods SWIFT FIN Module.

Platform and Operating System Requirements

The following table lists the supported platforms for the webMethods SWIFT FIN
Module. For each platform, the webMethods SWIFT FIN Module supports the same Java
Runtime Environments (JREs) as the version of the webMethods Integration Server on
which you are installing the SWIFT FIN Module.

Platform and Operating System

Hewlett-Packard HP-UX 11i and 11.0
Microsoft Windows NT 4.0 SP4

Microsoft Windows 2000 and XP Professional
Sun Solaris 2.8, 2.7

Red Hat Enterprise Linux 4.0
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Requirements

webMethods Software Requirements

The following table lists the webMethods components you must install before you can
install the webMethods SWIFT FIN Module:

Component Version

webMethods Integration Server 6.0.1, 6.1, or 6.5
webMethods Developer 6.0.1, 6.1, or 6.5
webMethods Trading Networks 6.0.1,6.1, or 6.5

Because the webMethods SWIFT FIN Module requires a method of communicating with
SWIFT, it is recommended that in addition to the above components, you also install one
of the following webMethods components:

Component Version
webMethods CASmf package® 6.1
webMethods WebSphere MQ Adapter 6.0 or 6.5

fwebMethods CASmf package is currently only supported on the Windows platforms that the
Integration Server you are running supports.

For more information about the webMethods CASmf Adapter and the webMethods
WebSphere MQ Adapter, see Chapter 5, “Configuring SWIFT Interfaces” in this guide.

The following table lists the webMethods components you should install if you plan to
use process models to manage the execution of SWIFT FIN messages.

Component Version
webMethods Modeler 6.1.5 or 6.5
webMethods Monitor 6.1.5 or 6.5
Process Runtime® 6.5

*Process Runtime 6.5 is only required when you are running Integration Server 6.5. Starting with 6.5, the
Process Runtime is installed separately. With previous versions of the Integration Server (i.e., versions
6.0.1 and 6.1), the Process Runtime was included with the Integration Server.

Third-Party Software Requirements

If you are using CASmf as the interface to SWIFT, you must install a CASmf client
(provided by SWIFT) on your Integration Server. For more information, see your SWIFT
documentation or go to http://www.swift.com.
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Hardware Requirements

The webMethods SWIFT FIN Module does not have any requirements beyond those of its
host Integration Server.

Installing the webMethods SWIFT FIN Module

A Important! This section provides instructions that are specific to installing the webMethods
SWIFT FIN Module. For complete instructions on using the using the webMethods
Installer, see the webMethods Installation Guide.

Install webMethods SWIFT FIN Module 6.1 and the needed SWIFT message records on
the same machine as Integration Server. The installer will automatically install the
webMethods SWIFT FIN Module in the Integration Server installation directory.

A Important! You must have administrator privileges on the webMethods Integration Server
to execute these procedures. If you do not have administrator privileges, have your
webMethods Integration Server administrator perform these procedures.

- To install the webMethods SWIFT FIN Module

1 Download the latest webMethods Installer from the webMethods Advantage Web site
at http://advantage.webmethods.com.

2 Ifyou are going to install the webMethods SWIFT FIN Module on an already installed
Integration Server, shut down the Integration Server.

3  Start the installer.

4 Select the webMethods platform on which to install the webMethods SWIFT FIN
Module. If you are going to install it on an existing Integration Server, select the
platform that matches the release of that Integration Server. For example, if you are
going to install webMethods SWIFT FIN Module on a 6.1 Integration Server, select the
6.1 platform.

5 Specify the SWIFT FIN Module installation directory as the webMethods installation
directory (by default, webMethods6).

6 In the component selection list, navigate to webMethods Integration
Platform » eStandards » webMethods webMethods SWIFT FIN Module 6.1. Select the
components you want to install:

®m  Documentation (Optional). Contains the documentation for webMethods SWIFT
FIN Module.

®  Program Files (Required). Contains the program files for this package.
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m  Samples (Optional). Contains the services that demonstrate how to send and
receive SWIFT FIN messages over SWIFINet.

7 If the Integration Server is not yet installed, also select to install the Integration Server,
as well as any other required webMethods components that are not already installed.

8 The installer installs the webMethods SWIFT FIN Module packages in the Integration
Server_directory/packages directory. For more information about the packages that are
installed, see “webMethods SWIFT FIN Module Packages” on page 17.

9  Click Next until the installer displays the Installation Complete panel.

10 Click Close.

11 If you are using the webMethods Broker with the webMethods Integration Server:
a Navigate to and open the following file:

webMethods6 \ IntegrationServer\packages\WmF IN\transport\config\
fintransport.cnf

where webMethods6\ IntegrationServer is the location of the webMethods
Integration Server.

b Change the fin.message.publishLocal parameter to false to enable publication of
messages to the Broker.

The webMethods SWIFT FIN Module starts automatically when you start the
webMethods Integration Server.

Upgrading the webMethods SWIFT FIN Module

This section describes how to upgrade from previous versions of the webMethods SWIFT
FIN Module to webMethods SWIFT FIN Module Version 6.1.

Upgrading from webMethods SWIFT FIN Module 6.0.1 or 6.0.1
SP2

When you want to upgrade from the webMethods SWIFT FIN Module 6.0.1 or
6.0.1 Service Pack 2, you need to complete the following steps:

1 Download the latest webMethods Installer from the webMethods Advantage Web site
at http://advantage.webmethods.com.

2 If you are going to install webMethods SWIFT FIN Module on an already installed
Integration Server, shut down the Integration Server.

3  Start the installer.

4 Select the webMethods platform on which to install the webMethods SWIFT FIN
Module. If you are going to install it on an existing Integration Server, select the
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platform that matches the release of that Integration Server. For example, if you are
going to install webMethods SWIFT FIN Module on a 6.1 Integration Server, select the
6.1 platform.

Specify the SWIFT FIN Module installation directory as the webMethods installation
directory (by default, webMethodsb6).

In the component selection list, navigate to webMethods Integration
Platform » eStandards » webMethods webMethods SWIFT FIN Module 6.1. Select the
components you want to install:

®  Documentation (Optional). Contains the documentation for webMethods SWIFT
FIN Module.

®  Program Files (Required). Contains the program files for this package.

m  Samples (Optional). Contains the services that demonstrate how to send and
receive SWIFT FIN messages over SWIFINet.

The installer installs the webMethods SWIFT FIN Module packages in the Integration
Server_directory/packages directory. For more information about the packages that are
installed, see “webMethods SWIFT FIN Module Packages” on page 17.

Click Next until the installer displays the Installation Complete panel.
Click Close.
After the installation, remove the following:

B The Integration Server_directory\ packages\ WmFINDev\ns\wm\ fin\ migration
directory

B The Integration Server_directory\ packages\ WmFINDev\import\mapTemplates
directory

B The following files from the
Integration Server_directory\ packages\ WmFINDev \import directory:

B finConvMT520ToMT540.xml
B finConvMT521ToMT54.xml

B finConvMT522ToMT542.xml
B finConvMT523ToMT543.xml

B The Integration
Server_directory\ packages\ WmFINDev\ns\wm\ fin\ dev\updateBizName
directory

B The Integration
Server_directory\ packages\ WmFIN \ns\ wm \ fin\ mappingFunctions directory
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B The Integration
Server_directory\ packages\ WmFIN\ code\ classes\ wm \ fin\ mappingFunctions.class
file

B The Integration
Server_directory\ packages\ WmFINDev \ code\ classes\ wm \ fin\ migration.class
file

Upgrading from webMethods SWIFT FIN Module 4.6

When you want to upgrade from the webMethods SWIFT FIN Module 4.6 to webMethods
SWIFT FIN Module 6.1, you need to complete the following steps:

1 Uninstall your webMethods Integration Server 4.6 as described in “Uninstalling the
webMethods SWIFT FIN Module” on page 33.

2 Install a version of webMethods Integration Server that webMethods SWIFT FIN
Module 6.1 supports. To see a list of Integration Server versions, see
“webMethods Software Requirements” on page 29. For more information about
upgrading from webMethods Integration Server 4.6 to a later version, see the
appropriate upgrade procedures, which are on the webMethods Advantage
Bookshelf.

3 Install the webMethods SWIFT FIN Module 6.1 as described in “Installing the
webMethods SWIFT FIN Module” on page 30.

Uninstalling the webMethods SWIFT FIN Module

, Important! This section provides instructions that are specific to uninstalling the
webMethods SWIFT FIN Module using the webMethods Uninstaller. For complete
instructions on using the webMethods Uninstaller, see the webMethods Installation Guide.

You can completely uninstall the webMethods SWIFT FIN Module or only selected
portions. Both procedures are explained below.

- To completely uninstall the webMethods SWIFT FIN Module

1 Uninstalling the webMethods SWIFT FIN Module will remove all components in the
SWIFT FIN Module packages. If you want to keep certain records or services that you
use with the existing SWIFT FIN Module packages on your webMethods Integration
Server, export them to a new package:

a From webMethods Developer, select the package to export.
b Select File » Export.
2 Shut down the Integration Server that hosts the SWIFT FIN Module 6.1
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3 Start the webMethods Uninstaller, as follows:

System Instructions

Windows  In the Add or Remove Programs window, select webMethods release
installation_directory as the program to uninstall, where release and
installation_directory are the release and installation directory of the
Integration Server on which the SWIFT FIN Module is installed.

UNIX Navigate to the webMethods_directory/bin directory of the installation
that includes the Integration Server on which the SWIFT FIN Module
is installed and enter uninstall (wizard) or uninstall -console (console
mode).

4 In the component selection list, navigate to webMethods Integration
Platform » eStandards » webMethods SWIFT FIN Module.

5 The uninstaller removes all webMethods SWIFT FIN Module-related files that were
installed into the Integration Server_directory\ packages directory. The uninstaller does
not delete files created after you installed the webMethods SWIFT FIN Module (for
example, user-created or configuration files), nor does it delete the directory structure
that contains the files.

6 If you want to delete the files that the uninstaller did not delete, navigate to the
Integration Server_directory\ packages directory and delete the WmFIN-related folders.

- To uninstall selected portions of the webMethods SWIFT FIN Module

1 Start the webMethods Integration Server and the Server Administrator that hosts the
webMethods SWIFT FIN Module.

2 Under the Packages menu in the Server Administrator navigation area, click
Management.

3 From the Package list, locate the following packages:
® WmFIN
B WmFINDev
B WmFINMarketPractice
B WmFINMessages
B WmFINSamples
®  WmFINTransport
®  WmlIPCore

4 Select one of the following options for each of the desired packages you want to
delete:
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B Select Delete to delete the package without keeping a backup copy.

B Select Safe Delete to remove the package and keep a backup copy. (Backup copies
are stored in the ServerDirectory\replicate\ salvage directory on the server.)

5 Refresh your Web browser. The selected packages are removed.

B 1o uninstall the webMethods SWIFT FIN Module Service Pack

1 The instructions in the webMethods Installation Guide say to shut down all webMethods
components and applications that are running on your machine. For webMethods
SWIFT FIN Module, you need to shut down only the Integration Server.

2 Select the Service Pack in the webMethods SWIFT FIN Module as the program to uninstall.

3 The uninstaller removes all webMethods SWIFT FIN Module-related files that were
installed into the Integration Server_directory\ packages directory. The uninstaller does
not delete files created after you installed the webMethods SWIFT FIN Module (for
example, user-created or configuration files), nor does it delete the directory structure
that contains the files.
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How Do | Use the webMethods SWIFT FIN Module?

This chapter describes how to configure your webMethods Integration Server to prepare
to send and receive SWIFT FIN messages using the services in the webMethods SWIFT
FIN Module. The subsequent chapters in this guide provide more detailed information
about each of these steps.

After you have completed the steps in this chapter, see Chapter 4, “Sending and Receiving
SWIFT Messages” in this guide for detailed information about sending and receiving
SWIFT FIN messages.

For a sample of how to use the webMethods SWIFT FIN Module to send and receive
SWIFT FIN messages, see Appendix C, “webMethods SWIFT FIN Module Sample” in this
guide.

A Important! The following steps assume that you already have installed the webMethods
Integration Server, webMethods Trading Networks, webMethods Modeler, webMethods
Monitor, the necessary SWIFT software, the webMethods SWIFT FIN Module packages,
and the appropriate software for the SWIFT interface that you want to use. For more
information about what SWIFT software you need, work with SWIFT to determine your
software needs. For more information about installing the webMethods SWIFT FIN
Module, see Chapter 2, “Installing the webMethods SWIFT FIN Module” on page 27.

Step 1: Configure SWIFT Interfaces

Use the instructions in the following section to configure the SWIFT interface you are
using:

To configure this

SWIFT interface... Use instructions in this section...

MQSA “Using the webMethods WebSphere MQ Adapter to
Communicate with SWIFI” on page 54

CASmf “Using the CASmf Adapter to Communicate with SWIFT” on
page 56

AFT “Using AFT to Communicate with SWIFT” on page 62
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Step 2: Import a SWIFT BIC or BIC+ List

To uniquely identify each financial institution or one of its specific departments, SWIFT
assigns a Bank Identification Code (BIC) to a each entity. SWIFT publishes a list of valid
BICs for all existing SWIFT financial institutions in the SWIFT BIC and BIC+ directories.
All SWIFT FIN messages are validated against the BIC or BIC+ list to make sure the sender
and receiver are valid.

To import a list, you first must create a database table to hold the BIC or BIC+ list. For
steps to create a BIC or BIC+ database table and import a BIC or BIC+ list into
webMethods Integration Server, see “Importing BIC and BIC+ Lists” on page 66.

Step 3: Create Message Records

For each SWIFT message that you want to exchange with your partner financial
institutions, you must do the following to create a message record:

B Install the SWIFT message DFD for the message (which includes a parsing template)
into the webMethods SWIFT FIN Module.

B Run the wmfin.dev:importFINltems service for the message DFD.

For more information about creating message records, see Chapter 7, “Creating Message
Records and Validation Rules” on page 71.

Step 4: Define Trading Partner Profiles

In the Trading Networks Console, you define the trading partner profiles for yourself and
all financial institutions with which you want to exchange SWIFT FIN messages.

For more information about defining trading partner profiles for use with the
webMethods SWIFT FIN Module, see Chapter 8, “Defining Trading Partner Profiles and
TN Document Types” on page 79.

Step 5: Modify Trading Partner Agreements

When running the wm.fin.dev:importFiNltems service for a message DFD to create a record,
you can select to create a corresponding trading partner agreement (TPA), which is a set
of parameters that governs how you exchange this SWIFT message with a trading partner.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 39



CHAPTER 3 Getting Started

Before you can use a TPA, you must modify its parameters to process the message
according to your company’s needs, and then set the TPA’s status to “Agreed”.

Important! The SubfieldFlag input parameter in the TPA supports the parsing of SWIFT
messages to the subfield level. If you change the value of the SubfieldFlag after creating the

message records, you must delete the message records pertaining to the TPA and recreate
them.

For information about modifying TPAs for use with SWIFT FIN messages, see Chapter 9,
“Customizing Trading Partner Agreements” on page 87.

Step 6: Write Inbound and Outbound Mapping Services

To send and receive messages, you create inbound and outbound mapping services that
define how each message will be handled. These services are used in the management of
SWIFT message execution, which you define in the next step.

B You create an outbound mapping service to map an internal message received from the
back-end to a SWIFT message that you want to send to another financial institution.

B You create an inbound mapping service to map a SWIFT message received from a
another financial institution to an internal message that is then sent to a back-end
system.

For more information about mapping business documents, see Chapter 10, “Mapping a
SWIFT FIN Module Process” on page 97.

Step 7: Manage SWIFT Message Execution

To manage the execution of SWIFT FIN messages, you can use either the Process Run
Time (PRT) and a process model, or the webMethods Trading Networks processing rule
that you can choose to create when creating the SWIFT message record.

Executing Messages Using the PRT and Process Models

Based on the SWIFT FIN messages you are using, you can use or modify one of the
sample process models provided by webMethods in the

webMethods6 \ IntegrationServer \ packages\ WmFINSamples\ data directory, where
webMethods6 \ IntegrationServer is the location of the webMethods Integration Server, or
you can create your own process models from scratch.
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To begin using the webMethods SWIFT FIN Module to send and receive SWIFT FIN
messages using the Process Run Time to manage the execution of SWIFT FIN messages,
you must run the process models that you create.

B For information about sending and receiving SWIFT FIN messages using the PRT and
process models, see Chapter 4, “Sending and Receiving SWIFT Messages” on page 43.

B  For information about working with process models and SWIFT FIN messages, see
Chapter 11, “Creating or Modifying a Process Model” on page 105.

B For information about starting and monitoring a SWIFT business process, see
Chapter 12, “Monitoring a Process” on page 109.

B For general information about the webMethods Modeler, see the webMethods Modeler
User’s Guide and Getting Started with webMethods Business Process Management.

Executing Messages Using TN Processing Rules

A webMethods Trading Networks processing rule enables you to manage the execution
of SWIFT FIN messages without using the PRT. If you choose to create a processing rule
for a SWIFT FIN messages, the rule is created in the WmFINMessages package in the
appropriate version folder (for example, webMethods6\IntegrationServer\packages\
WmF INMessages\may05).

For information about sending and receiving SWIFT FIN messages using processing
rules, see Chapter 4, “Sending and Receiving SWIFT Messages” on page 43. For general
information about using processing rules, see the webMethods Trading Networks User’s
Guide.
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Overview

The webMethods SWIFT FIN Module enables you to send and receive a SWIFT message
using either a business process (which uses the Process Run Time) or a Trading Networks
processing rule.

Sending Outbound Messages to SWIFT

You can send outbound messages to SWIFT using either a business process or a service
that is invoked by a Trading Networks processing rule.

Sending Outbound Messages Using a Business Process

When you use a business process, you are using the Process Run Time (PRT), which is a
facility of the Integration Server that manages the execution of business processes. To use
a business process (also called a conversation) to send outbound SWIFT FIN messages,
you use webMethods Modeler to create a process model that defines the steps that you
want to take in your business process. As a guideline, see the sample process model
(CorpActions_Account Servicer) provided in the SWIFT FIN Module sample. For more
information, see Appendix C, “webMethods SWIFT FIN Module Sample” on page 175.

After designing the process model, use webMethods Modeler to generate it. When you
generate a process model, webMethods Modeler generates the run-time elements (for
example, triggers, flow services, etc.) that are executed for the business process.

The first step of a business process is a step that waits for a document. At run time, you
send a back-end document to the Integration Server. The Integration Server passes the
document to the PRT, which determines the process model to use for the document and
either instantiates a new instance of the process model to start the business process, or
when subsequent documents aimed at the business process arrive, the PRT delivers them
to the appropriate business process to rejoin a running process.

The PRT uses the Conversation ID to determine whether documents belong to the same
instance of a business process. All documents that belong to the same instance of a
business process use the same Conversation ID.

Before You Can Send Outbound Messages

B Define a TN document type for the back-end format document that you will convert
to a SWIFT FIN message. For instructions to create TN document types, see the
webMethods Trading Networks User’s Guide.

When you create this TN document type, be sure to extract the SenderlD and ReceiveriD
system attributes. The values you extract for the SenderlD and ReceiverID should be the
sender’s and receiver’s BIC, respectively.
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B Create two TPAs as described in the following tables:

TPA One -- Used by first step of the business process

Sender The sender of the back-end document -OR- Unknown.

If you specify a specific partner for Sender, you must specify a
specific partner for Receiver. Likewise, if you specify Unknown
for Sender, you must specify Unknown for Receiver.

Receiver The receiver of the SWIFT FIN message that is to be sent to
SWIFT.
AgreementID Name of the TN document type for the back-end system

format document.

IS Document Type wm.Fin.doc:UserParameters

TPA Two -- Used to govern the creation and sending of the outbound SWIFT FIN message

Sender The sender of the back-end document -OR- Unknown.

If you specify a specific partner for Sender, you must specify a
specific partner for Receiver. Likewise, if you specify Unknown
for Sender, you must specify Unknown for Receiver.

Receiver The receiver of the SWIFT message that is to be sent to
SWIFT.
AgreementID User-defined. You might want to specify a name that

identifies the type of SWIFT FIN message that the TPA
governs, for example, MT564.

IS Document Type wm.Fin.doc:UserParameters

Designing the Process Model

Your process model will typically contain the following steps:

1 Wait for the document from the back-end system -and- invoke the wm.ip.cm:waitSteplnit
service. This service takes the actions necessary to prepare for the business process.
During processing, it retrieves the TPA associated with the AgreementID set to the
name of the TN document type. Processing will fail if the first step does not invoke
this service -or- if the service fails to retrieve the TPA.

2 Invoke a mapping service to map to the SWIFT FIN message.

a Map data from the back-end system document to webMethods DFD format,
which represents the {B4} block of the SWIFT FIN message.

b Add the payload variable to the existing documents variable in the pipeline, and
then set the documents/payload variable to the IData object that represents the
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3

webMethods DFD format document. For an example of how to do this, see the
outbound map service provided in the WmFINSamples package.

Add the tpaAgreementID variable to the existing documents variable in the pipeline,
and then set the documents/tpaAgreementID variable to the AgreementID
associated with the second TPA, which governs the creation and sending of the
outbound SWIFT FIN message.

Invoke the wm.fin.trp:send service to send the SWIFT FIN message to SWIFT. This
service:

a

Creates the header blocks {B1-B3} and {B5} using information from the second
TPA that you created.

Determines whether to validate the SWIFT message using the Validate...
parameters in the second TPA. If any of the Validate... parameters for example,
ValidateContent) are set to yes, the service performs the appropriate validation.

Sends the SWIFT FIN message using the transport specified in the message TPA
(for example, MQ, CASmF, AFT).

Executing the Business Process

To run the business process, send the back-end system document that starts the business
process to the Integration Server by invoking the wm.ip.cm:processDocument service. The
wm.ip.cm:processDocument service performs the following actions:

Recognizes the back-end system document using TN document types.

Forms a BizDocEnvelope for the back-end system document.

Sets the Conversation ID for the back-end system document.

If this is the first document of a business process, the processDocument service sets
the Conversation ID to the <Sender’s BIC>-<Unique IDentifier>. This unique
identifier is mapped into the MUR section in {B3} block of the outgoing SWIFT
FIN message.

If this document is to join a running business process, you must supply the
Conversation ID and pass it as input to the processDocument service.

Saves the content of the back-end system document to the Trading Networks
database.
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B Passes the back-end system document to the PRT. When the PRT receives the
back-end system document, it determines whether this is the first document for a
business process, or whether it is a document that is rejoining a running business
process. If it is the first document of a business process, the PRT instantiates a new
instance of the process model. Otherwise, it sends the document to rejoin a running
business process.

Note: When you use the wm.ip.cm:processDocument service, the document does not go through
typical Trading Networks processing. This service invokes the Trading Networks services
it needs to accomplish the tasks described above. The document does not go to Trading
Networks processing rules.

Sending Outbound Messages Using a Processing Rule

To use a processing rule to send outbound SWIFT FIN messages, you define a processing
rule in Trading Networks that invokes a service to send the message.

Before You Can Send Outbound Messages

B Define a TN document type for the back-end format document that you will convert
to a SWIFT message. For instructions to create TN document types, see the
webMethods Trading Networks User’s Guide.

When you create this TN document type, be sure to extract the SenderlD and Receiver|D
system attributes. The values you extract for the SenderlD and ReceiverID should be the
sender’s and receiver’s BICs, respectively.

B Create a TPA as described in the following table:

TPA used to govern the creation and sending of the outbound SWIFT message

Sender The sender of the back-end document -OR- Unknown.

If you specify a specific partner for Sender, you must specify a
specific partner for Receiver. Likewise, if you specify Unknown
for Sender, you must specify Unknown for Receiver.

Receiver The receiver of the SWIFT message that is to be sent to
SWIFT.
Agreement|D Name of the TN document type for the back-end system

format document.

IS Document Type wm_fin.doc:UserParameters
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Defining the Processing Rule

For instructions to define processing rules, see the webMethods Trading Networks User’s
Guide. The following sections describe specific settings that you should use when defining
your processing rule for use with SWIFT messages.

P

rocessing Rule Criteria

Set the following criteria on the Criteria tab of the processing rule.

Criteria tab field Set to...

Document Type The TN document type for the back-end format document.

Setting Processing Actions

On the Action tab, select Perform the following actions, and then set the following fields on the
Action tab of the processing rule.

Action tab field Set to...

Execute a service A service you created that maps the back-end format
document to webMethods DFD format. For more
information about creating this service, see “Creating a
Service to Map the Back-end Document to webMethods DFD
Format” on page 48.

Important! You must select to invoke this service
synchronously by selecting synchronous.

Deliver Document By Immediate Delivery and select FINTransport

The FINTransport delivery service uses variables specified in
the TPA to govern the creation and sending of the outbound
SWIFT message.

Creating a Service to Map the Back-end Document to webMethods DFD Format

The service you create should contain logic to do the following;:

1

Get the content of the back-end system document from the BizDocEnvelope to an
IData object by invoking the wm.tn.doc.xml:bizdocToRecord service.

Map data from the back-end system document to webMethods DFD format, which
represents the {B4} block of the SWIFT FIN message.

Convert the webMethods DFD format IData object to an XML String by invoking the
pub.xml:documentToXMLString service.
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4 Convert the XML String to bytes by invoking the pub.string:stringToBytes service.

5 Invoke the wm.tn.doc:addContentPart service to add the bytes to the BizDocEnvelope as a
new content part. When you add the content part, you must name the content part
DFD Data.

Using the Processing Rule at Run Time

At run time, to submit the back-end system document to the Trading Networks, invoke
the wm.tn:receive service.

Receiving Inbound Messages from SWIFT

You can process inbound messages from SWIFT using either a business process or a
service that is invoked by a Trading Networks processing rule.

Receiving Inbound Messages Using a Business Process

To use a business process (also called a conversation), you use webMethods Modeler to
create a process model that defines the steps that you want to take in your business
process. For a guideline, see the sample process model (CorpActions_Account Owner)
provided in the SWIFT FIN Module sample. For more information, see Appendix C,
“webMethods SWIFT FIN Module Sample” on page 175.

After designing the process model, use webMethods Modeler to generate it. When you
generate a process model, webMethods Modeler generates the run-time elements (for
example, triggers, flow services, etc.) that are executed for the business process.

The first step of a business process is a step that waits for a document. At run time, you
receive a SWIFT message via a SWIFT interface (MQSA, CASmf, or AFT). The message is
recognized as a TN document type and submitted to the PRT. The PRT determines which
process model to use for the document and either instantiates a new instance of the
process model to start the business process, or when subsequent documents aimed at the
business process arrive, the PRT delivers them to the appropriate business process to
rejoin a running process.

The PRT uses the Conversation ID to determine whether documents belong to the same
instance of a business process. All documents that belong to the same instance of a
business process use the same Conversation ID.
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Before You Can Receive Inbound Messages

When creating message records (using the wm.fin.dev:importFINItems service) for the
SWIFT FIN messages you will be receiving, you must set the following parameters to
true:

m  createDocType. Creates the TN document type for the message record.
m  createTPA. Creates the TPA for the message record.

Edit the message TPA parameters as necessary. For example, set the Validate...
parameters such as ValidateContent.

Designing the Process Model

Your process model will typically contain the following steps:

1

Wait for the SWIFT message from the sender -and- invoke the wm.ip.cm:waitStepinit
service. This service takes necessary actions to prepare for the business process.
During the processing, it retrieves the TPA with the AgreementID set to the name of
the TN document type. Processing will fail if the first step does not invoke this service
-or- if the service fails to retrieve the TPA.

Invoke the wm.fin.validation:validateFinMsg, which validates the incoming message based
on the parameters specified in the message TPA. The output of this service includes
the finlData and convertedFinIData variables.

Map data from the inbound SWIFT message into a back-end format document using
the following variables available in the pipeline.

B finlData. This is the message in TAG format.

B convertedFinlData. This is the format specified in the message TPA (for example,
TAG_BIZNAME).

Executing the Business Process

When an inbound SWIFT message is received by the wm.fin.trp:receive service, Integration
Server completes the following processing automatically:

Recognizes the SWIFT message using TN document types.
Forms a BizDocEnvelope for the SWIFT message.

Sets the Conversation ID for the SWIFT message. The Conversation ID is created in
the following format: Sender BIC-Unique ldentifier. The Unique Identifier is
retrieved from the inbound message’s MUR section in the {B3} block.

Saves the content of the SWIFT message to the Trading Networks database.
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B Passes the SWIFT message to the PRT. When the PRT receives the SWIFT message, it
determines whether this is the first document for a business process or whether it is a
document that is rejoining a running business process. If it is the first document of a
business process, the PRT instantiates a new instance of the process model.
Otherwise, it sends the document to rejoin a running business process.

Receiving Inbound Messages Using a Processing Rule

To use a processing rule to receive inbound SWIFT FIN messages, you define a processing
rule in Trading Networks that invokes a service to validate and process the inbound
message.

Before You Can Receive Inbound Messages

B  When creating message records (using the wm.fin.dev:importFINItems service) for the
SWIFT FIN messages you will be receiving, you must set the following parameters to
true:

m  createDocType. Creates the TN document type for the message record.
m  createProcessingRule. Creates the processing rule for the message record.
B createTPA. Creates the TPA for the message record.
B Edit the message TPA parameters as necessary. For example, set the Validate...
parameters such as ValidateContent.
Creating the Service to Map the webMethods DFD Format to the Back-end Document
Create a mapping service using the following variables available in the pipeline.
B finIData. This is the message in TAG format.

B convertedFinlData. This is the format specified in the message TPA (for example,
TAG_BIZNAME).

Then specify the name of this service in the message TPA InboundProcessingRulesService
parameter.
Defining the Processing Rule

For instructions to define processing rules, see the webMethods Trading Networks User’s
Guide. The following sections describe specific settings that you should use when defining
your processing rule for use with a SWIFT message.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 51



CHAPTER 4 Sending and Receiving SWIFT Messages

Processing Rule Criteria

On the Criteria tab of the processing rule, set the following criterion.

Criteria tab field Set to...

Document Type The TN document type for the SWIFT message.

Setting Processing Actions

On the Action tab of the processing rule, select Perform the following actions, and then set the
following criterion.

Action tab field Set to...

Execute a service wm.fin.validate:validateFINMessage

Important! You must select to invoke this service
synchronously by selecting synchronous.

Using the Processing Rule at Run Time

When an inbound SWIFT message is received by the wm.fin.trp:receive service, the
Integration Server does the following automatically:

B Recognizes the SWIFT message using TN document types.
B  Forms a BizDocEnvelope for the SWIFT message.

B Sets the Conversation ID for the SWIFT message.
|

Sets the Conversation ID for the SWIFT message. The Conversation ID is created in
the following format: Sender BIC-Unique ldentifier. The Unique Identifier is
retrieved from the inbound message’s MUR section in the {B3} block.

Saves the content of the SWIFT message to the Trading Networks database.

B Submits the SWIFT message to the Trading Networks processing rules engine, which
validates the message. If validation succeeds, the output of the validation includes the
finIData and convertedFinlData variables. Trading Networks then invokes the service
specified in the message TPA InboundProcessingRulesService parameter.
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Overview

The SWIFT interfaces you use with the webMethods SWIFT FIN Module enable you to
send outbound messages to SWIFT as well as receive inbound messages from SWIFT. You
can connect to SWIFT using one of the following SWIFT interfaces:

B MQSA. If you are connecting to SWIFT through MQSA, you must install the
webMethods WebSphere MQ Adapter on the Integration Server. For more
information about configuring and using the adapter with the webMethods SWIFT
FIN Module, see “Using the webMethods WebSphere MQ Adapter to Communicate
with SWIFT” on page 54.

B CASmf. If you are connecting to SWIFT through CASmf, you must install the
WmCASmf package on the Integration Server. For more information about
configuring and using CASmf with the webMethods SWIFT FIN Module, see “Using
the CASmf Adapter to Communicate with SWIFT” on page 56.

B AFT. If you are using Automated File Transfer (AFT), you must configure the File
Polling Listener and AFT settings in the message TPA. For more information about
configuring and using the File Polling Listener with the webMethods SWIFT FIN
Module as well as using File Drop for outbound messages, see “Using AFT to
Communicate with SWIFT” on page 62.

Using the webMethods WebSphere MQ Adapter to Communicate

with SWIFT

The webMethods WebSphere MQ Adapter enables the Integration Server to exchange
information with other systems through an IBM WebSphere MQ message queue. This
capability lets you route documents, or any piece of information, from the Integration
Server to systems that use WebSphere MQ message queuing as their information
interface.The WebSphere MQ Adapter enables you to connect to SWIFT through MQSA.
For detailed information about using the WebSphere MQ Adapter, see the webMethods
WebSphere MQ Adapter User’s Guide.

Important! The following procedure assumes that you already have configured your
WebSphere MQ system and SWIFT Alliance Access (SAA) to communicate with one
another, and have installed the webMethods WebSphere MQ Adapter. For more
information about installing the WebSphere MQ Adapter, see the webMethods WebSphere
MQ Adapter Installation Guide.
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Configuring the webMethods WebSphere MQ Adapter

B 1o configure the webMethods WebSphere MQ Adapter for the webMethods SWIFT FIN Module

1  Configure the WebSphere MQ Adapter connections. You will need to configure at
least two connections:

B A connection to send messages to MQ Series
B A connection to receive messages from MQ Series

For information about configuring WebSphere MQ Adapter connections, see
Chapter 3 in the webMethods WebSphere MQ Adapter User’s Guide.

2 Setup to deliver outbound messages from SWIFT FIN Module to SWIFT via
WebSphere MQ Adapter.

a Configure a WebSphere MQ Adapter Put service to deliver SWIFT messages to an
MQ Series queue. When configuring the Put service, identify the connection that
sends messages to MQ Series, which you configured step 1.

For information about configuring the WebSphere MQ Adapter Put service, see
Chapter 4 in the webMethods WebSphere MQ Adapter User’s Guide.

b  Create a service (e.g., Java or flow) that invokes the Put service you just
configured in step 2a. When you create the service:

B The input variables must include the variable msgBody with data type byte[]
(or Object for a flow service).

B Before invoking the Put service that you configured in step 2a, the logic of the
service must map the data in the input in the msgBody variable to the input of
the Put service; that is, map the value to the putServicelnput/msgBody variable
of the generated Put adapter service.

B The logic must invoke the Put service that you configured in step 2a.
¢ Update the TPA for SWIFT messages to identify the correct method to deliver
outbound SWIFT messages. To do so, update the following in the TPA:

In this section of

the TPA data... Set this parameter... To...
FINProcessinfo  Transport MQ
MQSeriesInfo putMessageHandlerService  The name of the service that you

created in step 2b.

For more information about TPAs, see Chapter 9, “Customizing Trading Partner
Agreements” in this guide.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 55



CHAPTER 5 Configuring SWIFT Interfaces

3 Setup to receive inbound messages from SWIFT via WebSphere MQ Adapter.

a

Configure WebSphere MQ Adapter listeners and listener notifications. When
configuring the listener, identify the connection that receives messages from
MQ Series, which you configured step 1.

When you create a listener notification, you must specify a service to invoke when
WebSphere MQ Adapter retrieves a message from MQ Series. For more
information about this service, see the next step, step 3b, below.

For information about configuring the WebSphere MQ Adapter listeners and
listener notifications, see Chapter 5 in the webMethods WebSphere MQ Adapter
User’s Guide.

Create a service (e.g., Java or flow) that will be invoked when the WebSphere MQ
Adapter retrieves a message from MQ Series. The last action that this service
takes must be to invoke the wm.fin.transport. MQSeries:getListenerService service. This
service processes the received FIN message. For more information about this
service, see “wm.fin.transport. MQSeries:getListenerService” on page 140.

How the service you create is invoked is based on the type of listener notification
you created in step 3a:

B If you create an asynchronous listener notification, you must create a trigger
that subscribes to the notification. When you create the trigger, set it up to
invoke this service.

B If you create a synchronous listener notification, you specify the name of this
service when you configure the synchronous listener notification.

Using the CASmf Adapter to Communicate with SWIFT

The webMethods CASmf package enables the webMethods Integration Server to send
and receive messages through the CASmf interface. A CASmf client and Adapter enable
the Integration Server to exchange information with other systems. This capability lets
you route documents—or any piece of information—from the Integration Server to
systems that use CASmf as their information interface. The webMethods CASmf Adapter
enables you to connect to SWIFT using the CASmf Adapter.
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webMethods CASmf package Architecture

The following diagram illustrates how the webMethods CASmf package fits into the
webMethods Integration Platform architecture.

webMethods CASmf package Architecture

WmFIN | WmCASmf

Packages | Package

SWIFT

SWIFT Transport

CASmf SWIFT
Client messages

Integration Server

SWIFT Network
INI[E[=] = messages (STN)

Access

CASmf
Server

The following table describes the components that interact with the webMethods CASmf

package.

Component

Description

FIN Packages

The FIN packages included in the webMethods SWIFT FIN
Module.

WmCASMmf
Package

Product described in this guide that transfers SWIFT FIN messages
to and from SAA system using CASmf.

CASmMf Client

The CASm(f client enables the CASmf Package to interface with the
CASmf server.

CASMf Server

The CASmf server enables communication between the CASmf
client and SAA.

SWIFT Alliance
Access (SAA)

SWIFT software configured to access the SWIFT Transport
Network (STN), SWIFT’s original network accessed using x.25
transport technologies.

SWIFT Transport
Network (STN)

The existing SWIFT interface, a computer system provided and
operated by the user, which enables communication with the
SWIFT network.
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Configuring the CASmf Adapter

a Important! The following procedure assumes that you already have configured your
CASmf server and SAA to communicate with one another. For more information, see your
CASmf server and SWIFT documentation.

B 7o configure the webMethods CASmf Adapter for the webMethods SWIFT FIN Module

1

Install a CASmf client on the same machine as webMethods Integration Server. For
more information, see your CASmf documentation.

Install the webMethods CASmf package on the same machine as webMethods
Integration Server. This package can be installed with the webMethods SWIFT FIN
Module. For more information, see Chapter 2, “Installing the webMethods SWIFT FIN

Module” in this guide.

Configure the webMethods CASmf package to work with the SWIFT FIN Module by
updating the properties in the following configuration file:

webMethods6\IntegrationServer\packages\WmCASmf\config\wmcasmf.cnf

Property

Description

wm.casmf.send.mapid

wm.casmf.receive.mapid

wm.casmf.send.message.folder

The sending and receiving map IDs that you
have defined for SAA.

These mapIDs must match exactly the two
|_mapid fields in the CASmf client dmapid.dat
file. Typically, this file is located in the following
directory:

$CASmfInstallationFolder\dat

where $CASmFInstal lationFolder is the
directory in which the CASmf client is installed.
You also can locate this file using the folder listed
in your DATTOP environment variable.

The folder in which all outbound SWIFT FIN
messages will be queued before being sent to
SWIFT via the CASmf Adapter. You do not need
to change this location, but you may do so at
your discretion.
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Property

Description

wm.casmf.authentication.type

wm.casmf.authentication.send
Key

wm.casmf.authentication.recei
veKey

wm.casmf.authentication.local
SendKey

wm.casmf.authentication.local
ReceiveKey

wm.casmf.receive.timeout

Type of authentication that you want the
webMethods CASmf package to perform. Specify
one of the following:

B AUTH_ACCESS to have webMethods CASmf
package perform session authentication with
SAA.

B AUTH_DATA to have webMethods CASmf
package perform data authentication with
SAA.

B AUTH_BOTH to have webMethods CASmf
package perform session and data
authentication with SAA.

B AUTH_NONE to have webMethods CASmf
package perform no authentication with
SAA.

The send and receive keys that you have defined
for SAA.

Important! Be sure to reverse the keys when you
specify them for the property. For example, the
value you specify for the sendKey in SAA use for
the wm.casmf.authentication.receiveKey

property.

The number of seconds that you want the
webMethods CASmf package to maintain an
active connection with SAA for receiving
messages. If no messages are received within the
specified time, the connection is closed. The
default is 300 seconds.

For example, assume the timeout value is set to
300 seconds and that there are 10 messages that
will take 2 seconds to receive. The connection
will remain open for the 2 seconds to receive the
10 messages, then remain idle for the next 298
seconds before the connection is closed.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1

59



CHAPTER 5 Configuring SWIFT Interfaces

4 In the TPA for each SWIFT message you will be sending and receiving using CASmf,
set the following field:

Set this field...  To...

Transport CASmf

For more information about TPAs, see Chapter 9, “Customizing Trading Partner
Agreements” in this guide.

5 Inthe Server Administrator, create a scheduling service to run the

wm.casmf.trp:casmfSendReceiveSchedule service on intervals:

a

Server >

Under Server, click Scheduler. The Scheduler screen appears.

Scheduler

® View system tasks

# Create s scheduled task

One-Time and Simple Interval Tasks

Service Run As User Interval Mext Run
wm.monitor.admin:imageCleanup Administrator 300.0 sec 217.0 sec

Active Remove

v dctive 7(’

b

Click Create a scheduled task. The Service Information screen appears.

Service Information

folder.subfolderiservice I

Run As User IAdministratDr 'I

Persistence [¥ persist after restart

Clustering Mot in cluster,

One-Time Tasks

' Run Once Drate I TETMMADD
Tirme | HH:MM: S

Repeating Tasks With a Simple Interval

 Repeating Interval ID seconds

Repeating [T Repeat fram end of invocation

Repeating Tasks with Camplex Schedules

(o Complex Repeating  Start Date I TYAMMADD (optional)
Start Time I HH:MM:SS (optional)

End Crate I TITYMMADD (ootional)
End Tirme I HH:MM: 55 (optional)

Schedule Type and Details
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C Set the fields in the Service Information section according to the instructions in the
webMethods Integration Server Administrator’s Guide.

d In the Schedule Type and Details section, under Repeating Tasks With a Simple Interval,
set the fields as follows:

B Select Repeating.

B In the Interval field, webMethods recommends that you set this service to run
at intervals of at least 15-20 minutes.

B Select the Repeat from end of invocation check box.
e Click Save Tasks.

For more information about this service, see Appendix A, “webMethods SWIFT FIN
Module Services” in this guide.
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Using AFT to Communicate with SWIFT

& Important! To use Automated File Transfer (AFT), you must have the WmF]latFile package
installed, which is installed by default with the webMethods Integration Server.

AFT enables the webMethods Integration Server to exchange information with other
systems. If you are using AFT to receive inbound SWIFT FIN messages through the File
Polling Listener, and File Drop capabilities to send outbound SWIFT FIN messages, the
File Polling Listener and the message TPA must be configured properly.

Configuring AFT for Inbound Messages

P 7o configure the webMethods File Polling Listener for the webMethods SWIFT FIN Module

1 In the Server Administrator, click Security » Ports » Add Port.

2 Select webMethods/FilePolling and click Go to Step 2.

3 Configure the File Polling Listener’s general fields as described in the “Configuring
Ports” section of the “Configuring the Server” chapter in the webMethods Integration
Server Administrator’s Guide.

4 Set the following fields so that the File Polling Listener handles SWIFT FIN messages

properly.

Set this field...

To...

Content Type

Folder location

Processing Service

application/x-wmflatfile

The fully qualified path of the folder in which SAA will be
sending SWIFT FIN messages. The folder must be accessible
to both SAA and the webMethods Integration Server.

wm.Fin.transport._AFT:processlnboundFile
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Configuring AFT for Outbound Messages

To configure AFT using File Drop capabilities to send outbound SWIFT FIN messages
using the webMethods SWIFT FIN Module, you must complete the following procedure.

B 7o configure File Drop for the webMethods SWIFT FIN Module

1 Map a network directory in which you want to drop files to be picked up by SAA,
which can be any directory in the webMethods Integration Server.

2 In the TPA for the SWIFT message, set the following parameters:

Set this field... To...
Transport AFT
Folder location The fully qualified path of the folder in which the

webMethods Integration Server will be dropping SWIFT FIN
messages. The folder must be accessible to both SAA and the
Integration Server.

FileExtension inp
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Overview

The webMethods SWIFT FIN Module home page in the Server Administrator enables you
to import and search BIC and BIC+ lists.

Importing BIC and BIC+ Lists

A BIC list provides a list of valid BICs for all existing SWIFT financial institutions. All
SWIFT FIN messages are validated against this BIC list to make sure the sender and
receiver are valid.

Before you can import a BIC or BIC+ list into the webMethods Integration Server, you
must create a database table to hold the BIC data. webMethods provides database scripts
in multiple formats to create the empty database table(s) to hold the BIC information that
you import.

After you have created the BIC table(s) in your database, you then can import the most
recent list of SWIFT BIC or BIC+ codes into your database table from the CD provided to
you by SWIFT. To do so, you use the Import BIC List tool on the webMethods SWIFT FIN
Module home page in the Server Administrator.

Important! SWIFT provides BIC lists in fixed-length ASCII format. SWIFT provides BIC+
lists to you in Access database format. To import a BIC+ list into the webMethods SWIFT
FIN Module, you first must convert the list into fixed-length ASCII format.

To create a BIC database table

1 With your database server running, make sure you have a database in which to add a
BIC table.

2 Import the following file into your selected database to create an empty BIC table in
your database:

webMethods6 \ IntegrationServer \ packages\ WmFIN \ config\ bic\ create_BIC_db.sql

where db is the type of database sever you are using, such as Oracle. webMethods
provides scripts for SQL Server, Oracle, and Sybase databases.

For the procedure to complete this step, see your database server documentation.

To import a BIC or BIC+ List

1 Inthe Server Administrator, on SWIFT home page, click Import BIC List.
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SWIFT Import BIC List Screen

Import BIC List

Mote: Everytime BIC import process is initiated the previous BIC list from the database is
deleted and a new list is inserted.

BIC Type: IE.IC "I
FiIeName:I Browse... |

Ziffoldersbic.dat
Example Paths Afserverffolder/bic.dat
folderfbic.dat (relative to install directory )

2 In the BIC Type list, select BIC or BIC+ to indicate the type of BIC list you are importing.

ﬂ Important! If you are importing a BIC+ list, you first must convert the list into fixed-
length ASCII format.

3 In the File Name box, type the full directory path and name of the BIC or BIC+ list file
that you want to import. To locate the file, you can click Browse.

4 Click Import BIC List. The new BIC list is imported into your BIC database table and
made available to your webMethods SWIFT FIN Module. This process might take a
few minutes.

Note: A sample BIC+ database is located in the
webMethods6 \ IntegrationServer \ packages\ WmFINSamples\ data directory. Unzip the
bicpluz.zip file and import the bicplus.txt file.

Searching for BICs

Using the Search BIC List tool on the webMethods SWIFT FIN Module home page in the
Server Administrator, you can import the most recent SWIFT Bank Identification Code
(BIC) lists provided by webMethods into the webMethods SWIFT FIN Module.

A BIC list provides a list of valid BICs for all existing SWIFT financial institutions. All
SWIFT FIN messages are validated against this BIC list to make sure the sender and
receiver BICs are valid.

P TosearchaBIC list

1 In the Server Administrator, on webMethods SWIFT FIN Module home page, click
Search BIC List.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 67



CHAPTER 6 Working with BIC and BIC+ Lists

SWIFT Search BIC List Screen

Search BIC List

Mote: For partial search, enter "%partial search string%o’.

Cude:l

Institution: I

Branch:

|
Citoy: I

Modified Flag: I vI

Location:

|
Country Mame: I

2 On the Search BIC List screen, provide the information on which you want to search.
You must enter information in at least one field, but to limit your search, you can
enter information in as many fields as necessary.

Note: All fields on this screen are case-sensitive.

Field Name Description

Code The institution’s BIC code. For example, type ABCDEFGHIJK.
Institution The institution’s name. For example, type Citibank.

Branch The institution’s branch name. For example, type Main.

City The institution’s city. For example, type Miami.

Modified Flag From the drop-down list, select the modification flag for which

you want to search:

B New. Identifies a new BIC entry.

B Update. Identifies a BIC entry currently being updated.
B Modified. Identifies a modified BIC entry.

B Deleted. Identifies a deleted BIC entry.
Location The institution’s location. For example, type Mall.

Country Name The institution’s country. For example, type USA.

3 Click Search. The Search BIC List screen displays up to the first 50 matching BICs.
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SWIFT Search BIC List Results Screen

Search criteria

Code
Institution %% Citi%
Branch
City
Modified Flag
Location
Country Narme
Documents Retrieved 50

BANK HANDLOWY W
WARSZAWIE SA A& MEMBER OF

BHWAPLPWEIS  CITIGROUP{FORMERLY BANEK
HAMDLOWY W WARSZ AWIE
S8

BANK HANDLOWY W
WARSZAWIE SA A& MEMBER OF

BHWAPLPWEBIE  CITIGROUP{FORMERLY BANEK
HAMDLOWY W WARSZ AWIE
S8

Code Institution Branch

City

BIALTSTOK

BIELSKO BIALA

Received documents

Modified
Flag

]

Location

15213
BIALTSTOK

43300 BIELSK
BIALA
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CHAPTER 7 Creating Message Records and Validation Rules

Overview

To send and receive SWIFT FIN messages, you first must create a message record for each
SWIFT message that you will be sending and receiving. You also can use network and
usage validation rules in your maps to validate your messages.

You use SWIFT message records to create inbound and outbound maps that define how
this particular message will be handled. For information about mapping, see Chapter 10,
“Mapping a SWIFT FIN Module Process” in this guide.

Creating Message Records

To create a message record for a SWIFT message, you must do the following:

B Install the SWIFT message DFD (which includes the message parsing template) into
the webMethods SWIFT FIN Module. For more information, see “Installing SWIFT
Message DFDs and Parsing Templates” on page 72.

B Run the wm.fin.dev:importFINitems service located in the WmFINDev package. For more
information, see “Running the wm.fin.dev:importFINItems Service” on page 73 in
this chapter.

Note: SAA sends SWIFT Acknowledgements (ACKs) and Negative Acknowledgements
(NACKS) to the webMethods SWIFT FIN Module. However, you do not need to manually
install and import DFDs for SWIFT ACKs and NACKs. These are automatically installed
for you the first time you initialize the Integration Server after installing the webMethods
SWIFT FIN Module.

The SWIFT templates for ACKs and NACKSs are located in
webMethods6\IntegrationServer\packages\WmFIN\config\dfd directory. During
initialization of the Integration Server, the TN document type for ACKs and NACKs are
inserted into Trading Networks database if they are not already present. The
corresponding IS document types ACKs and NACKs are located in wm.fin.doc.catF folder of
the WmFIN package.

Installing SWIFT Message DFDs and Parsing Templates

To create a message record for a SWIFT message, you must install the message DFD
(which includes its parsing template) using webMethods Installer. For more information
about installing message DFDs using the webMethods Installer, see Chapter 2, “Installing
the webMethods SWIFT FIN Module” in this guide.

For more information about parsing templates, see Appendix B, “XML Parsing
Templates” in this guide.
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Running the wm.fin.dev:importFINItems Service

When you run the wm.fin.dev:importFINItems service located in the WmFINDev package for a
particular SWIFT message DFD, the service will create the following items for each message:

IS Document Type

Network validation rules (if available)
Market Practice rules (if available)

TN document type

Trading Partner Agreement (in “Proposed” status)

Processing rule to process an inbound SWIFT message

The SWIFT message parsing template and DFD is copied from the WmFINDev package
into the WmFIN package. For example, for may05 version, the parsing template and DFD
files from WmFINDev\import\may05 are copied into WmFIN\config\dfd\may05. The IS
document types are stored in the WmFINMessages package in the appropriate version
folder and message category (for example, wm. fin.doc.may05.cat5).

B 7o run the wm.fin.dev:importFINitems service

1 In the Developer, navigate to the wm.fin.dev:importFINltems service located in the

WmFINDev package, and then click . The Input dialog box appears.

Input dialog box
|E| Input for ‘importFINIEEMS x I

meaType |

CL=Tg=uly] |

format [TAG_BIZNAME |

subfieldFlag Itrue 'I
createDocType Itrue vI

createProcessingRie Itrue vI

createlPA Itrue vI

[ Include empty values for String Types

] Cancel | Load | Save Help
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2 Complete the following fields, and then click OK:
Field Description
msgType FIN message type. For example, 564.
version FIN version. For example, may05.
format The format of the generated blocks and fields for the input FIN message. Valid
values:

B TAG_BIZNAME (default). SWIFT Message tag followed by the business name
specified in the message DFD. For example, 23G_Function of the Message.
This format provides the best balance between readability and performance. It
provides DFD business names while retaining the field tag. This format causes
half of the performance penalty of BIZNAMEONLY because lookups are used only
when receiving a message.

B TAGONLY. SWIFT Message tag only. For example, 23G:. This is the simplest
format and is suited to those already familiar with SWIFT and specific
messages. This format provides the best performance.

B BIZNAMEONLY. Business name specified in the message DFD only. For example,
Function of the Message. Although this format is the most readable, it also
carries the largest performance penalty.

B XMLTAG. XML-compatible tag name. For example, F23G. This format cannot
contain colons or tags that begin with a number. This format enables you to
take advantage of the XML-specific services and functionality provided by the
Integration Server, such as pub.xml:documentToXMLString, etc.

subfieldFlag Indicates whether the IS Document Type generated for this FIN Message is parsed

to the field or subfield level. Valid values:

true. Parse to the subfield level.

false. Parse to the field level.

Note: For inbound SWIFT FIN messages, setting the subfieldFlag variable to true
causes the webMethods SWIFT FIN Module to automatically parse messages to the
subfield level and then remove the SWIFT delimiter (/) from between subfields. For
outbound SWIFT FIN messages, setting the subfieldFlag variable to true causes the
webMethods SWIFT FIN Module to add the SWIFT delimiter (/) between subfields.

74

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1



Creating Validation Rules

Field Description

createDocType Indicates whether to create and insert a TN document type for this message. The
TN document type is used to recognize an incoming message.

B true (default). Create and insert a TN document type.

B false. Do not create and insert a TN document type.

Important! You should always set this field to true.

createProcessing Indicates whether to create a Trading Networks processing rule for this message.
Rule After the message is recognized, the processing rule specifies how the message
should be processed.

B true (default). Create a processing rule.

B false. Do not create a processing rule.

Important! If you will be using the processing rules to manage the execution of
SWIFT FIN messages, you should always set this field to true.

createTPA Indicates whether to create a Trading Networks trading partner agreement (TPA)
for this message. A TPA is a set of parameters that you use to govern how SWIFT
FIN messages are exchanged between two trading partners.

B true (default). Create and insert a TPA.

B false. Do not create and insert a TPA.

Important! You should always set this field to true.

Creating Validation Rules

webMethods provides network validation rules for a number of commonly used message
types. In addition to these rules, the webMethods SWIFT FIN Module enables you to
create network validation rules for additional messages as well as create usage validation
rules.

Note: Although Market Practice rules function in much the same way as validation rules,
the configuration of Market Practice rules differs from that of validation rules. For more
information about Market Practice rules, see Chapter 13, “Working with Market
Practices” on page 113.
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Creating Network Validation Rules

When the webMethods SWIFT FIN Module sends and receives a SWIFT message, it
validates the message at the individual field level or across the fields using network
validation rules as specified by SWIFT. The webMethods SWIFT FIN Module sends a
message only when the message structure, syntax, and validation rules are applied.

webMethods provides network validation rules for version may05, as flow services, for
you to use with the SWIFT FIN messages that you import. When you create a message
record, the corresponding network rule (as a flow service) is imported into the Integration
Server and will be placed in the WmFINMessages package along with the message record.

After the webMethods SWIFT FIN Module syntactically validates a message, it executes
the corresponding network rule. Any validation errors will be aggregated and reported in
the webMethods Integration Server and Process Run Time (PRT) error logs, if you are
using process models.

webMethods provides network validation rules for the following SWIFT FIN messages:
MT 101 Request for Transfer

MT 103 Single Customer Credit Transfer

MT 103STP Single Customer Credit Transfer
MT 202 General Financial Institution Transfer
MT 300 Foreign Exchange Confirmation

MT 320 Fixed Loan/Deposit Confirmation

MT 502 Order to Buy or Sell

MT 515 Client Confirmation of Purchase or Sale
MT 535 Statement of Holdings

MT 536 Statement of Transactions

MT 537 Statement of Pending Transactions

MT 540 Receive Free

MT 541 Receive Against Payment

MT 542 Deliver Free

MT 543 Deliver Against Payment

MT 544 Receive Free Confirmation

MT 545 Receive Against Payment Confirmation

MT 546 Deliver Free Confirmation
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MT 547 Deliver Against Payment Confirmation

MT 548 Settlement Status and Processing Advice

MT 564 Corporate Action Notification

MT 565 Corporate Action Instruction

MT 566 Corporate Action Confirmation

MT 567 Corporate Action Status and Processing Advice
MT 568 Corporate Action Narrative

MT 900 Confirmation of Debit

MT 910 Confirmation of Credit

MT 940 Customer Statement Message

MT 942 Interim Transaction Report

MT 950 Statement Message

You can create additional network validation rules for particular messages by writing
individual services based on the SWIFT message documentation (pdf), which is provided
by SWIFT. To use a new validation rule, you must specify the service you created in the
ValidationRule parameter in the TPA for the particular SWIFT message.

For more information about TPAs, see Chapter 9, “Customizing Trading Partner
Agreements” on page 87.

Creating Usage Validation Rules

Usage rules exist only for certain messages when being exchanged between two specific
partners. webMethods does not provide built-in usage rules because they vary by trading
partner pairs, but you can create usage rules for particular messages by writing individual
services based on the message documentation (pdf) provided by SWIFT. To implement a
usage rule, you must specify the service you created in the UsageRule parameter in the
TPA for the particular SWIFT message.

For more information about TPAs, see Chapter 9, “Customizing Trading Partner
Agreements” on page 87.
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CHAPTER 8 Defining Trading Partner Profiles and TN Document Types

Overview

Trading partner profiles help define how you and your trading partners exchange SWIFT
FIN messages. TN document types enable webMethods Trading Networks to identify a
type of business document and specify what to extract from the business document.

This chapter provides you with information about defining trading partner profiles and
TN document types in webMethods Trading Networks.

Defining Trading Partner Profiles

A trading partner is any person or organization with whom you want to conduct business
electronically. In the webMethods SWIFT FIN Module, a trading partner is defined by
several criteria that you specify in a trading partner profile, including company name and
identifying information, contact information, and preferred delivery methods.

In addition to specifying trading partner profiles for all of your trading partners, you must
specify a profile for your own organization.

Why Are Trading Partner Profiles Important?

Your trading partner profiles, used in conjunction with trading partner agreements
(TPAs), and process models, define how you and your trading partners exchange SWIFT
FIN messages. For example, a process model defines what actions your company takes in
certain transactions, as well as the actions you expect your trading partners to perform
during those transactions. In fact, the concise definition of profiles, the configuration of
process models, and the application of TPAs are what enable you to interact successfully
with your trading partners.

For the webMethods SWIFT FIN Module, you define a single trading partner profile for
yourself (Enterprise) and then create a process model to support each role you will perform
in exchanging messages with your trading partners. You also must define a trading
partner profile for each trading partner with whom you will be exchanging messages.
When you create a process model, you will use the various trading partner profiles to help
define the sender and receiver of the message.

For information about creating process models, see Chapter 11, “Creating or Modifying a
Process Model” on page 105. For general information about process models, see the
webMethods Modeler User’s Guide.
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Defining Your Enterprise Profile

Before defining your trading partner profiles in Trading Networks and exchanging
messages with your trading partners, you first must define your enterprise (Enterprise)
profile by completing the fields in the Profile Assistant in the Trading Networks Console.

For procedural information about defining your enterprise profile as well as descriptions
of all the fields you must complete when defining your enterprise profile, see the
webMethods Trading Networks User’s Guide. The following section provides you with the
fields that you are required to complete when defining your enterprise profile for use
with the webMethods SWIFT FIN Module.

Required Profile Fields

Profile information is displayed on the Trading Networks Console Profile Assistant
Corporate tab. The following table lists and describes the required fields you must
complete when defining your enterprise profile for use with the webMethods SWIFT FIN

Module.
Required Profile Field for Enterprise Description
Corporation Name The name of your enterprise.
External ID Type BIC
External ID Type Value Your enterprise’s BIC.

Note: The BIC External ID Type is added to the webMethods Trading Networks database
when you start the webMethods SWIFT FIN Module for the first time.

For descriptions of other fields you must complete when you defining your enterprise
profile, see the webMethods Trading Networks User’s Guide.

Defining Your Trading Partners’ Profiles

Each trading partner with whom you want to exchange SWIFT FIN messages must have a
trading partner profile in Trading Networks. After you have defined your enterprise
profile, you are ready to define your trading partners’ profiles.

You define a trading partner profile by completing the fields in the Profile Assistant in the
Trading Networks Console.

For procedural information about defining a trading partner profile as well as
descriptions of the fields you must complete when defining a trading partner profile, see
the webMethods Trading Networks User’s Guide. The following section provides you with
the fields that you are required to complete when defining your trading partner profiles
for use with the webMethods SWIFT FIN Module.
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Required Profile Fields

Profile information displays on the Trading Networks Console Profile Assistant Corporate
tab. The following table lists and describes the required fields you must complete when
defining a trading partner profile.

Required Profile Field for Trading Partner ~ Description

Corporation Name The name of the trading partner.
External ID Type BIC
External ID Type Value Your trading partner’s BIC.

For descriptions of other fields you must complete when you define a trading partner
profile, see the webMethods Trading Networks User’s Guide.

Defining TN Document Types

TN document types are definitions that tell webMethods Trading Networks how to
identify a type of business document and specify the attributes that Trading Networks is
to extract from the business document.

When you run the wm.fin.dev:iimportFINItems service, which is located in the WmFINDev
package, to create a record for a particular SWIFT message DFD, you can specify that the
service also create the external TN document types for this message. For more information
about creating message records, see Chapter 7, “Creating Message Records and Validation
Rules” on page 71.

When the webMethods SWIFT FIN Module receives a message, it invokes a Trading
Networks service to recognize the type of business document by using the TN document
types that were created along with your message records or that you created yourself.
When Trading Networks recognizes the TN document type of the business document,
Trading Networks extracts specific pieces of information from the business document
based on the attributes specified in the TN document type.

For more information about TN document types, see the webMethods Trading Networks
User’s Guide.

Defining Your Own Internal TN Document Types

You might want to create your own internal TN document types or customize one of the TN
document types created using the wm.fin.devimportFiNitems service in the WmFINDev package.

Important! Do not modify any of the provided external TN document types. If you do, the
incoming SWIFT message will not join the business process (also called a conversation).
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When you define an internal TN document type, you specify the root tag from within the
SWIFT message that the TN document type is to match, as well as the XML queries that
Trading Networks uses to extract the SenderID and ReceiverID attributes from the message.

B 7o define an internal TN document type

Start the Trading Networks Console.

If you are using Trading Networks 6.0.1, in the Selector Panel, click My Enterprise.
Select View » Document Types.

Select Types » New.

g B~ W NN

In the Create New DocType dialog box, select the XML document type category from the
list, and click OK.

6 In the Document Type Details screen, in the Name field, type the name you want to give
to the internal TN document type (for example, Internal Corporate Action).

7 In the Description field, type a description for the internal TN document type.

8 In the Root Tag field, type the value of the root tag of your internal document (for
example, InternalCorporateAction).

9 Click OK.

The following figure illustrates the Identify tab of the Document Type Details screen with
the necessary fields completed.
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|dentify Tab of the Document Type Details Screen

Hame: |Interna| Corporate Action Last Modified: 2003-07-0312:30:44.0 Enabled: |
Description Internal Corporate Sction
Identifyl Extract] Hamespaces | Options |
File: 23 :Identifying Queries:
Queny: Value: : E
|l 2
\Load & sample document to work with
Root Tag: |IrdernaICOrporateAdion =1
| DOCTYPE Identifier: | :
Pipeline Matching:
' Mame Walue | E
i
0K ‘ Cancel |

Note: You can tell whether a TN document type is internal or external because an
external TN document type always has a pipeline matching variable of processVersion.
The TN document type in the preceding figure has no pipeline matching variable, so it
is an internal TN document type.

10 Trading Networks uses the extracted attributes to determine who is sending the
message and to whom to send the message. On the Extract tab, specify SenderID as one
of the attributes to extract.

Click Add an Attribute E .

o 9

In the Add an Attribute dialog box, in the Name list, select SenderID.

o

Select the Required check box.

d In the Description field, enter a description for the attribute.
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e In the Query field, enter the query to extract the SenderID attribute, which is
illustrated in the following figure.

Completed Add Attribute Dialog Box

B Add an Attribute

Hame: ]SenderID .:_J Enabled: [7

Type: STRING
Required: [/

Description: |

Querny: I.l'lrrternaICDrporateAdion[D]Isender[U]

Detail: [BiC ||
| ———————

OK J Cancel

f  In the Detail list, select BIC.
g Click OK.
11 Repeat step 10 for the ReceiverID.

The following figure illustrates the Extract tab of the Document Type Details screen with
the necessary fields completed.

Completed Extract Tab of the Document Type Details Screen

Hame: |Interna| Corporate Action Last Modified: 2003-07-0312:3816.51 Enabled: [+

Description

Internal Corporate Sction ‘

Identify Extract l Namespaces] Options]
ile: 4 Attributes to Extract:
File: (3 N\

Queny: Value:
E || [ReceiverlD

Test Query| Show Source| &
| :

Load & sample document to work with

ol wleje

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 85



CHAPTER 8 Defining Trading Partner Profiles and TN Document Types

86 webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1



webMethsids.

CHAPTER

Customizing Trading Partner Agreements

B Understanding Trading Partner Agreements . .........ovie i, 88
B How Does the webMethods SWIFT FIN Module Identify a TPA? ..................... 88
B MOdifyiNg TPAS 88

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1 87
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Understanding Trading Partner Agreements

A Trading Partner Agreement (TPA) is a set of parameters that you use to govern how
SWIFT FIN messages are exchanged between two trading partners. TPAs also enable you
to define Market Practice requirements for individual markets. Using Trading Partner
Agreements (TPAs), the webMethods SWIFT FIN Module supports customization of
SWIFT FIN messages based on specific trading partner pairs.

You modify and view TPAs in the Trading Networks Console Agreement Details screen. For
detailed information about working with TPAs in the Trading Networks Console, see the
webMethods Trading Networks User’s Guide.

How Does the webMethods SWIFT FIN Module Identify a TPA?

Every SWIFT message in the webMethods SWIFT FIN Module is associated with a TPA.
Every TPA is uniquely identified by a Sender, Receiver, and Agreement ID. During a
business process between trading partners, the webMethods SWIFT FIN Module uses this
information to retrieve the TPA for a specific sender-receiver pair and to process the
messages exchanged.

When using a business process to manage the execution of SWIFT FIN messages, the
Agreement ID is always the first TN document type name used to start the process. For the
sender of a SWIFT message in a business process, the first TN document type name is
typically the TN document type name representing the internal back-end document, such
as InternalCorporateAction. For the receiver of a SWIFT message in a business process,
the first TN document type name is typically the TN document type name of the first
SWIFT message received, such as MT541.

Important! To process messages according to a TPA, both sender and receiver TPAs must
have an Agreement Status of “Agreed”.

Modifying TPASs

When the webMethods SWIFT FIN Module creates a message record, it automatically
creates the TPA for the particular SWIFT message. You can view and modify the TPA by
double-clicking to open the selected “Proposed” TPA on the Trading Networks Agreement
tab to display the Agreement Details screen.

Important! The SubfieldFlag input parameter in the TPA supports the parsing of SWIFT
messages to the subfield level. If you change the value of the SubfieldFlag after creating the
message records, you must delete the message records pertaining to the TPA and recreate
them.
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Modifying TPAs

Sender,

Receiver, and ———

Agreement ID

Double-click a
heading to view

In the Agreement Details screen, the Sender and Receiver fields initially display a default
value of “Unknown”.

In the SWIFT TPA for each message that you created, you must specify the Sender, Receiver,
and Agreement ID. The Agreement ID is a placeholder for the TN document type name of the
internal business document received from the back-end system (for example,
“InternalCorporateAction”) or of the SWIFT message received from a partner (for
example, “MT541"). After the webMethods SWIFT FIN Module recognizes and associates
an incoming SWIFT message with a particular TN document type, it uses the TN
document type name in the business document, such as “MT541”, to find a TPA matching
that sender-receiver pair. Although your TPA identifies the business names of the sender
and receiver, the webMethods SWIFT FIN Module identifies the sender and receiver

using their BIC.

Agreement Details Screen

the parameters
that fall under
that heading.

Description:

Sender: |Elank of America (Bank of America) ﬂ Control Mumber: |D
Receiver: |CLSA Limited (CLSA Limited) LJ Datar Status: iNon-modifiabIe ﬂ
Agreement IO |MT541 Export Service: 1 L—_:I
15 Document Type: |Wm.fin.d0c::UserParameters E! Initislization Service: | m
- P zlnfo %‘
MQSeriesinfo B
- AFT =
i

Agreement Status: Proposed / Last Modified: 2003-07-03 13:21:45.629

0K | Cancel |

In the preceding figure, the Agreement ID value of MT541 indicates that the TPA is for a
receiver because the starting business document for a receiver’s TPA is always a SWIFT
message. If this TPA were for a sender, the Agreement ID would be the name an internal
business document from a back-end system such as InternalCorporateAction.

Important! The webMethods SWIFT FIN Module does not support a TPA in which either
the Sender is known (for example Company1) and the Receiver is Unknown or in which the
Sender is Unknown and the Receiver is known (for example, Company2). The webMethods
SWIFT FIN Module supports only those TPAs in which either both the Sender and
Receiver are known (for example, Companyl and Company2, respectively) or Unknown.
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CHAPTER 9 Customizing Trading Partner Agreements

Agreement Details Field Descriptions

The following table lists and describes the basic TPA information at the top of the
Agreement Details screen that you need to understand.

TPA Information Description

Sender The name of the trading partner that has the sender role in the
TPA. You select the sender from the profiles defined on your
Trading Networks system, including your own profile.

Receiver The name of the trading partner that has the receiver role in the
TPA. You select the receiver from the profiles defined on your
Trading Networks system, including your own profile.

Agreement ID An application-specific field that uniquely identifies the type of
agreement between two partners. For example, MT541 or
InternalCorporateAction.

IS Document Type ~ The IS document type wm. fin.doc:UserParameters specifies the
parameters that you define for a SWIFT TPA. It is located in the
WmFINTransport package.

For step-by-step instructions about how to create or modify a TPA, see the webMethods
Trading Networks User’s Guide.
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TPA SWIFT-Specific Input Parameters

To modify TPA input parameters, click ¥ on the Agreement Details screen.

TPA Input Screen

El Irpeiit Foor “venn fin doc:UserPar anebers”

FiNProceszinfo Transport M2 ﬂ
MessageType 540
EDocumentiMame wm fin doc mey0S catSMTI40
MessageFormat TAG_BIZNAME ~ |
SubfieldFiag true * |
ValidateContent No =
ValidateBiCPus o ~ |
ValidateNetworkrules o~ |
. z W —_———
ValidateMarketPractcafules Mo~ |
MarketPraciceRules Service
ValidateUsageRules Mo~ |
UsageRufes Sarvice
DA — LogealTermnal

Serviceldertifier 01 ¥ |
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CHAPTER 9 Customizing Trading Partner Agreements

The following table describes the TPA input parameters for a SWIFT-specific TPA that

you need to complete.

TPA Section Parameter

Description

FINProcessInfo ~ Transport

Name of the SWIFT interface used to send and receive
SWIFT FIN messages. Select one of the following values:

B MQ (Default). Use webMethods WebSphere MQ
Adapter to transport SWIFT FIN messages.

B CASmf. Use CASmf to transport SWIFT FIN messages.

B AFT. Use Automated File Transfer to transport SWIFT
FIN messages.

B TEST. Enables you to test the processing of your FIN
message without sending the message to SWIFT.

MessageType

SWIFT FIN message type identifier, such as 541, which
identifies MT 541, Receive Against Payment.

ISDocumentName

The IS document type name for this particular message.
You can find the IS document type for each message record
you have created in the WmFINMessages package. For
example, wm.Ffin_doc.may05.cat5:MT541.

Version

Version number of the SWIFT message record being used.
For example may05.

MessageFormat

The format of the generated blocks and fields for the input
FIN message. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed
by the business name specified in the message DFD.
For example, 23G_Function of the Message.

TAGONLY. SWIFT Message tag only. For example, 23G:.

B BIZNAMEONLY. Business name specified in the message
DEFD. For example, Function of the Message.

B XMLTAG. XML-compatible tag name. This format
cannot contain colons or tags that begin with a
number. For example, F23G.

SubfieldFlag

Indicates whether to parse SWIFT messages to the field or
subfield level. Select one of the following values:

B true (default). Parse to subfield level.

B false. Parse to field level.
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TPA Section Parameter

Description

InboundProcessingRuleService

Optional - Indicates whether to manage the execution of this
SWIFT message using a processing rule you have created.
To do so, type the name of the service you created. For
more information, see “Receiving Inbound Messages Using
a Processing Rule” on page 51 of Chapter 4, “Sending and
Receiving SWIFT Messages” in this guide.

ValidateContent

Optional - Indicates whether to validate the SWIFT message.

ValidateBICPlus

Optional - Indicates whether to validate the BIC+
information included in the message.

ValidateNetworkRules

Optional - Indicates whether to validate the SWIFT message
against the network rules for this message.

NetworkValidationService

Optional - Name of the network validation service to
validate the network rules for this message.

ValidateMarketPracticeRules

Optional - Indicates whether to validate the SWIFT message
against the Market Practice rules for this message.

MarketPracticeRulesService

Optional - Name of the Market Practice Rules service to
validate the Market Practice rules for this message.

ValidateUsageRules

Optional - Indicates whether to validate the SWIFT message
against the usage rules for this message.

UsageRulesService

Optional - Name of the usage validation service to validate
the usage rules for this message.

Message Header  This section contains information to be populated in blocks {B1}, {B2}, and {B3} of the

outbound SWIFT message.

Logical Terminal

The logical terminal identifier defined in SAA.

Applicationldentifier

Identifies the application within which the message is
being sent or received. Select one of the following values:

B F. SWIFT FIN - Use this setting for all FIN user-to-user,
FIN system, and FIN service messages.

B A GPA - Use for GPA system and GPA service
messages.

B L. GPA - Use for certain GPA service messages. For
example, LOGIN, LAK, ABORT.
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TPA Section Parameter Description

Serviceldentifier Identifies the type of data being sent or received. Select one
of the following values:

B (1. Identifies user-to-user messages.

B 21. Identifies message acknowledgements.

Priority Indicates the priority with which the message is being
delivered to the receiver. Select one of the following values:

B N. Delivered with Normal priority.
B U. Delivered with Urgent priority.

B S. Delivered with System priority.

DeliveryMonitoring Optional - Enables the sender to request one of the following
levels of delivery monitoring:

B None. Do not perform delivery monitoring.

B 1. Non-delivery warning - Requesting automatic
MTO010 non-delivery warning if message is not
delivered within the obsolescence period, which is 15
minutes for U Priority, 100 minutes for N Priority.

B 2. Delivery notification - Requesting automatic MT011
delivery notification after the message is delivered.

B 3. Both - Requesting both automatic non-delivery
warning and delivery notification.

FINCopyServiceldentifier Optional - (Used with FINCopy messages only.) Three-
character system ID used to support access to multiple
services with the same CBT.

BankingPriority Optional - Four-character field agreed upon by two or more
parties to indicate priority.

ValidationFlag Optional - Flag indicating whether special validation needs
to be completed at SWIFT. For more information, see
SWIFT documentation.

Addresseelnformation Optional - Information from the central institution to the
receiver of the payment message. This information is used
in the input of MT097, FIN Copy Message Authorization
Refusal Notification.

Training Indicates whether a message is sent to or received from a
test and training logical terminal.
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TPA Section

Parameter

Description

MQSeriesInfo

putMessageHandlerService

The name of the service that you generated when creating a
message handler service for your IS-to-WebSphere MQ
transport. For more information, see “Using the
webMethods WebSphere MQ Adapter to Communicate
with SWIFT” on page 54.

AFT

folder

Fully qualified path of the folder you want the File Polling
Listener to poll for this SWIFT message. For example,
c:\folder\bic.dat.

Important! This folder must be accessible by both Integration
Server and SAA.

extension

Optional - File extension of the files to be received from the
AFT folder. The default is inp.

webMethods SWIFT FIN Module Installation and User’s Guide Version 6.1
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CHAPTER 10 Mapping a SWIFT FIN Module Process

What Is “Mapping” a Message?

Mapping a message refers to the process of assigning the structure, values, or content of
the message to a new message; that is, mapping the values, data, and information into a
new message. You need to map messages because, typically, your back-end systems have
different message formats than the format of a SWIFT message.

Why Do You Create an Outbound Mapping Service?

You create an outbound mapping service to translate an outbound back-end proprietary
message format (for example, Oracle Financials) to SWIFT message format. Elements of
the proprietary message need to be mapped to corresponding elements of a SWIFT
message (for example, MT 541, Receive Against Payment). Extra elements in the back-end
message are ignored; however, you must map values to all elements in the SWIFT
message.

Examples of outbound mapping services are located in the WmFINSample package.

Why Do You Create an Inbound Mapping Service?

You create an inbound mapping service to map each element of an inbound SWIFT
message to a corresponding element in your back-end proprietary message format. For
example, if you use Oracle Financials and you want to receive a SWIFI message via the
webMethods SWIFT FIN Module, you create an inbound mapping service that maps each
element of the SWIFT message to a corresponding element in the Oracle Financials
format.

Examples of inbound mapping services are located in the WmFINSample package.
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What Is “Mapping” a Message?

Example of Mapping a Message

The following figure illustrates the process of mapping a message. For further
explanation, see the text that follows the figure.

Example of Mapping a Message

Internal

—~

Back-End
System Internal

t

Back-End
Internal System

— |

6

Process Model Process Model
Integration Server Integration Server
Trading Partner A Trading Partner B

Step Description

Trading Partner A uses an outbound mapping service to map an internal
message from a back-end format to SWIFT format.

Trading Partner A sends the SWIFT message to Trading Partner B.

Trading Partner B receives the SWIFT message and uses an inbound mapping
service to map the SWIFT message to an internal message. After the internal
message is mapped, it is in a format that Trading Partner B’s back-end system
can process.

Trading Partner B responds by using an outbound mapping service to map an
internal message from a back-end format to SWIFT format.

Trading Partner B sends the SWIFT message to Trading Partner A.
g g g
[ 6 |

Trading Partner A receives the SWIFT message and uses an inbound mapping
service to map the SWIFT message to an internal message. After the SWIFT
message is mapped, it is in a format that Trading Partner A’s back-end system
can process.
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CHAPTER 10 Mapping a SWIFT FIN Module Process

Creating an Outbound Mapping Service

In webMethods Developer, you create an outbound mapping service by creating a service
that contains one or more MAP entities, which do the actual mapping from your back-end
message, through any desired intermediate steps, to the IS document type for the
appropriate outbound SWIFT message.

Input/Output to Use

The input to the outbound mapping service is a TN document type representing your
back-end document in a variable named bizEnv.

Note: For information about retrieving your back-end document from the bizEnv variable,
refer to the outbound mapping services in the WmSamples package.

The output of the outbound mapping service is the SWIFT message in the
documents \ payload IData object in the pipeline. For example, if you are mapping your
back-end message to the MT 564, the output of the mapping service would be MT564 in
the documents\ payload IData object. See the figure in “Example of an Outbound Mapping
Service” on page 101.

The output of the outbound mapping service must be placed in the documents\ payload
IData object. Because the webMethods SWIFT FIN Module has to convert an IData object
into an XML string before sending the SWIFT message to the trading partner, it must
know the precise location of the IData object.

Also, you must place the Agreement ID for this TPA in the documents\ tpaAgreementID
IData object. For more information about Agreement IDs, see Chapter 9, “Customizing
Trading Partner Agreements” on page 87.

Note: If the documents for your back-end system have DTDs, you can automatically
import an external DTD in webMethods Developer to provide a starting point for
mapping. To do so, create an external record and specify the source as XML, DTD, or XML
Schema.
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Creating an Outbound Mapping Service

Flow Operations to Use

In the flow service, you insert a MAP operation and use the service pipeline to map
elements of the IS document type from your back-end message to all elements of the IS
document type for the appropriate SWIFT message. Built-in IS document types for all
versions of the SWIFT FIN messages that you imported are located in the
WmFINMessages Package in wm \ fin\ doc\ version \ category folders as illustrated in the
following figure.

Records Available for Mapping

- WimFIN

=) WimFINDey

- WimF INMarketPractice
E@ WimFINMessages

= E WM

------ I:} MTI00MetworkialidationRules

This folder containsall @ P E;} MT910MetworkialidationRules

Soamenpestat e C> MT340NetworkvalidationRules
------ I::> MTas0NetworkValidationRules

R mMTa00

...... MTE9 0

...... MTE40

...... mMTa50

-3 WmFINSamples

---@WmFINTranapur’[

Example of an Outbound Mapping Service

If you are the sender in a business process and are implementing a version of MT 564, an
outbound mapping service converts your back-end business document to a DFD and then
to a SWIFT message. One of these outbound mapping services might look like the
following figure. For further explanation, see the text that follows the figure.
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Outbound Mapping Service
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Under the Pipeline Out heading, in the documents\payload IData object, the MT564 not in
parentheses is the IData object, or SWIFT message, being sent to the trading partner and
the MT564 in parentheses is the IS document type that defines the SWIFT message. The

name of the IData object is case sensitive.

Creating an Inbound Mapping Service

In webMethods Developer, just as with outbound mapping services, you create an
inbound mapping service by creating a new service that contains one or more MAP
entities, which do the actual mapping from the received SWIFT FIN messages, through
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Creating an Inbound Mapping Service

any intermediate steps, to the format of your back-end messages. The inputs to any
inbound mapping service include the following variables:

B finlData. This is the message in TAG format.

B convertedFinlData. This is the format specified in the message TPA

(for example, TAG_BIZNAME).

Example of an Inbound Mapping Service

If you are the receiver in a business process and are implementing a version of MT 564, the
inbound mapping service might look like the following figure.

Inbound Mapping Service
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Note: The finIData object that contains information from the inbound SWIFT message is

mapped to the InternalCorporateAction IData object representing your back-end document.
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Parsing to the Subfield Level

You can configure the webMethods SWIFT FIN Module to parse to the subfield level in
your outbound and inbound mapping services. To do so, you set the subfieldFlag variable
to true when invoking the following services:

B wm.fin.deviimportFINItem
B wm.fin.dfd:convertTagFormat
B wm.fin.dfd:convertBizZNameFormat

For information about these services, see Appendix A, “webMethods SWIFT FIN Module
Services” on page 119.

For inbound messages, if you want to manually parse messages to the subfield level
(without using subfield option), you must manually remove the SWIFT delimiter (/) from
between subfields. For outbound messages, if you want to manually identify subfields
(without using the subfield option), you must add the SWIFT delimiter.

u Note: The DFDs files provided in
webMethods6\IntegrationServer\packages\WmFIN\dfd\version directory and
webMethods6\IntegrationServer\WmFINDev\import\version directory do not define
subfields for some compound fields. If you require subfields for a tag where they are not
provided, you can edit the DFD files; be sure to follow the SWIFT documentation when
adding subfields. The DFD files located in the WmFINDev package take precedence over
the DFD files located in the WmFIN package.

Reusing Mapping Services

In the webMethods SWIFT FIN Module, you can reuse mapping services for trading
partners that submit the same business document format. For example, you can use the
same mapping services for Trading Partner A and Trading Partner B if they both always
submit business documents in the same document format to the webMethods SWIFT FIN
Module. As the receiver of those documents, you need to define only one inbound
mapping service for both trading partners because the message format versions are the
same.
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CHAPTER 11 Creating or Modifying a Process Model

What Is a Process Model?

A process model is a diagram that represents a business process. The following figure
illustrates a sample process model. For further explanation, see the text that follows the

figure.

Sample Process Model

Eacksnd Sy=tem SWFT Alliance
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computer. 2 vaidats Corporate
q Action hztruction i
8B a.

- wiat for Intsrnal Frocess B Receive Status
Transitions are Statis of Corporie Actbn Instruction MIS65
lines between Inztruction Ims tructon
steps that Send Backend
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flow of 7

: Fmocess Level
execution. —— S >, error ﬁ
@ """""""""""""""""""""""""""""" s
Qutbound Map Send Statie of Wat for 867
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steps that are NE et Outtrund Map Send Ganfirm A P
performed R;o::t Acr;i:rnryn e Account Activly Ancourt Actiity
outside of an {MTEES) to Account Ow ner
enterprise. ;
e
A process model consists of:
B Steps. The basic unit of work in a process model.
B Transitions. The lines between steps that indicate the execution order of steps within
the process model.
B Groups. Clustering steps to represent different organizational boundaries within a
process model.
B Annotations (notes or text). The labels, notes, and explanatory text in a process model.
For more information about steps, transitions, groups, and annotations, see the
webMethods Modeler User’s Guide.
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Working with Process Models

The steps in a process model determine how the Process Run Time (PRT) conducts a
business process, which includes how the Process Run Time processes a SWIFT message.
For information about the Process Run Time, see “Run-Time Architecture/Components”
on page 24, the webMethods Modeler User’s Guide, and Getting Started with webMethods
Business Process Management.

webMethods provides process model samples that you can use to create your own
process models. You specify how the process model is to interact with your back-end
systems by editing the services that are invoked by the steps of the process model,
identifying the TN document types that you have created for steps that are waiting for
messages, and specifying inbound and outbound mapping services. When creating a
process model, you also assign TN roles to TN document types and a focal role to the
process model.

You use webMethods Modeler to create the process models based on the messages you
are using. For more information about process models and Modeler, see the webMethods
Modeler User’s Guide.

Note: You can use webMethods Trading Networks processing rules instead of the Process
Run Time to manage the execution of SWIFT FIN messages. For information about
creating processing rules, see Chapter 4, “Sending and Receiving SWIFT Messages” on
page 43.

What Is a Role?

In webMethods Modeler, you assign roles to TN document types that are associated with
steps that wait to receive a message, such as an MT 564.

TN Roles
You
Bank Broker

Your Trading Partner A/

When you identify a TN document type that you created for a particular wait step,
Modeler prompts you to enter the Sender Role and Receiver Role in the Set Roles dialog box.
For example, if you are identifying a TN document type for a particular wait step with the
name of a MT 564 that you are sending to a trading partner, you would enter “Bank” as
the Sender Role and “Broker” as the Receiver Role.
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Focal Role

When you create a process model, you also assign a focal role to the process model. A focal
role specifies the role of the user for a particular business process. You assign a focal role
for your enterprise in the Properties dialog box in Modeler.

Using Process Model Samples

webMethods provides the following process model samples to assist you in creating your
process models:

B CorpAction_AccountOwner.model

B CorpAction_AccountServices.model

You can find the process model samples in the following location:
webMethods6 \ IntegrationServer \ packages\ WmFINSample\ data

where webMethods6 \ IntegrationServer is the directory in which the webMethods
Integration Server is installed.

Creating or modifying a process model consists of such tasks as specifying the TN
document type for a particular wait step, assigning inbound and outbound mapping
services to invoke during the respective mapping steps, and so on. When you modify or
create a process model, you must generate and update your process model in
webMethods Modeler to create a business process, and then enable that business process
in webMethods Monitor.

To see these process models used in a sample, see Appendix C, “webMethods SWIFT FIN
Module Sample” in this guide. For more information about creating process models, see
the webMethods Modeler User’s Guide and Getting Started with webMethods Business Process
Management.
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CHAPTER 12 Monitoring a Process

Why Monitor a Business Process?

You monitor a webMethods SWIFT FIN Module business process to track the state of a
particular SWIFT transaction. For example, suppose that you send a message to a trading
partner. The next day, the trading partner calls to say that they did not receive your
message. In the webMethods SWIFT FIN Module, you can view the activity of the
business process to determine what the current status is and what activity has occurred
during the progress of the business process.

Following the same example, a reason why the trading partner did not receive the
message could be because the transaction encountered an error, such as a timeout error.
By monitoring the business process, you can determine whether this was the cause. You
can see whether your message was resent, how many times, and with what success. By
viewing the current status of and the progress of a transaction, you can take appropriate
action, which might include retrying the business process, editing your trading partner
profiles, or editing your process models.

Finding Business Process Information

To monitor business processes, you have a number of sources from which you can draw
information to determine the status of your business processes and the activity of the
various involved software entities. The following table lists and describes the primary
sources.

Source Description

webMethods Monitor Use this tool to monitor and manage business processes.
For information about using webMethods Monitor, see
“Using Monitor” on page 111. For more information
about using webMethods Monitor 6.0.1, see the
webMethods Monitor User’s Guide. For more information
about using webMethods Monitor 6.1, see the
webMethods Integration Platform Installation Logging and

Monitoring Guide.
webMethods Trading Use this log to query and analyze results of documents
Networks Transaction that are sent or received by Trading Networks. For
Analysis screen information about transaction analysis, see the
webMethods Trading Networks User’s Guide.
webMethods Integration Use this log to retrieve server-related error and
Server error log exception messages that occur during an invocation of a

service directly or indirectly from a business process.
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Using Monitor

Monitor is a web-based user interface that you can use to examine instances of your
process models. Monitor displays information about instances of your process models by
accessing data from the Process Logging Database. For information about the Process
Logging Database, see “Run-Time Architecture/Components” on page 24.

Using Monitor, you can:

Search for a business process by name, status, or date range.

Search specifically for a business process that ended in error.

See a graphical overview of a business process.

Examine information about a business process and its execution, for example, status
of the business process, status and iteration of process model steps, and so on.

View services used in the business process.

Perform control tasks to affect the state of a business process:

Suspend and resume a business process.
Enable and disable a business process.
Start and stop a business process.

Edit and resubmit process model steps.

For more information about Monitor and for procedures to perform the aforementioned
tasks, see one of the following:

B If you are using webMethods Monitor 6.0.1, see the webMethods Monitor User’s Guide.

B If you are using webMethods Monitor 6.1, see the webMethods Integration Platform

Installation Logging and Monitoring Guide.
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Overview

Market Practices are specific requirements for individual markets. Using Trading Partner
Agreements (TPAs), the webMethods SWIFT FIN Module supports customization of
SWIFT FIN messages based on specific trading partner sender-receiver pairs. For
example, two partners trading within France might have different processing
requirements for their SWIFT FIN messages than two trading partners within Austria.

SWIFT FIN messages that are exchanged between two partners may have additional
fields and/or a subset of key words. The webMethods SWIFT FIN Module enables you to
maintain multiple versions of a given message that conform to different Market Practices.

Creating Market Practices

You create a Market Practice by creating an alternate version of the SWIFT message based
on an original message record. Doing so maintains the original content of the message
record.

I 1o create a Market Practice

1 Onyour file system, create identically named folders (for example, FrenchMarket) in
the following directories:

B webMethods6\IntegrationServer\packages\WmFINDev\import directory
B webMethods6\IntegrationServer\packages\WmFIN\config\dfd

2 Copy dfd000.xml from WmFIN\config\dfd\may05 to
WmFIN\config\dfd\FrenchMarket, where may05 is the SWIFT message version, for
example mayO05.

3 Copy the dfd*.xml file (for example, dfd541.xml) for your message from
WmF INDev\import\may05 to WmFINDev\import\FrenchMarket.

4 Open your French Market\dfd*.xml and edit as necessary by deleting or changing
existing information.

Sample of dfd541.xml File

<7uml version="1.0" 7=
- <constraintss
«l-- Text Block for MNT541 -->=
- <field name="11A::DENO" type="PatternType"=
<hizMame=Currency A - Currency of the Denomination</bizNameaz
zpattern=/f<CUR>=</pattemz=
< /ffeld=
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5 Inthe webMethods Developer, run the wm.fin.dev:iimportFINitems service for the message.
The Input screen appears.

importFINItems Service Input Screen
|E| Input for ‘importFINIEEMS x |

msoType |

YErsion |

format [TAG_BIZNAME = |

subfieldFlag Itrue vI
createDocType Itrue vI

createProcessingRue Itrue ¥ I

createTPA Itrue ¥ I

[ Include empty values for String Types

(0] 4 Cancel | Load | Save Help

6  On the Input screen for the importFINItems service, set the version field to the name of the
new folder (for example, FrenchMarket). Set the remaining fields as desired.

7 In the Trading Networks Console, click the Agreements tab, open the TPA for the

particular SWIFT message, and then click % on the Agreement Details screen to
display the Inputs screen.

8  On the Input screen, set the ISDocumentName parameter to the location the new message
record (for example, wm.fin.doc.FrenchMarket._catl1:MT103).

9  Set the Version parameter to a new Market Practice version name (for example,
FrenchMarket).
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10 Set the MarketPracticeRulesService parameter to the Market Practice rule for this SWIFT

message.
Completed Market Practice TPA Input Screen

|E| Input for "wm.fin.doc:UserParameters

FINProcessinfo

MessaneTyp ,3__:;_|3|:|3

fehwork\Validationsend e_.|Wm.fin.du:u:.Frenu:hMarket.u:aﬂ :MT1 03Metwork alicate
ValidateMarketPracticeRules [No ~|

.Ir.alnne VI

For more information about TPAs, see Chapter 9, “Customizing Trading Partner

Agreements” in this guide.
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Creating Market Practice Rules

The webMethods SWIFT FIN Module provides 16 common Market Practice rules for
Category 5 SWIFT FIN messages. You can create additional Market Practice rules by
writing services based on message documentation (pdf) provided by SWIFT.

To use a new Market Practice rule, you must specify the service you created in the
MarketPracticeRulesService parameter in the TPA for the particular SWIFT message. For
more information about TPAs, see Chapter 9, “Customizing Trading Partner Agreements”
on page 87.
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WmCASmf Package

The WmCASmf Package contains support services used to send and receive messages from CASmf.

wm.casmf.init

The services in this folder perform initialization routines for CASmf.

wm.casmf.init;shutdown

This service unregisters the application with CASmf.

wm.casmf.init:startup

This service registers the application with CASmf Input Name.

wm.casmf.trp

This folder contain services to send and receive messages from CASmf.

wm.fin.transport.casmf:SendReceiveSchedule

This is the service to be run as a scheduled job by the user. This service will first send all the outbound
messages to CASmf using the value specified for wm.casmf.send.mapid in wncasmf.cnf Ffile located in
webMethods6\IntegrationServer\packages\WmCASmf\config folder. Then incoming messages are
retrieved from CASmf using the value specified for wm.casmf.receive.mapid in wmcasmf.cnf file. The
messages received are then published to the Integration Server/Broker for processing by
wm.fin.trp:receive service in WmFIN package.

wm.casmf.trp:processOutboundMessage

This service is invoked when publishing an outbound message with the Transport parameter in the
message TPA is set to CASmf. This service writes the SWIFT message to a unique file name located in the
folder specified by the wm.casmf.send.message.folder property in the file webMethodsé\IntegrationServer
\packages\WmCASmFf\config\wmcasmf.cnf.

Input Variables Type Description
wm.fin.doc:FIN Document Document subscribed by this service when the Transport
OutboundMessage parameter in the message TPA is set to CASmf.
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wm.casmf.trp:sendAndReceive

Service to send and receive messages from CASmf. This service is invoked by the
wm.casmf.trp:casmfSendReceiveSchedule service. Messages received from CASmf are accumulated into a
String [ ].

Output Variables Type Description

receivedFINMessages ~ String List List of messages received from CASmf.

wm.casmf.trp: CASmfOutboundTrigger

Trigger to process outbound SWIFT FIN messages to sent via CASm(f. This trigger then invokes
wm.casmf.trp:processOutboundMessage to process the outbound SWIFT message.

wm.casmf.util

This folder contains utility services for retrieving property values specified in
webMethods6\IntegrationServer\packages\WmCASmf\config\wmcasmf.cnT file.

wm.casmf.util:getOutboundMessageFolder

This service retrieves the value for the wm.casmf.send.message.folder property specified in
webMethods6\IntegrationServer\packages\WmCASmf\config\wmcasmf.cnf file. This is the folder to
which all outbound SWIFT FIN messages to CASmf are stored prior to actually sending them to CASmf.

Output Variables Type Description

folder String Value specified for the wm.casmf.send.message.folder property in
the wmcasmf _cnf file.
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WmFIN Package

The WmFIN Package contains services used to implement and support the SWIFT FIN-compliant
functionality of the webMethods SWIFT FIN Module.

wm.fin.bic
This folder contains BIC-related services. They are used in inserting and retrieving BIC information.

wm.fin.bic:getBICInfo

Retrieves BIC information from database based on specified criteria.

Input Variables Type Description

code String BIC code of the financial institution. You may specify a partial
String specified using %partial string%.

bicKey String BIC+ key of the financial institution.

institution String Name of the financial institution.

branch String Name of the financial institution’s branch.

city String City in which the financial institution is located.

modFlag String BIC modifier flag for the financial institution, which identifies

additions, updates, and deletions of BIC records since the last
update. Valid Values:

B A Addition.
B U. Unchanged.
B M. Modified.

location String Location of the financial institution.

countryName String Country in which the financial institution is located.
Output Variables Type Description

count String Specifies the number of BIC records returned in the search.
biclnfo Document List ~ BIC records specifying the search criteria.
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wm.fin.bic:insertBICList

Imports BIC list into database.

Input Variables Type Description

filename String Fully qualified path and file name of the BIC list you want to
import. For example, c:\folder\bic.dat.

biclnfo String Specify the type of BIC list you are importing. Valid values: BIC
or BIC+.

Output Variables Type Description

errorMessage String Specifies the error message if one occurs.

error String Specifies whether an error occurred. Valid values: yes and no.

wm.fin.bic:BICInfo

Record structure identifying BIC record retrieved from the database. This specifies the result of the

wm.fin.bic.getBICInfo service.

wm.fin.dfd

This folder contains services related to the loading and use of the FIN Data Field Dictionary (DED).

wm.fin.dfd:convertBizNameFormat

Converts FIN IData from specified format to TAGONLY format and merges subfields into a FIN field.

Input Variables Type Description

finlData Document FIN IData in the format specified in the fromFormat input string.
msgType String SWIFT message type identifier. For example, 541.

version String Version number of the SWIFT message record being used. For

example, nov03.
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Input Variables Type Description

fromFormat String The format of the generated blocks and fields for the input
SWIFT message. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by
the business name specified in the message DFD.

B TAGONLY. SWIFT Message tag only.
B BIZNAMEONLY. Business name specified in the message DFD.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.

subfieldFlag String Specifies whether the fields in the input FIN IData are parsed to
the subfield level. Valid values:

B true (default). Parse to the subfield level.

B false. Parse to the field level.

Output Variables Type Description

convertedFinlData Document Converted FIN IData in the format of TAGONLY.

wm.fin.dfd:convertTagFormat

Converts FIN IData from TAGONLY to the specified format and parses whole fields into subfields.

Input Variables Type Description

finlData Document FIN IData in the format specified in the fromFormat input string.
msgType String SWIFT message type identifier. For example, 541.

version String Version number of the SWIFT message record being used. For

example, may05.
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Input Variables Type Description

toFormat String The format of the generated blocks and fields for the output FIN
IData. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by
the business name specified in the message DFD.

B TAGONLY. SWIFT Message tag only.
B BIZNAMEONLY. Business name specified in the message DFD.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.

subfieldFlag String Specifies whether the generated fields in the output FIN IData
are parsed to the subfield level. Valid values:

B true (default). Parse to the subfield level.

B false. Parse to the field level.

Output Variables Type Description

convertedFinlData ~ Document Converted FIN IData in the format specified in the fromFormat
input string.

wm.fin.dfd:getDFDList

Displays a list of DFDs loaded into the system.

Output Variables Type Description

dfdList String List List of DFDs loaded into the system in <dfd name>_<dfd
version> format. For example, 541_mayO05.

wm.fin.dfd:loadDFD
Loads a FIN DFD into memory.

Input Variables Type Description
msgType String SWIFT message type identifier. For example, 541.
version String Version number of the SWIFT message record being used. For

example, may05.
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wm.fin.dfd:unloadDFD
Unloads a FIN DFD from memory.

Input Variables Type Description
msgType String SWIFT message type identifier. For example, 541.
version String Version number of the SWIFT message record being used. For

example, may05.

wm.fin.dfd:unloadDFDs
Unloads all FIN DFDs from memory.

wm.fin.doc

This folder contains the document structures used to represent particular sections of SWIFT FIN messages,
such as the header and trailer structures and their fields. Also within this folder are the generic structure
definitions for incoming and outgoing SWIFT FIN messages, where the data record structure (known as
Block 4 in SWIFT FIN messages) is left as an open record. These are generated by the
wm.fin.dev:iimportFINItems service in the WmFINDev package.

wm.fin.doc:FINIData_Input

Record structure defining the fields of an incoming SWIFT message. B4 is left as open record and can be
created based on the particular message type and version.

wm.fin.doc.header:FINIData_Outgoing

Record structure defining the fields of an outgoing SWIFT message. B4 is left as open record and can be
created based on the particular message type and version.

wm.fin.doc.catF

The record definitions within this folder describe the record structures used to represent the body of the
FIN Acknowledgement

wm.fin.doc.catF:MTF21
Record structure defining the fields of the body of the FIN Acknowledgement (F21).
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wm.fin.doc.header

The record definitions within this folder describe the record structures used to represent the three header
sections of a SWIFT message; the Basic Header (known as Block 1 in SWIFT FIN messages), the
Application Header (Block 2, in both incoming and outgoing message format), and User Header (Block 3).

wm.fin.doc.header:ApplicationHeader_Input

Record structure defining the fields of the Application Header (Block 2) on an incoming SWIFT message.

wm.fin.doc.header:ApplicationHeader_Outgoing

Record structure defining the fields of the Application Header (Block 2) on an outgoing SWIFT message.

wm.fin.doc.header:BasicHeader

Record structure defining the fields of the Basic Header (Block 1) of a SWIFT message.

wm.fin.doc.header:UserHeader

Record structure defining the fields of the User Header (Block 3) of a SWIFT message.

wm.fin.doc.trailer

The record definitions within this folder describe the record structures used to represent the trailer section
of a SWIFT message, known as Block 5.

wm.fin.doc.trailer:Trailer

Record structure defining the fields representing the Trailer section (Block 5) of a SWIFT message.

wm.fin.format

This folder contains format-related services. They are used in converting formats such as a SWIFT message
format into a FIN IData.

wm.fin.format:conformFINIData

Conforms (rearranges) FIN IData into correct structure based on B4 IS Document.

Input Variables Type Description
inputFINIData Document Input bound FIN IData. (Must include B4 block.)
isDocument String Fully-qualified is document name to conform inputFINIData B4

block to. For example, wm. fin.doc.may05.cat5:MT502.
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Output Variables Type Description

outputFINIData Document Output bound conformed FIN IData.

wm.fin.format:conformIData

Conforms (rearranges) IData into correct structure. Incorrect IData structure will not yield conformed
data.

Input Variables Type Description
finlData Document Input bound FIN IData.
isDocument String Fully-qualified IS document name to conform input finIData to.

For example, wn.fin.doc.may05.cat5:MT502.

Output Variables Type Description

finlData Document Output bound conformed IData.

wm.fin.format:convertFINTolData

Converts a SWIFT Message into a FIN IData. This will load a ‘parse” template into memory to create the
correct structure.

Input Variables Type Description

finMsg String Valid SWIFT message.

msgType String SWIFT message type identifier. For example, 541.

version String Version number of the SWIFT message record being used. For

example, may05.

Note: When using this service to convert a SWIFT
Acknowledgement (ACK) or Negative Acknowledgement
(NACK) to an IData object, do not specify the version input
variable because ACKs and NACKs are version neutral.

Output Variables Type Description

finlData Document FIN IData in the format specified.
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wm.fin.format:convertlDataToFIN

Converts a FIN IData into a SWIFT Message.

Input Variables Type Description

finlData Document FIN IData in the format specified.
Output Variables Type Description

FINmsg Document Output SWIFT message.

wm.fin.format:flushTemplateCache

Clears “parse’ templates from memory.

wm.fin.format:xmlITolData

Converts a XML-formatted SWIFT message into an IData.

Input Variables Type Description

xmlString String XML string.

Output Variables Type Description

outputIData Document Output FIN IData.
wm.fin.init

The services found in this folder are used to either initialize or de-initialize FIN packages on startup and
shutdown of webMethods Integration Server.

wm.fin.init:startup

Initializes DSP user interface and resource bundles and configures the WmFIN package for run-time.
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wm.fin.map

Services found in this folder provide easy frameworks for creating the header and trailer sections of SWIFT
FIN messages, for use in outbound (to be sent to SWIFT) messages. All services have as their input the
mandatory fields required in each appropriate header or trailer section.

wm.fin.maps.outbound:mapApplicationHeader

Maps the input variables into a default FIN Application Header.

Input Variables Type Description

userVariable Document FIN transport user variables.
TPA Document The TPA for SWIFT message.
Output Variables Type Description

B2 Document Application header IData.

wm.fin.maps.outbound:mapBasicHeader

Maps the input variables into a default Basic Header.

Input Variables Type Description

userVariable Document FIN transport user variables.
TPA Document The TPA for SWIFT message.
Output Variables Type Description

B2 Document Basic header IData.

wm.fin.maps.outbound:mapTrailer

Creates a Trailer record. When creating an outbound SWIFT message, this record does not need to be
populated, so this service currently creates an empty Trailer record.

Input Variables Type Description

userVariable Document FIN transport user variables.
Output Variables Type Description

B5 Document Trailer IData.
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wm.fin.maps.outbound:mapUserHeader

Maps a default User Header.

Input Variables Type Description

userVariable Document FIN transport user variables.
TPA Document The TPA for SWIFT message.
Output Variables Type Description

B3 Document User header IData.

wm.fin.rules

The services found within this folder provide utility functions that are used in the implementation of
network validation rules.

wm.fin.rules:checkCodeOrder

Specifies whether codes are in correct order.

Input Variables Type Description

codeList String List Input code list.

codeOrder String List Correct order of codes.

Output Variables Type Description

isCodeOrderValid String Specifies whether the code list is valid. Valid values: true or
false.

wm.fin.rules:contains

Specifies whether key is contained in code list.

Input Variables Type Description
codeList String List Input code list.
key String Key that may be in the code list.
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Output Variables Type Description

keyExists String Specifies whether the key exists in the code list. Valid values:
true or false.

wm.fin.rules:getDuplicateCodeList

Returns all codes that are duplicates in code list.

Input Variables Type Description

codeList String List Input code list.

Output Variables Type Description

duplicateCodeList String List All duplicate codes in the input codeList.

wm.fin.rules:setErrorDocument

Returns correct error document from specified variables.

Input Variables Type Description
key String Error message key. This is usually a FIN error message code.
path String Path of error in message. For example, B4/SBB/57D:.
data String Data where error occurs.
Output Variables Type Description
errors Document List ~ Error array with error appended to end.
wm.fin.trp

These two core services are used in conjunction with Trading Networks, to provide single-point access to
send and receive SWIFT FIN messages.

wm.fin.trp:receive

Triggered by the FINInboundMessageTrigger, this service receives an incoming FINInboundMessage IData,
parses it into a record, and sends it to Trading Networks to be recognized and routed.

Input Variables Type Description

FINInboundMessage ~ Document IData containing raw SWIFT message.to be processed.
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wm.fin.trp:send

Formats an IData into a SWIFT message and send it to the appropriate delivery service.

Input Variables Type Description

TPA Document IP TPA containing specified configuration variables.
documents Document IData containing FIN IData to process.

bizEnv Document TN business envelope containing document.

wm.fin.trp:FINInboundMessageTrigger

This Trigger subscribes to the wm.fin.doc:FINInboundMessage service. When a document is received, the

wm.fin.trp:receive service is invoked.

wm.fin.utils

The services found within this folder are generic utility services providing various functionality.

wm.fin.utils:getFINMessageAndIDs

From a raw SWIFT message, this service will recognize and extract the sender, receiver and message type.

Input Variables Type Description

rawFINMessage String Raw SWIFT message.

Output Variables Type Description

finMessage Document Contains SWIFT Message and whether message is an

internalSenderID String
internalReceiverID  String

msgType String

acknowledgement.
Trading Networks Internal Sender ID.
Trading Networks Internal Receiver ID.

SWIFT message type.
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wm.fin.validation

This folder contains validation-related services. They are used to facilitate the validation of a SWIFT

message.

wm.fin.validation:getErrorMessage

Return appropriate SWIFT message for that key.

Input Variables Type Description
key String Error key.
Output Variables Type Description
errorMessage String FIN error message.

wm.fin.validation:validationFinMsg

Parses and validates a SWIFT message.

Input Variables Type Description

bizdoc Document Trading Networks BizDocEnvelope containing SWIFT message.
Output Variables Type Description

finlData Document SWIFT message as an IData in TAGONLY format.

convertedFinlData Document

wm.fin.validation:validatelData

SWIFT message as an IData in specified format.

Provides Content Validation, Network Rule Validation, Market Practice Rule Validation, and Usage Rule

validation of a FIN IData.

Input Variables Type Description
finlData Document FIN IData.
userVariables Document User variables providing configuration information for

message.
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Output Variables Type Description

isValid String Specifies whether FIN IData passes validation according to the
message configuration.

errorArray Document Errors occurring if FIN IData doesn’t pass validation.

wm.fin.validation:validatelDataUtil

Validates content and structure of a FIN IData.

Input Variables

Type

Description

finlData

userVariables

msgType

version
isDocument

fromFormat

mapServiceName

validateHeaders

Document

Document

String
String

String

String

String

String

FIN IData.

User variables providing configuration information for
message.

SWIFT message type identifier. For example, 541.

Version number of the SWIFT message record being used. For
example, may05.

Fully-qualified name of the TN document type to validate FIN
IData structure. For example, wm. fin.doc.may05.cat5:MT502.

The format of the generated blocks and fields for the input
SWIFT message. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by
the business name specified in the message DFD.

B TAGONLY. SWIFT Message tag only.

B BIZNAMEONLY. Business name specified in the message DFD.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.

The migration map’s fully-qualified service name. For example,
wm.Fin_migration.maps:map520T0540.

Specifies whether service should validate headers. Valid values:
true or false.
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Output Variables Type Description

isValid String Specifies whether FIN IData passes validation according to the
message configuration.

errors Document Errors occurring if FIN IData does not pass validation.

WmFINDev Package

The WmFINDev Package contains the records and services that enable users to create message records,
TPAs, TN document types, validation rules, and processing rules.

wm.fin.dev

This folder contains design-time services. They are used in the install and configuration of new SWIFT FIN
messages.

wm.fin.dev:importFINItems

Imports, configures and creates all items needed in a SWIFT Message transaction. This includes the IS
document, DFD, parse template, TN doc type, TN processing rule, and TN TPA.

Input Variables Type Description

msgType String SWIFT message type. For example, 502.

version String FIN version. For example, nov03.

format String The format of the generated blocks and fields for the input

SWIFT message. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by
the business name specified in the message DFD. For
example, 23G_Function of the Message.

B TAGONLY. SWIFT Message tag only. For example, 23G:.

B BIZNAMEONLY. Business name specified in the message DFD.
For example, Function of the Message.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.
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Input Variables

Type

Description

subfieldFlag

createDocType

createProcessing
Rule

createTPA

String

String

String

String

Specifies whether the fields in the IS Document Type generated
for this FIN Message are parsed to the subfield level. Valid
values:

B true (default). Parse to the subfield level.

B Tfalse. Parse to the field level.

Indicates whether to create and insert a TN document type for
this message. The TN document type is used to recognize an
incoming message. Valid values: true or false.

Indicates whether to create a Trading Networks processing rule
for this message. After the message is recognized, the
processing rule specifies how the message should be
processed.Valid values: true or false.

Indicates whether to create a Trading Networks TPA for this
message. This specifies specific variables used in WmFIN for
processing and validation.Valid values: true or false.

WmFINMarketPractice Package

The WmFINMarketPractice Package contains common services that support Market Practices for some
Category 5 messages. The services in this package are for internal use only.
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WmFINTransport Package

This package contains the services needed to exchange messages with SWIFT using Automated File
Transfer (AFT) and MQSeries.

wm.fin.doc

This folder contains publishable IS document types that are used to send and receive SWIFT FIN
messages. It also contains IS document types which will be used to populate values for a given TPA.

Document Publishable  Description

FINInboundMessage Yes SWIFT FIN messages received via AFT or MQ Series are mapped
into this document. This document is then published to the
Broker or the Integration Server where it is processed by the
wm.fin.trp:FINInboundMessageTrigger service and the wm.fin.trp:receive
service.

FINOutboundMessage Yes SWIFT FIN messages to be sent via AFT or MQSeries are mapped
into this document and published to the Broker or the Integration
Server. If wm. fin.doc:FINOutboundMessage/Transport = MQ,
this document is subscribed and processed by the
wm.fin.transport. MQSeries:MQSeriesPutTrigger. If
wm.Fin.doc:FINOutboundMessage/Transport = AFT, this
document is subscribed and processed by the
wm.fin.transport AFT:AFTOutboundTrigger service.

MessageHeader No Data used to populate to header blocks (B1,B2,B3 and B5) in the
outgoing SWIFT message.
UserParameters No TPA information to be used while sending and receiving SWIFT

FIN messages.

wm.fin.transport.AFT

This folder contains services to send and receive messages using Automated File Transfer.

wm.fin.transport. AFT:generateUniqueFileName

This service generates a unique file name.

Input Variables Type Description
folder String The folder in which the file needs to be created.
extension String Optional - The extension to use for the generated file name. If no

”

extension has been specified, the default extension is “.inp”.
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Output Variables Type Description

fileName String Generated unique file name.

wm.fin.transport. AFT:processinboundFile

Flat File Listener invokes this service to process incoming SWIFT FIN messages received via AFT.

Input Variables Type Description

ffdata java.io.InputStream InputStream to the file received via AFT.

wm.fin.transport. AFT:processincomingMessage

This service parses incoming SWIFT FIN messages separated with special characters and outputs the
SWIFT FIN messages as a String array with the special characters stripped.

Input Variables Type Description

ffdata java.io.InputStream InputStream to the file received via AFT.

Output Variables Type Description

finMessage String List A string list containing the individual SWIFT FIN messages

with the special characters stripped.

wm.fin.transport. AFT:processOutboundFile

Generates a unique file name and writes the outbound SWIFT message to the file to the folder specified

in the TPA.
Input Variables Type Description
ffdata java.io.InputStream InputStream to the file received via AFT.
wm.fin.doc:FIN Document Document subscribed by this service when the
OutboundMessage Transport parameter in the message TPA is set to AFT.

wm.fin.transport. AFT:AFTOutboundTrigger

Trigger to subscribe for outbound SWIFT FIN messages when the Transport parameter in the message TPA
is set to “AFT”. The trigger then invokes the wm.fin.transport. AFT:processOutboundFile service to process the
outbound SWIFT message.
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wm.fin.transport.MQ

This folder contains services to send and receive SWIFT FIN messages from MQ Series.

wm.fin.transport.MQSeries:getListenerService

This is the service to be specified by the user when getting SWIFT FIN messages from a specified MQSeries
queue. This service strips out extraneous information in the SWIFT message and publishes the actual
SWIFT message to be processed further by services in WmFIN package. More specifically, wm.fin.trp:receive
service subscribes to, processes, and validates the message, after which the service will either pass the
resulting TN document type to the Process Run Time or to the specified Trading Networks processing
rule. The user must specify this service as the Message Service when creating the WebSphere MQ-to-IS
message handler.

Input Variables Type Description
msgbody String SWIFT message retrieved off the specified WebSphere MQ
queue.

wm.fin.transport. MQSeries:put

This service puts the outbound SWIFT message in a MQ Series queue by invoking the ‘put’ message
handler service created by the user and specified in the message TPA.

Input Variables Type Description
wm.fin.doc:FIN Document Document subscribed to by this service when the Transport
OutboundMessage parameter in the message TPA is set to “MQ”.

wm.fin.transport.MQSeries:MQSeriesPutTrigger

Trigger to subscribe to outbound SWIFT FIN messages when the Transport parameter in the message TPA
is set to “MQ”. The trigger then invokes the wm.fin.transport. MQSeries:put service to put the outbound SWIFT
message into the specified WebSphere MQ queue.
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wm.fin.transport.Test

This folder contains services, triggers and publishable documents to be used with WmFINSamples
package.

wm.fin.transport.Test:processFinMsg

Service to receive an outbound SWIFT message and simulate a round-trip by publishing the same message
as an inbound SWIFT message. This service is invoked by the
wm.fin.transport. Test: FINSampleOutboundMessageTrigger service when the Transport parameter in the message TPA
is set to “Test”.

Input Variables Type Description
wm.fin.doc:FIN Document Document subscribed to by this service when the Transport
OutboundMessage parameter in the message TPA is set to “Test”.

wm.fin.transport.Test:FINSampleInboundMessageTrigger

Trigger to subscribe to the FINSamplelnboundMessage document published by the
wm.fin.transport. Test:processFinMsg service. This trigger then invokes the wm.fin.sample:receive service to process
the incoming SWIFT message.

wm.fin.transport.Test:FINSampleOutboundMessageTrigger

Trigger to subscribe to outbound SWIFT FIN messages when the Transport parameter in the message TPA
is set to “Test”. The trigger then invokes the wm.fin.transport.Test:processFinMsg service to process the
outbound SWIFT message.

wm.fin.transport.Test:FINSamplelnboundMessage

Publishable IS Document representing an inbound SWIFT message to be used WmFINSamples package.

wm.fin.transport.property
This folder contains services to retrieve properties defined for publishing SWIFT FIN messages.

wm.fin.transport.property:getProperty

Outputs the property value specified in webMethods6\IntegrationServer\packages\
WmFINTransport\config\finTransport.cnf file.

Input Variables Type Description

propertyName String Property name specified in finTransport.cnf file
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Output Variables Type Description

value String Value of the property specified in finTransport.cnf file

wm.fin.transport.property:listProperties

Outputs all the properties specified in webMethods6\IntegrationServer\packages\
WmFINTransport\config\finTransport.cnf file.

Output Variables Type Description

properties Document List of all the properties and their values specified in
finTransport.cnf file

WmIPCore Package

The WmIPCore Package contains generic services for using the webMethods SWIFT FIN Module with the
webMethods Integration Server.

wm.ip.bizdoc

The services in this folder are used to deal with Trading Networks bizdoc envelope.

wm.ip.bizdoc:addErrorContentPart

Add/update errors content part of the bizdoc and set the User Status of the bizdoc

Input Variables Type Description

errors Document List  Error to be added as content part to the bizdoc.

bizdoc Document Bizdoc envelope to which errors must be added as content part.
errorType String User status to be set for the bizdoc.

Output Variables Type Description

bizdoc Document Updated bizdoc envelope.

wm.ip.bizdoc:decodeErrorContentPart

Decodes a byte [ ] into an document List object.

Input Variables Type Description

bytes byte [ ] Bytes to be decoded into a Document List object.
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Output Variables Type Description

errors Document List  Errors returned.

wm.ip.bizdoc:getBizDocFromEvent

Retrieve latest bizdoc envelope submitted to PRT (Process Run Time).

Input Variables Type Description

variables Document An IData object that contains the variables related to the current
business process.

document Document An IData object that contains the document related to the
current business process.

lastEvents String Optional - The events associated with the BizDocEnvelopes that
you want to retrieve.

getContent String Whether you want to retrieve the content. valid values: true or
false.

Output Variables Type Description

bizenv Document Bizdoc envelope retrieved from TN database.

wm.ip.cm

This folder contains services used to manage processes, such as start a process, unhandled documents, etc.

wm.ip.cm.handlers:defaultHandler

This service is a place holder for the service that is invoked by a handler step in a process model. You
should replace this service with a handler service that you code, and update the process model to reflect
your service.

Input Variables Type Description

ProcessData Document An IData object that contains run-time process information for
the process.
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wm.ip.cm.handlers:done

Sets the current business process to a done (completed) state.

Input Variables Type Description

ProcessData Document An IData object that contains run-time process information for
the process.

wm.ip.cm.handlers:done

Sets the current business process to an error state.

Input Variables Type Description

ProcessData Document An IData object that contains run-time process information.

wm.ip.cm:getConversation|D

Construct a Conversation ID in the format <OriginalReceiverID>-<Uniqueldentifier>.

Input Variables Type Description
bizdoc Document Bizdoc envelope associated with the current business process.
cid String Unique identifier to be used as part of the generated

Conversation ID.

Output Variables Type Description

convID String Generated Conversation ID.

wm.ip.cm:getConversationScript

Finds the first matching process run-time script for a given bizdoc (a BizDocEnvelope). Generates the
Conversation ID for the process run-time script that is going to be initiated.

Input Variables Type Description

bizdoc Document Bizdoc envelope used to find matching process run-time.
finlD String A unique identifier to be used as part of the Conversation ID.
direction String Whether the message is inbound or outbound. Valid values:

Inbound or Outbound.
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Output Variables Type Description
name String Specifies the first matching process run-time script for a given
bizdoc.

wm.ip.cm:processDocument

This service performs the following tasks:

B Recognizes the incoming document.

B Finds the matching process run-time script if the value you specify for cid is null.
B Saves the incoming document to the Trading Networks database.
|

Submits the recognized bizdoc to PRT.

Input Variables Type Description
node Object Optional - XML node to be recognized as a bizdoc.
input Document Optional - IData object to be recognized as a bizdoc to be

eventually used to start a new business process or rejoin an
existing business process. Either node or input must be present

in the pipeline.
nsDecls Document Optional - Namespace prefixes to use for the conversion.
cid String Optional -The Conversation ID of the business process that the

document, which is specified in input, is joining, if one exists. If
the document is not currently part of a business process, leave
cid null.

wm.ip.cm:startConversation

Starts a process model and passes it a matching process run-time script and assigns the business process
the specified Conversation ID.

Input Variables Type Description

matchResult Object The process run-time script that matches the given bizdoc.

cid String The Conversation ID to assign to the business process you are
starting.
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wm.ip.cm:waitSteplnit
Any step in the process that waits for a document can invoke this service. This service:
B Retrieves the BizDocEnvelope that is associated with the current document event.

B Retrieves the TPA that is associated with the business process if it does not already exist.

Input Variables Type Description

ProcessData Document The data associated with the current business process, such as
the process instance ID, roles, etc.

Input Variables Type Description

documents Document An IData object that contains the documents associated with the
business process.

variables Document An IData object that contains the variables associated with the
business process.

roles Document The role information for the sender and receiver of the
document.

bizEnv Document The BizDoc envelope that is associated with the most recent

document event.

TPA Document An IData object that contains the trading partner profile
information of the partners involved in the business process
and process specific variables.

wm.ip.profile

This folder contains services that are used to retrieve information about trading partners and the retrieves
the internal identifier of the sender and receiver for a business process.

wm.ip.profile:createCertChainList

Creates a certificate chain list with the user certificate as the first certificate in the list followed with the CA
certificate chain.

Input Variables Type Description
userCertBytes Byte [ ] User certified bytes.
certChainBytes Byte [ ] CA certificate chain bytes.
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Output Variables Type Description

certChain Object List User certified and CA certificate chain bytes.

wm.ip.profile:getinternallDs

Retrieves the internal identifier of the sender and receiver for a business process.

Input Variables Type Description

variable Document An IData object that contains the variables related to current
business process.

focalRole String The focal role associated with the current business process.

Output Variables Type Description

senderlD String The Trading Networks internal identifier of the sender.

receiverID String The Trading Networks internal identifier of the receiver.

tpaSenderID String The Trading Networks internal ID of the partner that is

associated with the focal role of the business process.

tpaReceiverID String The Trading Networks internal ID of the partner that is
associated with the second role of the business process.

secondRole String The second role associated with the current business process.

wm.ip.profile:getTPA

This service retrieves the TPA for a given sender, receiver and agreement ID combination.

Input Variables Type Description

docTypeName String Agreement ID of the TPA.

tpaSenderID String The Trading Networks internal identifier of the sender.
tpaReceiver]D String The Trading Networks internal identifier of the receiver.
Output Variables Type Description

tpaData Document IData object containing the retrieved TPA data.
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wm.ip.profile:getTPAInfo

Retrieves an IData object that represents the trading partner profile and process information related to the
current business process.

Input Variables Type Description

senderlD String The Trading Networks internal identifier of the sender.
receiverlD String The Trading Networks internal identifier of the receiver.
docTypeName String Name of the TN document type that was received.
tpaSenderID String The Trading Networks internal ID of the partner that is

associated with the focal role of the business process.

tpaReceiverID String The Trading Networks internal ID of the partner that is
associated with the second role of the business process.

Output Variables Type Description

TPA Document IData object containing sender, receiver profile information and
process information related to the current business process.

wm.ip.rec

This folder contains the IS document types used when retrieving TPA information.

IS Document Type Description

Address Address information for a trading partner.

Contact Contact information for trading partner.

Corporation Company entity information for trading partner.

Delivery Delivery method information for trading partner.

ExternallD An external ID for trading partner.

TPAInfo Trading partner profile information and process information.
TPInfo Trading partner information for a trading partner.
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wm.ip.ui
The services in this folder add submenus’ to the specified link under Adapters in the Server Admin Ul

wm.ip.ui:addSubmenu

Add the specified submenu under the specified link in Adapters section of the Server Admin UL

Input Variables Type Description

narme String The name of the adapter link in Adapters section of the Server
Admin UI to which the submenus need to be specified.

tabs Document List  Information containing the submenus to be added

wm.ip.ui:removeSubmenu

Remove the specified submenu under the specified link in Adapters section of the Server Admin Ul

Input Variables Type Description
name String The name of the adapter link in Adapters section of the Server
Admin Ul to remove.
tabs Document List  Information containing the submenus to be removed.
wm.ip.util

This folder contains utility services used by other packages such as generating unique ID, writing to a file,
etc.

wm.ip.util:createFinID

Generates a unique 16 character identifier

Output Variables Type Description

finID String Generated unique 16-character identifier.

wm.ip.util:formatErrorMessage

Formatted string representation of error IData object.

Input Variables Type Description
errorMessage Document IData object containing the error information.
tabs Document List  Information containing the submenus to be removed.
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Output Variables Type Description

formattedError String Formatted string representation of error IData object.

wm.ip.util:getLastDocuments

Retrieves the bizdoc envelope(s) specified in the lastEvents variable from TN database.

Input Variables Type Description

variables Document IData object containing the variables related to the current
business process.

documents Document IData object containing the documents related to the current
business process.

getContent String Optional - Whether you want to retrieve the content for the
bizdoc. Valid values: true or false.

lastEvents String List IDs of the bizdoc envelopes to be retrieved.

Output Variables Type Description

recordCount String Number of bizdoc envelopes retrieved from TN database.

events Document List  IDatal ] containing the retrieved bizdoc envelope.

wm.ip.util:init

Startup service for WmIPCore package to perform needed initialization routines.

wm.ip.util:invokeService

Invoke the specified service synchronously or asynchronously.

Input Variables Type Description
serviceName String Service to be invoked.
threadlnvoke String Optional - Whether service is invoked asynchronously.

true. Invoked asynchronously.
false. Invoked synchronously in the same thread.

input Document IData object containing data to be passed to the service being
invoked.
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Output Variables Type Description
events Document IData object containing the output from the service invoked
synchronously.

wm.ip.util:removeEmptyStrings

Recursively remove any string variables that either have a null value or zero length in the given IData
object.

Input Variables Type Description

Record Document IData object from which empty string variables need to be
removed.

Output Variables Type Description

Record Document IData object from which empty string variables have been
removed

wm.ip.util:writeLog

Write a message to Integration Server Log.

Input Variables Type Description

message String The detailed message to write to the Integration Server Log.
briefMessage String Optional - Brief message to write to the Integration Server Log.
relatedConversation  String Optional - The business process to which the log message relates.
1d

TNLevel String Optional - Type of activity log entry to create. Valid values: OFF,

MESSAGE, WARNING, or ERROR.

wm.ip.util;writeToFile

Writes the specified string or the specified bytes to the local file system.

Input Variables Type Description

FileName String Name of the file to which to write the specified the string or
bytes. Either specify a file name relative to the Integration
Server home folder or specify a fully-qualified path name.
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WmFINSamples Package

Input Variables Type Description

cursdata String Optional - String (in UTF-8 encoding) to write to the file system.
You must specify either userdata or byteslin.

bytesIn Object Optional - Bytes to be write to the file system. You must specify
either userdata or bytesin.

Output Variables Type Description

errorStatus String Optional - Error message when writing to the local file system.

wm.fin.mappingFunctions

The WmFINSamples package contains the services that are used by the sample.

The services found within this folder provide mapping functions that are used in SWIFT message
migration; that is, conversion of a SWIFT message from one ISO message type to another (in this case,
between ISO 7775 and ISO 15022). The functions are used in the services created by the
wm.fin.migration:templateToMap service to transform field values during the mapping process.

wm.fin.mappingFunctions:AccruedinterestRemoveDays

Remove days from Accrued Interest Field.

Input Variables Type Description
value String Input string.
Output Variables Type Description
output String Output string.
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wm.fin.mappingFunctions:BookValueToDealPriceln15022

Convert from ISO 7775 Book Value field to ISO 15022 Deal Price (place //ACTU at the start of the value).

Input Variables Type Description

value String Input string.

param String Input variable. This is the fully-qualified name of the field
within the target message where the party identifier will be
placed.

Output Variables Type Description

output String Output string. This is the remainder section of the input string.

wm.fin.mappingFunctions:CrestStripPartyldentifier

Strips party identifier from the value where the party identifier begins with ‘/CREST *, and returns both
the party identifier and the remainder.

Input Variables Type Description

value String Input string.

param String Input variable. This is the fully-qualified name of the field
within the target message where the party identifier will be
placed.

Output Variables Type Description

output String Output string. This is the remainder section of the input string.

wm.fin.mappingFunctions:FullStripPartyldentifier

Strips party identifier and returns both the party identifier and the remainder.

Input Variables Type Description

value String Input string.

param String Input variable. This is the fully-qualified name of the field
within the target message where the party identifier will be
placed.
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Output Variables Type Description

output String Output string.

wm.fin.mappingFunctions:InsertSlashes

Insert two slashes at the beginning of a string.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is “//” followed by the input string.

wm.fin.mappingFunctions:QuantityOfSecurities

Converts to new Security Quantity string format (Starts with FMT, UNT, or other to FAMT//, UNIT// or
AMOR// respectively.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is the converted QuantityOfSecurities value.

wm.fin.mappingFunctions:RemoveSlashes

Removes the slashes at the beginning of a string.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is input string without leading slashes.
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wm.fin.mappingFunctions:StripPartyldentifier

Strips party identifier and returns remainder.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is input string minus the party identifier (if
present).

wm.fin.mappingFunctions:TaxesAdded

Returns only the Taxes Added subsection of the field.

Input Variables Type Description

value String Input string.

param String Optional - Input variable.
Output Variables Type Description

output String Output string.

wm.fin.mappingFunctions:call

Used primarily in conversion maps, this service will take the first available input, invoke the appropriate
services, and return an output string.

Input Variables Type Description

value Document Input fields providing mapping information.
Output Variables Type Description

output String Results of input.
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wm.fin.mappingFunctions:dateAndPlaceMapT015022
Converts date format from YYMMDD to YYYYMMDD and maps place value.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string.

TRADDET.94B:: String Mapped place value (migration service will map to correct IS
TRAD Document format).

wm.fin.mappingFunctions:dateMapTo15022
Converts date format from YYMMDD to YYYYMMDD.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is the converted date.

wm.fin.mappingFunctions:dateMapTo7775
Converts date format from YYYYMMDD to YYMMDD.

Input Variables Type Description

value String Input string.

Output Variables Type Description

output String Output string. This is the converted date.
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wm.fin.mappingFunctions:replaceMT

Replace the three-character string describing message type with a new message type. Input string is
assumed to be the Application Header (Block 2) raw string, without ‘{2:" at the start.

Input Variables Type Description
value String Input string.
param String Input variable.
Output Variables Type Description
output String Output string.

wm.fin.mappingFunctions:strip

Strips specified leading characters from string.

Input Variables Type Description
value String Input string.
param String Input variable. This is the number of characters to strip from the

beginning of the input string.

Output Variables Type Description

output String Output string. This is the stripped input string.

wm.fin.mappingFunctions:truncate

Truncates string to specified size.

Input Variables Type Description
value String Input string.
param String Input variable. This is the number of characters to truncate the

input string to.

Output Variables Type Description

output String Output string. This is the truncated input string.
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wm.fin.migration

The services in this folder are used in the migration of SWIFT FIN messages from ISO 7775 to ISO 15022
and ISO 15022 to ISO 7775.

wm.fin.migration:maplDataToMap

This service is for internal use only.

wm.fin.migration:templateToMap

Creates a webMethods Flow map from a template that can be used in the migration of ISO 7775 messages
to ISO 15022 and ISO 15022 to ISO 7775.

Note: IS Documents for the input/output MUST be created first.

Input Variables Type Description

templateFileName String Path of migration template. For example,
packages/WmFINDev/ import/templateName.

package String IS package in which to generate the migration map. For
example, Default.

mapServiceName String Fully qualified IS service name of the migration map. For
example, wm_fin.migration.maps: map520T0540.

inputMsgType String SWIFT message type of the input SWIFT message. For example,
502.

inputVersion String FIN version of the input SWIFT message. For example, may05.

inputFormat String The format of the generated blocks and fields for the input

SWIFT message. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by the
business name specified in the message DFD.

B TAGONLY. SWIFT Message tag only.
B BIZNAMEONLY. Business name specified in the message DFD.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.

outputMsgType String SWIFT message type of the output SWIFT message. For
example, 502.
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Input Variables Type Description

outputVersion String SWIFT version of the output SWIFT message. For example,
may05.

outputFormat String For the output SWIFT message. The format of the generated

blocks and fields. Valid values:

B TAG_BIZNAME (default). SWIFT Message tag followed by the
business name specified in the message DFD.

B TAGONLY. SWIFT Message tag only.
B BIZNAMEONLY. Business name specified in the message DFD.

B XMLTAG. XML-compatible tag name. This format cannot
contain colons or tags that begin with a number. For
example, F23G.

wm.fin.migration:templateToMaplData

This service is for internal use only.
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Overview

Important! XML parsing templates are used only when receiving messages in Integration
Server.

webMethods provides XML parsing template files to define the structure of SWIFT FIN
messages. Each parsing template describes the message using an XML syntax, and each
parsing template defines a unique SWIFT message. The webMethods SWIFT FIN Module
uses the parsing template when it receives a message of that type.

To fully define the entire set of SWIFT FIN messages, a parsing template is required for
each type of SWIFT message. The parsing templates are installed in the appropriate
category and version folder. The webMethods SWIFT FIN Module reads a parsing
template as needed at run time.

The name of each parsing template is based on the definition of the message type it
contains. Each message type has a unique ID, which is usually a three-digit number.
Typically, the name of a parsing template follows a convention that indicates the MT
defined in the parsing template. The following table shows the format used for the names
of parsing templates:

Format of Parsing Template Name Used for...

swiftmtF21_xml Incoming ACK/NACK messages returned by the
SWIFT system. Any service message will follow this
file name format.

swiftmtnnn_xml All other incoming messages types and all outgoing
message. The webMethods SWIFT FIN Module looks
for a specific parsing template file for the specific
type of message. For example, swiftmt101.xml.

where nnn is the unique id for
the message type.

The parsing templates that webMethods provides are a mixture of messages that conform
to the older SWIFT message standard (ISO 1775) and the new standard (ISO 15022). The
webMethods SWIFT FIN Module can support both standards because of the flexible
parsing template syntax. As a result, when SWIFT issues an update of their message
standards, you can define new parsing templates for new SWIFT message formats or
update existing parsing templates for updated SWIFT message formats.

The wm.fin.trp:receive service converts messages that are received from SWIFT into
Integration Server document structures. Likewise, the wm.fin.trp:send service converts
Integration Server documents into SWIFT FIN messages, so that the messages can be sent
to SWIFT.
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SWIFT Message Data

The following message is a sample of MT 101. Users unfamiliar with the SWIFT format
should take time to study this data. Alternate blocks and repeating sequences within
block 4 have been highlighted for clarity.

{1:FO1PASOBEBOAXXX0071007172}{2:01011509010306LRLRXXXX4A00000009622301
03061609N}

{3:{108:MT101 005 OF 007}}{4:

:20:00054

:50H:/12345-67891

WALT DISNEY COMPANY

:30:000228

:21:DP951101TRSGB

:32B:USD132546,93

:50L:WALT DISNEY PRODUCTION HOLLYWOOD CA
:57A:TESTGBVT

:59:/0010499

TRISTAN RECORDING STUDIOS

35 SURREY ROAD

BROMLEY, KENT

:71A-0UR

:21:WDC951101RPCUS

:32B:USD377250,

:50L:WALT DISNEY COMPANY LOS ANGELES, CA
:57A-TESTUSVT

:59:/26351-38947

RIVERS PAPER COMPANY

37498 STONE ROAD

SAM RAMON, CA

:71A:0UR
-H5:{MAC:711DDD87}{CHK:A66AB15C6E3F}{TNG: }}{S:{SAC:}{COP:P}}

Sample SWIFT Message Definition

The following tables give the definition of block 4 in SWIFT message 101. Blocks 1, 2, 3

and 5 are not shown because they have a fixed definition for all message types.

Block 4, Mandatory Sequence A

Field Name Mandatory
21R No
50L No
50H No
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Field Name Mandatory
52A or No

52C

51A No

30 Yes

25 No

Block 4, Mandatory Repetitive Sequence B

Field Name Mandatory Notes
21 Yes
21F No
23E Yes Field can repeat multiple times.
32B Yes
50L No
50H No
52A No
or

52C

56A Yes
or

56C

or

56D

57A No
or

57C

or

57D

59 Yes
70 No
77B No
33B No
71A Yes
25A No
36 No
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Parsing Template Structure

All SWIFT FIN messages are essentially a sequence of fields that are contained within
blocks. The message syntax allows for the fact that blocks and fields can be optional, and
that blocks can be nested to any level, can repeat, or embed submessages. Every SWIFT
message consists of one to five blocks as shown in the following table.

Block ID  Block Name Mandatory Description

1 Basic Yes Contains fixed length, untagged fields.
Header

2 Application  No Contains fixed length, untagged fields.
Header

3 User No Contains tagged, delimited fields that are
Header mapped to individual fields.

4 Text No Contains tagged, delimited fields that are
mapped to individual fields within a sub
structure. This block can contain nested blocks
of fields that are mapped into further sub-
structures. It also can contain repeating
sequences of fields, which are mapped to a
sequence of structures.

5 Trailers No Contains delimited, tagged fields that are

mapped to individual fields within a sub
structure.

Each of these five basic blocks is enclosed in braces {....} and is identified by a single digit.
Although defined as an optional block, in practice block 4 is always present because it

contains the actual message text.

Despite these complexities, the parsing templates use just two main elements:
block and lineAttribute.
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Sample Parsing Template

A sample parsing template is illustrated below:

Sample Parsing Template

<?xml version="1.0"?>
<block i1d="101" isMandatory=""true" isList="false'>

<lineAttribute id="1:" isMandatory="true" extractHint="BR,{,},T,S"
idHint="FL,0,2" B2BMap=""' EAlmap="B1" />
<lineAttribute i1d="2:" isMandatory="false" extractHint="BR,{,},T,S"
idHint="FL,0,2" B2BMap=""" EAlmap="B2" />
<block id="3:" isMandatory=""true" isList="false” termString=""
extractHint="BR,{,},T,S" idHint="FL,0,2" EAlmap="B3">
<lineAttribute id="103:" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,4" B2BMap=""" EAlmap="0103" />
<lineAttribute id="113:" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,4" B2BMap=""" EAlmap="0113" />
<lineAttribute i1d="108:" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,4" B2BMap=""" EAImap="'0108" />
<lineAttribute id="119:" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,4" B2BMap=""" EAlmap="0119" />
<lineAttribute id="115:" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,4" B2BMap=""" EAImap='"0115" />
</block>

<block id="4:\r\n" isMandatory="false" isList="false"
termString="\r\n" extractHint="BR,{,-},T,S" idHint="FL,0,4" EAImap="B4">
<lineAttribute id=":20:" isMandatory="true"
extractHint="DL,:,T,S" iIdHint="FL,0,4" B2BMap=""" EAlmap="M20" />
<lineAttribute id=":21R:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""021R" />
<lineAttribute id=":50L:" isMandatory=""false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAImap=""050L" />
<lineAttribute id=":50H:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""050H" />
<lineAttribute id=":52A:,:52C:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="052A,052C" />
<lineAttribute id=":51A:" isMandatory=""false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""051A" />
<lineAttribute id=":30:" isMandatory="true"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap=""" EAlmap="M30" />
<lineAttribute id=":25:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap=""" EAlmap="025" />
<block 1d="B4B" isMandatory="true" isList="true" termString="\r\n"
EAImap=""B4B"'>
<lineAttribute id=":21:" isMandatory="true"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap=""" EAlmap="M21" />
<lineAttribute id=":21F:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="021F" />
<block i1d="B423E" isMandatory="false" isList="true"
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termString="\r\n" EAlmap="B423E">
<lineAttribute i1d=":23E:" isMandatory=""true"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""023E" />
</block>
<lineAttribute i1d=":32B:" isMandatory=""true"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""M32B" />
<lineAttribute id=":50L:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="050L" />
<lineAttribute id=":50H:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="050H" />
<lineAttribute id=":52A:,:52C:" isMandatory="false"
extractHint="DL,:,T,S"™ idHint="FL,0,5" B2BMap=""" EAlmap=""052A,052C" />
<lineAttribute id=":56A:,:56C:,:56D:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""056A,056C,056D"
/>
<lineAttribute id=":57A:,:57C:,:57D:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""057A,057C,057D"
/>
<lineAttribute id=":59:" isMandatory="true"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap=""" EAlmap="M59" />
<lineAttribute i1d=":70:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap=""" EAlmap="070" />
<lineAttribute id=":77B:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="077B" />
<lineAttribute id=":33B:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap="033B" />
<lineAttribute id=":71A:" isMandatory=""true"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlmap=""M71A" />
<lineAttribute id=":25A:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,5" B2BMap=""" EAlImap=""025A" />
<lineAttribute i1d=":36:" isMandatory="false"
extractHint="DL,:,T,S" idHint="FL,0,4" B2BMap="""' EAlmap="'036" />
</block>
</block>
<block 1d="5:" isMandatory=""false" isList="false"™ termString="\r\n"
extractHint="BR,{,},T,S" idHint="FL,0,2" EAlmap="B5">
<lineAttribute id="MAC" isMandatory=""true"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap=""MMAC" />
<lineAttribute id="CHK" isMandatory=""true"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap=""MCHK" />
<lineAttribute id="TNG" isMandatory="false"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAImap="OTNG" />
<lineAttribute id="PDE" isMandatory="false"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap=""OPDE" />
<lineAttribute id="SYS" isMandatory=""false"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap="0SYS" />
<lineAttribute id="PDM" isMandatory="false"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap="OPDM" />
<lineAttribute id="DLM" isMandatory="false"
extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap=""0ODLM" />
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<lineAttribute id="PAC"

isMandatory=""false"

extractHint="BR,{,},T,S" idHint="FL,0,3" B2BMap=""" EAlmap=""OPAC" />

<lineAttribute id="MRF"

isMandatory=""false"

extractHint="BR,{,},T,S" idHint="FL,0,3"™ B2BMap=""" EAlmap="OMRF" />

</block>

</block>

Block Syntax of a Parsing Template

The block elements in the SWIFT parsing template define the blocks in the SWIFT
message. The syntax of a block directive is shown below. (Note that optional parameters
are shown in square braces [ ].)

<block id="id" isMandatory=""true|]false" isList="true|false"
[termString="string"] [ EAlmap="string'] [[extractHint="hint"
idHint=""hint"] [ loadBlockHint="hint"™ blockPointer="pointer']]>

For the first (outer most) block directive, only the mandatory parameters are supplied.
The first block directive identifies the entire message, which translates to the top level
Enterprise document type. The syntax of the first block directive always takes the

following syntax:

<block id="nnn" isMandatory=""true" isList="false">

where nnn is the SWIFT message type number. This number must match the number in
the parsing template file name, for example, for MT 101, the value of nnn must be 101 in
the file swiftmt101.xml.

For all subsequent blocks, the block directive requires optional parameters. The full set of
parameters are described below.

return)

\n (line feed)

Elements Values Description

id block id The block number in the SWIFT message, including delimiting
characters. For the first block directive this contains the message
type id.

isMandatory true | false false indicates that the block is optional and does not need to be
present for the message to be considered valid.
true indicates that the block must be present in an incoming
message or the message will fail validation.

isList true | false false indicates that only one instance of the block can occur.
true indicates that the block can repeat one or more times.

termString \r (carriage Characters that occur at the end of the block. Some blocks are

terminated with a carriage return + line feed, while other blocks.
For example blocks 1, 2 and 3, are not terminated with a carriage
return + line feed and the value of termString should be an empty
string (termString="").
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Elements

Values

Description

EAImap

document
structure name

Represents the name of the structure in the document that the
SWIFT message block is mapped to or from. By convention, the
EAImap value for blocks is prefixed with ‘B’.

extractHint

Parameter list

he first member of which must be BR, block is enclosed in braces.
The syntactical clue used to identify the beginning and end of
blocks.

B For an incoming message, extractHint is used to strip block
markers from the raw data.

B  For an outgoing message, extractHint specifies the padding
characters to be applied to form a syntactically correct message
block.

Note: The “braces’ used to enclose blocks can comprise any
characters, such as

{...... blockdata......-}
or
:16R:TRADE...... blockdata......:16S:TRADE

For a full explanation of this element, see “Hint Processing” on
page 172.

IdHINnt

Parameter list

The first member of which must be FL, tag is fixed length or EH, tag
is derived from the extractHint.

Syntactical clue used to extract the tag that identifies the block
extracted using the extractHint.

B  FLis used in most cases, and is used to strip the first few
characters from the remaining raw data.

B EHis used to extract the first few characters from the block
marker stripped by the extract hint. This is used where the
block delimiters are themselves a string, such as, 16R:TRADE.

For the webMethods SWIFT FIN Module to identify the block
correctly, the text returned by idHint must match the value in the
block id element.

For a full explanation of this element, see “Hint Processing” on
page 172.
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Elements Values Description
loadBlockHint | Parameter list The first member of which must be FL, tag is fixed length. Used for
embedded messages, such as in n92, n95 and n96. These messages
embed block 4 of a message that was previously processed. The
embedded message can be any of the SWIFT message types.
loadBlockHint is used to determine the sub-template that must be
embedded in the current parsing template whenever an embedded
message is received. It extracts the message type number (100, 101,
521 etc.) from the data returned by a preceding lineAttribute.
For a full explanation of this element, see “Hint Processing” on
page 172.
Note: loadBlockHint must be used in conjunction with
blockPointer. If these elements are specified, extractHint and
idHint are omitted.
blockPointer 4:\r\n Used in conjunction with loadBlockHint.
Specifies that block 4 is to be included from the embedded parsing
template.
Line Attribute Syntax of a Parsing Template
The lineAttribute elements typically define a single field in the message, although it
also is used in the generic parsing template to include an entire block of fields. The syntax
of the lineAttribute directive is shown below.
Note that optional parameters are shown in square braces [ ].
<block id="id" isMandatory="true|false"
EAlImap="'string” extractHint="hint" idHint="hint"
[ blockLoadField=""true"]>
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document field name

Elements Values Description
id field id The field tag in the SWIFT message, including delimiting
characters. Mutually exclusive fields are depicted as a
of comma separated list (see fields 52, 56 and 57 in the
field id list example parsing template above).
isMandatory true / false false indicates the lineAttribute is optional and need not be
present for the message to be considered valid.
true indicates the field represented by the lineAttribute
must be present in an incoming message, or the message
will fail validation. For an outgoing message, the
corresponding field in the Enterprise document (specified
by the EAImap element) must be populated, or the message
will fail validation.
EAlImap document field name | The name of the field in the Enterprise document that the
or lineAttribute is mapped to or from. By convention, the

EAImap value for lineAttributes are prefixed with ‘O’
for optional fields or ‘M’ for mandatory fields. Mutually

list exclusive fields are depicted as a comma separated list that
must match up with the field ID list.
extractHint Parameter list The first member of which must be BR, field is enclosed by

braces, DL, field is delimited, or CK, field will contain the
entire block data in a single chunk.

Note: CK is used for the generic parsing template only.

Syntactical clue used to identify the beginning and end of
fields. For an incoming message, extractHint is used to
identify the end of the field data and to strip any braces
from the raw data. For a full explanation of this element, see
“Hint Processing” on page 172.
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Elements

Values

Description

idHint

Parameter list

The first member of which must be FL, ID is fixed length, or
CK, ID will not be extracted as the field contains the entire
block in a single chunk.

Syntactical clue used to identify and strip the ID of the field
extracted using the extractHint. The idHint is applied to
the raw data line and typically uses a fixed length
parameter to return the first few characters of the data.

For the webMethods SWIFT FIN Module to identify the
field correctly, the text returned by idHint using FL must
match the value in the lineAttribute ID element. For a
full explanation of this element, see “Hint Processing” on
page 172.

blockLoadField

true (if specified)

Optional element that causes the lineAttribute to be
referenced by a subsequent loadBlockHint directive.

blockLoadField must precede loadBlockHint in the
parsing template.

Hint Processing

ExtractHint, idHint, and loadBlockHint are used in block and lineAttribute
directives. The full syntax is provided in the following sections.

Braced fields

Used where the data is enclosed in one or more bracing characters BR, <open brace
characters>, <close brace characters>, <tag flag>, <tag position>.

Delimited fields

Used where fields are delimited by a single character DL, <delimiting character>, <tag

flag>, <tag position>

Chunk data

Used where data is treated as a single chunk, without further parsing CK, <tag flag>, <tag
position> or extractHint CK[, <from position>, <to position>] for idHint.

Fixed length

Used where data occupies a fixed number of characters FL, <from position>, <to position>.
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Extract hint

Used to extract a fixed number of characters from the extract hint EH, <from position>, <to

position>.

The remaining parameters are given in the following table:

Parameter

Values

Description

open brace
character

any sequence of
characters

The character(s) used to identify the
beginning of the block or field

close brace
character

any sequence of
characters

The character(s) used to identify the end
of the block or field

delimiting

any character

A single character that separates fields

character
from numeric character | Starting character position used to extract
position fixed length data from the raw data after

the block characters have been stripped
off. First character is position 0.

to position

numeric character

Last character position plus one used to
extract fixed length data.

tag flag TorN T (tagged) — the field tag is included with
the data.
N (not tagged) — data does not include the
tag field

tag position | SorE S (start) — data tag precedes the data.

E (end) — data tag follows the data.

Miscellaneous Notes

The following notes should be read and understood before attempting to maintain the

webMethods SWIFT FIN Module parsing templates.

B While SWIFT defines block 1 as the only mandatory block, in general the parsing

templates define blocks 1 through 4 as mandatory.

B Individual optional repeating fields must be defined as a mandatory field within an

optional block.

B  When loadBlockHint / blockPointer is used, isMandatory must be true and
isList must be false.

B [f extractHint uses chunk parameter (CK), idHint must also be CK.
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B  loadBlockField and associated loadBlockHint /blockPointer can only occur once
in the parsing template.

B Block 3 must include field 108. This is required to correctly process ACK/NACK
messages received from the SWIFT network.
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Overview

This document provides a real-world example of sending SWIFT FIN messages using the
webMethods SWIFT FIN Module. In this example, two financial institutions (trading
partners) join in a SWIFT business process (also called a conversation) that adheres to the
SWIFT standard. You will use various webMethods interfaces to simulate this business
process. This document assumes that you are familiar with the webMethods Integration
Server, the Server Administrator, webMethods Developer, webMethods Trading
Networks, the Trading Networks Console, webMethods Modeler, and webMethods
Monitor.

Who Are the Trading Partners?

The sender is EuroClear. EuroClear performs the role of the initiating party in this sample.
The receiver is UBS Warburg. UBS Warburg performs the role of the executing party in this
sample.

What Will Be Accomplished?

EuroClear, as the initiating party, will implement the SWIFT FIN messages MT 564, 568,
and 566, with UBS Warburg, the executing party. The process is as follows:

B EuroClear sends an MT 564, Corporate Action Notification, to UBS Warburg. This is used to
provide an account owner with the details of a corporate action event along with the
possible elections or choices available to the account owner.

M UBS Warburg sends an MT 565, Corporate Action Instruction, to EuroClear. This message is
used to provide the custodian with instructions on how the account owner wishes to
proceed with a corporate action event. Instructions include investment decisions
regarding the exercise of rights issues, the election of stock or cash when the option is
available, and decisions on the conversion or tendering of securities.

B EuroClear sends an MT 568, Corporate Action Narrative, to UBS Warburg. This message is used
to provide complex instructions or narrative details relating to a corporate action
event.

M EuroClear sends an MT 566, Corporate Action Confirmation, to UBS Warburg. This message is
used to confirm to the account owner that securities and/or cash have been
credited/debited to an account as the result of a corporate action event.
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Process Overview

EuroClear UBS Warburg
Back-end System Back-end System

Outhound Map Service

DQ*Q P

MT 564 564 564 MT 564

Outbound Map Service L IQ

2<oa

MT568

Process Model MT 566

Process Run Time

webMethods Trading Networks

Integration Server

Before You Begin

In this sample scenario, you will use the IS document types and services in the various
folders of the packages that make up the webMethods SWIFT FIN Module. This guide

assumes that you are familiar with the Integration Server, Trading Networks, Modeler,
and Monitor.

Make sure that you have:
B Installed the Integration Server, Trading Networks, Modeler, and Monitor.

For information about installing these webMethods components, see the webMethods
Integration Platform Installation Guide.

B Installed the webMethods SWIFT FIN Module and the nov03 Category 5 messages.

For information about installing the webMethods SWIFT FIN Module, see Chapter 2,
“Installing the webMethods SWIFT FIN Module” on page 27.
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Note: You can run the entire sample on one computer running a single installation of the
webMethods6\ IntegrationServer with Trading Networks, Modeler, Monitor, and the
SWIFT FIN Module. While you can set up two separate machines to simulate an over-the-
network connection to a trading partner, you do not need to do so to run the sample. This
guide directs you to run the entire sample on a single machine.

How Do | Run the Sample?

& Important! These steps assume that you already have created database tables for you BIC
information and imported you BIC or BIC+ list. For more information, see Chapter 6,
“Working with BIC and BIC+ Lists” on page 65.

To run the sample, you will need to perform the following steps after installation:
Step 1: Set Up Partner Profiles

Step 2: Import TN Document Types and TPAs

Step 3: Run ImportFINItems for Each TN Document Type

Step 4: Import the Sample BIC List Database

Step 5: Import, Generate, and Enable the Process Models

Step 6: Run the Business Process

Step 7: View the Business Process

Note: For more information about installation requirements to run the webMethods
SWIFT FIN Module sample, see the previous section, “Before You Begin” on page 177.

Step 1: Set Up Partner Profiles

Perform the following procedures to set up the trading partner profiles that the sample
uses. You define in Trading Networks Console the profiles for EuroClear (Enterprise) and
UBS Warburg.

In the sample, set up the Enterprise profile for EuroClear (the initiating party in this
sample) and a partner profile for UBS Warburg (the executing party in this sample).
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Create the Enterprise Profile for EuroClear

Perform the following steps to set up EuroClear as the Enterprise profile in the Trading
Networks Console.

P 7o create the Enterprise profile for EuroClear

1

Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

In the Trading Networks Console, select Tools » Profile Assistant. The Trading
Networks Console displays the first page of the Profile Assistant.

Select Create my profile, if it is not already selected, and then click Next. The Trading
Networks Console displays the next page of the Profile Assistant, which you use to
supply the name of the corporation.

Note that the Trading Networks Console highlights required fields in blue and also
marks the required fields with an asterisk.

Type EuroClear in the Corporation Name field. You also can enter information for the
Unit Name and import an image file for the corporate logo, but you are only required to
fill in the Corporation Name.

Click Next twice. The Trading Networks Console displays the next page of the Profile
Assistant, which you use to supply the corporation’s external ID, which is the BIC for
EuroClear.

Click Add New External ID E , select BIC from the External ID Type column, and type
MGTCBEBEECL in the Value column.

Note: To run the sample using your own profile, enter your enterprise BIC in this field.

Click Next until you reach the last page of the Profile Assistant.
Click Finish.
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Verifying and Enabling the EuroClear Profile

To verify that the Enterprise profile for EuroClear is configured correctly for the sample,
view the profile. You also must enable the profile. Perform the following to verify and
enable the profile.

B 1o verify and enable the profile for EuroClear is configured correctly

1

In the Trading Networks Console, in the Selector panel, select the Enterprise radio
button, if it is not already selected.

Select View » Profile.

Click through the tabs of the profile to verify that the profile for EuroClear is
configured as shown in the following figure, or using your Enterprise information.

Enterprise Profile

Corporation Mame: IEurnCIear

Linit Marme: I

@l Extermal I Type Yalue El

Partner Type: I,:.D webhethods Trading Metworks b | El

4

To enable the profile, click Enable Q to activate the EuroClear profile.

Create a Partner Profile for UBS Warburg

Perform the following steps to set up the partner profile for UBS Warburg in the Trading
Networks Console.

B 1o create a partner profile for UBS Warburg

1

In the Trading Networks Console, select Tools » Profile Assistant. The Trading
Networks Console displays the first page of the Profile Assistant.

Select Create partner profile and click Next. The Trading Networks Console displays the
next page of the Profile Assistant.

Note that Trading Networks Console highlights required fields in blue and also
marks the required fields with an asterisk.

Type UBS Warburg in the Corporation Name field. You also can enter information for
the Unit Name and import an image file for the corporate logo, but you are only
required to fill in the Corporation Name.

Click Next twice. The Trading Networks Console displays the next page of the Profile
Assistant, which you use to supply the corporation’s external ID, which is the BIC for
UBS Warburg.
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5  Click Add New External ID E , select BIC from the External ID Type column, and type
UBSWUS3NXXX in the Value column.

Note: To run the sample using your another partner, enter your partner’s BIC in this
field.

6  Click Next until you reach the last page of the Profile Assistant.
7 Click Finish.

Verifying and Enabling the UBS Warburg Profile

To verify that the Partner profile for UBS Warburg is configured correctly for the sample,
view the profile. You also must enable the profile. Perform the following to verify and
enable the profile.

I 7o verify and enable the profile for UBS Warburg is configured correctly

1 Inthe Trading Networks Console, in the Selector panel, select the Partner radio button,
if it is not already selected.

2  Select View » Profile.

3 Click through the tabs of the profile to verify that the profile for UBS Warburg is
configured as shown in the following figure, or using your Enterprise information.

Enterprise Profile

Corporation Matme: IUEIS Warkury ﬁl External ID Type Walle El
Urit Marme: I lﬁ |
Partner Type: @ webMethods Trading MNetvworks v | %l

4 To enable the profile, click Enable Q to activate the UBS Warburg profile.

Note: The default External ID Type is DUNS. You must set the External ID Type to BIC.
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Step 2: Import TN Document Types and TPASs

You must import the TN document types and TPAs for the messages that the sample will
be processing.

Import the TN Document Types

I o import the TN Document Types
1 Inthe Trading Networks Console, click File » Import.

Import Data E

Select File: [:||

Available ftems: Selected tems:

3| ¢
LKL

O | Cancel I

2 To select the TN document type file, click 8.

3 Navigate to the webMethods6\IntegrationServer\packages\WmFINSamples\data
directory and select one the following files:

B If you are running Trading Networks 6.0.1, select
CorporateActionDocTypes_601.xml

B If you are running Trading Networks 6.1, select CorporateActionDocTypes.dat

After selecting the appropriate file, click Open. The TN document types are listed on
the Import Data screen.
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4 Click w to select all of the TN document types and then click OK. The TN document
types are imported.

Import the TPASs

P o import the TPAs

1 Inthe Trading Networks Console, click File » Import.

Import Data m

Select File: [:||
show: [T - |

Availzhle kems: Selected kems:

| ¢
9]«

OK | Cancel I

2 To select the TPA file, click 3.

3 Navigate to webMethodsé\IntegrationServer\packages\WmFINSamples\data
directory and select one of the following files:

B If you are running Trading Networks 6.0.1, select CorporateActionTPA_601.xml
B If you are running Trading Networks 6.1, select CorporateActionTPA_dat
After selecting the appropriate file, click Open. The TPAs are listed on the Import Data

screen.

4 Click w to select all of the TPAs and then click OK. The TPAs are imported.
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Step 3: Run ImportFINItems for Each TN Document Type

Important! This step assumes that you copied the may05 Category 5 DFDs when installing
the webMethods SWIFT FIN Module.

You must run the wm.fin.devimportFINItems service for the following message DFDs:

MT 564
MT 565
MT 566
MT 568

To run the wm.fin.dev:importFINItems service

1

In the Developer, navigate to the wm.fin.dev:importFINitems service, and then click B,
The Input dialog box appears.

Input dialog box
EI Input for ‘importFINItems" * |

msgType |

version |
format |[TAG_BIZNAME |

subfieldFlag Ifalse 'I
createlocType Itrue *I

createProcessingRiue Itrue 'I

createTPA Itrue 'I

[T Include emptywalues for String Tvpes

(6] Cancel | Load | Save Help
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2 Complete the following fields, and then click OK:

In this field... Specify...
msgType 564

version may05

format TAG_BIZNAME
subfieldFlag false
createDocType false
createProcessing false

Rule

createTPA false

Note: The createDocType, createProcessingRule, and createTPA fields should be set to false
because you already have imported the elements that you need.

3 Repeat the previous step for MT 565, 566, and 568.

4 Reload the WmFINMessages package to view the service outputs in Developer.

Note: Refresh Developer to see the WmFINMessages package.

The output is stored in the WmFINMessages package in the
webMethods6 \ IntegrationServer \ packages\ WmFINMessages \ may05).

Step 4: Import the Sample BIC List Database

I Toimport the BIC List database
1 Inthe Server Administrator Navigation panel, under Adapters, click SWIFT.

2 On the SWIFT home page, click Import BIC List. The SWIFT Import BIC List screen
appears.
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SWIFT Import BIC List screen

Import BIC List

Mote: Everytime BIC import process is initiated the previous BIC list from the database is
deleted and a new list is inserted.

BIC Type: IE-IC vI
FiIeName:I Browse... |

Ci/ffoldersbic.dat
Example Paths ffserverfolders/bic.dat
folder/bic.dat (relative to install directory)

Import BIC List

3 In the BIC Type list, select BIC.

4 Navigate to the webMethods6 \ IntegrationServer \ packages\ WmFINSamples\ data
directory, and extract the files for the BIC List database (bicplus.zip). Select bicplus.txt
file from the list.

5  Click Import BIC List.

Step 5: Import, Generate, and Enable the Process Models

You will use the sample process models in webMethods Modeler to define (execute steps
for) the sample business processes.

When you import, generate, and enable these process models, you are setting up the
process that EuroClear, as the initiating party (Account Owner), would run on their
installation, and that UBS Warburg, as the executing party (Account Servicer) would run
on their installation. In a real life situation, each company would set up only the process
model that would run on their installation. Because you are simulating the entire business
process on one installation, you must set up both process models.

Import the Process Models

Before you can use the sample process models, you must import the following process
models into webMethods Modeler:

B CorpActions_AccountOwner.model
B CorpActions_AccountServicer.model

For more details about importing process models, see the webMethods Modeler User’s
Guide.
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Importing the Account Owner Process Model

Perform the following steps in Modeler to import the sample EuroClear Account Owner
process model.

To import the EuroClear Account Owner process model

1  Start the Integration Server, Server Administrator, and Modeler, if they are not
already running.

2 In Modeler, select File » Import.

3 Locate the sample process model named CorpActions_AccountOwner.model in:

webMethods6\IntegrationServer\packages\WmFINSample\data\ProcessModels

where webMethods6\IntegrationServer is the directory in which the Integration
Server is installed.

4 Click Open to import the process model.

5 When the message “Imported items: Business Process: CorpActions_AccountOwner”
appears, click OK.

6 The process model appears in Modeler.

Account Owner Process Model

a CorpActions_AccountOwner

& & [y 20 |Rnsert... <SMewstep 88 new workflow tep  [Dl oraw Group |1 Addnote 1S add Text
lictount Servicer "t [Action Messages T
@ MT5ES (N oli!icationi v @ L & _@ ternal Corp: Action g
N m=————— By [t ¢ ¥ F A d ek bt
» 2 B’ . Instructi i
Recers Corporats | WWait Tor MTOG4 “Waliclate Corporats Process Offer Wait for Internal . Send Intermal
Action Motification Action Motification Motification Imstruction Corporate Action
MT564 fram Instruction
Mccount Sarvicar
@ 4. M1900 Unstruction) %‘ Uk Lofparate Action Instiiction (@
Send Corporate ; Send Corporate Outhound Map
Action Instruction Action Instruction (DD SG3)
MTSES to Accourt MT565
Servicer : l
i : ) -
E& BTG (Namative) . g > » g
Racaive Caorporste Wit For Corporste Walidate Corporste Procese Action Process Level
Action Narrative Action Marrative Action Marrative Status Error
MT5E8 from (MTSE8)
Arrnunt Servicer
; @
f o] 2 3 .8
f MTHEE (Confirmation) 4 c@ &
., » - » 4
@ O~ “
Receive Corporste Wiai for Corporste “alidate Corporste Procese Action Encd
Action Action Action Confirmation
Confirmation Confirmation Confimation
MATEEE froor
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Importing the Account Servicer Process Model

Perform the following steps in Modeler to import the sample UBS Warburg Account
Servicer process model.

- To import the UBS Warburg Account Servicer process model
1 In Modeler, select File » Import.
2 Locate the sample process model named CorpActions_AccountServicer.model in:
webMethods6\IntegrationServer\packages\WmFINSample\data\ProcessModels

where webMethods6\IntegrationServer is the directory in which the Integration
Server is installed.

3 Click Open to import the process model.

4 When the message “Imported items: Business Process: CorpActions_AccountServicer.”
appears, click OK.

5 The process model appears in Modeler.

Account Servicer Process Model

2% LN B JdETOH

Backend System Action Messages

Account Owner

@ntemal Corpsrhte Astion @ L % DFD Corporate Action Notification | @ MTS64 (Notification) " @
S 1 » L4 Lo i »
B

Send Backend ‘Wit for Internal Outhound Map Send Motification of Send Corpaorate
Corporate Action Corporate Action (DFDSE4) Offer (MTS64) Action Motification
Motification Motification MTSE4 to Account
l Owvnier
.y
@Imfr_n_a_l Corgofate Action @ i % i o @ - MTSES (Instruction) | ¢+ @
R > o
Act on Corporate Send to Backend Map to Backend “alidate Corporate  Wait for Corporate Receive Corporate
Action Instruction Data Format Action Instruction  Action Instruction Action Instruction
J' (MT5E5) MTS65
Internal Corpdrat Actiolh i DFD Corporate Action Narrative M TSES (Marrative)
Nartai T iy Lg i
v
Send Backend ‘Wit for Internal Outhound Map Send Corporate Send Corporate
Corporate Action Corporate Action [DFDSES) Action Marrstiv Action Marrative
Marrative Marrative (MTSES) MTSES to Account
l | Owvnier
6 1
Internal Cofpprate Action DFD Corporate Action MTSES (Confirmation)
ey ] > Alca i B e i B »
Confirmation B’ Confirmation
Send Backend Wit for Confirm Cuthound Map Send Confirm Send MTSE6
Confirm Account Account Activity [DFDSEE) Account Activit Confirmation of
Activity [MTSEE) Account Activity
F.—_ ¥
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Generate the Process Models

After importing the process models into Modeler, use Modeler to generate the process
models to create the run-time elements in the underlying webMethods platform. When
you generate the process models, Modeler generates the run-time elements (that is,
services, triggers, and process run-time fragments) that actually execute at run-time.
Modeler displays messages in the Implementation Generation Messages dialog as it creates the
run-time elements.

For more details about generating process models, see the webMethods Modeler User’s
Guide.
Generating the Account Owner Process Model

Perform the following steps in Modeler to generate the Account Owner process model.

I 7o generate the Account Owner process model
1 In Modeler, select the Account Owner model.

2 Select Tools » Generate Business Process. Modeler begins to generate the run-time
elements. The Implementation Generation Messages dialog appears.

3 When the message “CorpActions_AccountOwner Model generated successfully” appears in
the dialog, click Close.

4 Update the model for monitoring by selecting Tools » Update Model for Monitoring. A
dialog appears confirming the process model is ready for monitoring.

5 Click OK.

Generating the Account Servicer Process Model

Perform the following steps in Modeler to generate the Account Servicer process model.

P 7o generate the Account Servicer process model
1 In Modeler, select the Account Servicer model.

2 Select Tools » Generate Business Process. Modeler begins to generate the run-time
elements. The Implementation Generation Messages dialog appears.

3 When the message “CorpActions_AccountServicer Model generated successfully” appears
in the dialog, click Close.

4 Update the model for monitoring by selecting Tools » Update Model for Monitoring. A
dialog appears confirming the process model is ready for monitoring.

5 Click OK.
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Enable the Process Models

After generating the process models and updating them for monitoring, the process
models are disabled. The Process Run Time will not use the process models until you
enable both of them. You enable the process models using Monitor.

For more details about enabling process models, see the generating process model chapter
in the webMethods Modeler User’s Guide and one of the following guides for webMethods
Modeler:

B [If you are using webMethods Modeler 6.0.1, see the chapter about monitoring
processes in the webMethods Monitor User’s Guide.

B If you are using webMethods Modeler 6.1, see the chapter about setting up process
logging in the webMethods Integration Platform Installation Logging and Monitoring
Guide.

Enabling the Account Owner Process Model

Perform the following steps in Monitor to enable the Account Owner process model.

To enable the Account Owner process model
1 Open Monitor, if it is not already running.
2 In the Monitor Navigation panel, under the Processes heading, click Process Models.

3 Locate the CorpActions_AccountOwner Model from the list of unused process models.
Monitor lists the process model under Unused Process Models because no instances of
this process model have been executed.

4 In the CorpActions_AccountOwner Model row, the Enabled column, click No.

5 When prompted to confirm your action, click OK, and refresh the page to see the
enabled status of the process model.

Enabling the Account Servicer Process Model

Perform the following steps in Monitor to enable the Account Servicer process model.

I 1o enable the Account Servicer process model

1 In the Monitor Navigation panel, under the Processes heading, click Process Models.

2 Locate the CorpActions_AccountServicer Model from the list of process models. Monitor
lists the process model under Unused Process Models because no instances of this
process model have been executed.
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3 In the CorpActions_AccountServicer Model row, the Enabled column, click No.

4 When prompted to confirm your action, click OK, and refresh the page to see the
enabled status of the process model.

Step 6: Run the Business Process

In webMethods SWIFT FIN Module, to start a business process on the initiating party’s
side, the initiating party’s back-end system calls wm.ip.cm:process Document. To start a
business process on the executing party’s side, a service on the initiating party’s side
sends a SWIFT message to wm.ip.fin:receive. After you start a service, you can monitor its
progress using Monitor. For more information about running a business process, see
Chapter 12, “Monitoring a Process” on page 109. For more information about monitoring
process progress using Monitor, see “Step 7: View the Business Process” on page 197.

Perform the following procedures to kick off the business process between EuroClear and
UBS Warburg.

B 7o run the sample SWIFT business process

1  Start the Integration Server, Server Administrator, and Trading Networks Console, if
they are not already running.

2 Inthe Server Administrator navigation panel, under the Adapters heading, click SWIFT.
The Integration Server displays the SWIFT Management page in a new browser
window.

3 In Navigation panel, under the SWIFT heading, click CA Account Servicer.
4 EuroClear sends an MT 564, Corporate Action Notification, to UBS Warburg.

Click Initiate New Corporate Action Notification. The Corporate Action sample screen
appears with the appropriate information already entered in the fields.

Note: If you used different BICs to define your profiles for this sample, you must enter
those BICs in the Sender’s BIC and Receiver’s BIC fields.
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Corporate Action Notification Sample
FIM > Corporate Action Sample

Corporate Action Notification MT564 -- Cash Dividend

Trading Parties

Sender's BIC: IMGTCE-EE-EECL Receiver's BIC: |u55wu53w><><><

General Information

Feference Mumber: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Euroclear Reference Number: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Mandatory/Optional Indicator: IMandatDr}f vI
Financial Instrument Details

Financial Financial
Instrurment IISIN USE7R5R97038 Instrurment IT.-’-'-.T.-’-'-. TEA LTD (REGS
ISIN Detail;
number: '
Der&uu"::';gﬁtceﬁ IUSD Options: Im
Eligible Account
Securities: |143E|D Information: IQDDDD
Met Gross
Entitlerment Entitlerment
(e o [0.1761 (UsO per jo.1911
sharel: sharel:
Payrnent
Record Date: IMa}r g, 2001 YDate: I.-i'-.ugLJSt 31, 2001

5 At the bottom of the page, click Send.

If the sample runs successfully, the Integration Server displays the following page.

Corporate Action Notification Confirmation Page

FIM > Corporate Action Account Servicer

» Sent Corporate Action Motification Qrder with reference number CADDDDDZ2345630
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6 To view the message details, click the reference number.

Message D.etails

Corproate Action Notification -- Cash Dividend

Trading Parties

Sender's BIC: MGTCRBEBEECL Receiver's BIC: UBSWLUSIMN®®®

General Information

Reference Mumber; CAODO00Z345630
Euroclear Reference Mumber: CAODO00Z345630
Mandatory/Optional Indicator: MAND

Financial Instrument Details

Financial Instrument ISIN ISIMN TATA TEA LTD (REGS

Financial Instrurnent Detail:

nurmber: US3765692035 GDS)
Denominated Currency: USD Options: CASH
Eligible Securities: 14300 Account Information: 90000
Met Entitlernent! USD per 01761 Gross Entitlernenti{ USD per 01911
share): share):
Record Date: May 5, 2001 Payrent Date: August 31, 2001

additional Information:

Corporate Action Motification SWIFT message

7 To view the actual SWIFT message, click the Corporate Action Notification SWIFT message
link at the bottom of the page.

SWIFT MT 564 Message

564 SWIFT Message

Date: Sat Jun 28 20:23:29 EDT 2003

[1:FOIMGTCREEREXECLOOO0000000} [ 2 - TH64UBSWUSINIOOONN 20203 (3 [108: 20000000nc20edoul } [4:
:16E: GENL

:20C: :CORPf FCROO0002345630
c20C: : SEMEf FCRAO00002345630
: 236G : NETIM

:22F: :CREV//DVYCh

: 22F : :CRMYf FMAND

c98C: - PREP/F20010901093444
: 25D: : PROC f fCOMP

16K :LINK

c20C: :PREY/ /000002345630
165 :LINK

1165 : GENL

:16ER: USECY

“35B-T5TNH USET65692038
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8 In Navigation panel, under the SWIFT heading, click CA Account Owner. You also can
view the details for the MT 564 message by clicking the reference number of this
screen.

9 UBS Warburg sends an MT 565, Corporate Action Instruction, to EuroClear.

Click Send Corporate Action Instruction with reference number CAXxxxxxxxxxxx. The
Corporate Action sample screen appears with the appropriate information already
entered in the fields.

Note: If you used different BICs to define your profiles for this sample, you must enter
those BICs in the Sender’s BIC and Receiver’s BIC fields.

Corporate Action Instruction Sample

Corporate Action Sample > Corporate Action MNarrative

Corproate Action Instruction MT565 -- Cash Dividend

Trading Parties

Sender's BIC: |ue.5wu53w><><>< Receiver's BIC: IMGTCE.EE.EECL

General Information

Feference Mumber: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Account Owner's Reference Mumber: IEIEIEIEIEIB?E1344

Financial Instrument Details

Financial Instrurnent ISIN number: IISIN IISE7AEA22038

Financial Instrurnent Detail: IT,-i'-.T,-i'-. TEA LTD (REGS

Account Information: IQEIEIEIEI

Foreign Exchange transformation: IGE.F'

Send

10 At the bottom of the screen, click Send.
If the sample runs successfully, the Integration Server displays the confirmation page.
11 To view the message details, click the reference number.
12 To view the actual SWIFT message, click the link at the bottom of the page.
13 In Navigation panel, under the SWIFT heading, click CA Account Servicer.

14 Click Resume the Last Corporate Action Notification, and then click Refresh.
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15 EuroClear sends an MT 568, Corporate Action Narrative, to UBS Warburg.

Click Send Corporate Action Narrative with reference number CAXXXxxxxxxxxx. The
Corporate Action sample screen appears with the appropriate information already
entered in the fields.

Note: If you used different BICs to define your profiles for this sample, you must enter
those BICs in the Sender’s BIC and Receiver’s BIC fields.

Corporate Action Narrative Sample
FIM > Corporate Action Sample > Corporate Action Narrative

Corporate Action Marrative MT568 -- Cash Dividend

Trading Parties

Sender's BIC: IMGTCE-EE-EECL Receiver's BIC: |u55wu53w><><><

General Information

Feference Mumber: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Euroclear Reference Number: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Financial Instrument Details

Financial Instrurnent ISIN number: IISIN IISE7AEA22038

Financial Instrurnent Detail: IT,-i'-.T,-i'-. TEA LTD (REGS

Account Information: IQEIEIEIEI

additional Information:

Send

‘D

16 At the bottom of the page, click Send.

17 To view the message details, click the reference number.

18 To view the actual SWIFT message, click the link at the bottom of the page.
19 In Navigation panel, under the SWIFT heading, click CA Account Servicer.

20 Click Resume the Last Corporate Action Notification, and then click Refresh.
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21 EuroClear sends an MT 566, Corporate Action Confirmation, to UBS Warburg.

Click Send Corporate Action Confirmation with reference number CAXXXXXXXXXxxX. The
Corporate Action sample screen appears with the appropriate information already
entered in the fields.

Note: If you used different BICs to define your profiles for this sample, you must enter
those BICs in the Sender’s BIC and Receiver’s BIC fields.

Corporate Action Confirmation Sample

Corporate Action Confirmation MT566 -- Cash Dividend

Trading Parties

Sender's BIC: IMGTCE-EE-EECL Receiver's BIC: |u55wu53w><><><

General Information

Reference NMurmber: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Euroclear Reference Number: IC.-’-'-.EIEIEIEIEIEB-’-I-EE\HD

Financial Instrument Details

Financial Instrument ISIN Financial Instrument
numnber: IISIN ISa7eb09z2038 Detail: IT,.’.-.,T,.’.-., T

Denominated Currency: IUSD

dccount Infarmation: I'EIEIEIEIEI

Cash/Stock Entitlerment: IStDCk vI

Payment Date: IMa'g,-' 5, 2001

Credit/Dehit; ICredit vI

Payrnent Amount; IlEv?Ei

Yalue Date: |Maﬁ,f 5, 2001

22 At the bottom of the page, click Send.
23 To view the message details, click the reference number.

24 To view the actual SWIFT message, click the link at the bottom of the page.
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Step 7: View the Business Process

To monitor business processes, you can determine the status of your business processes
and the activity of the various involved software entities in a couple of ways:

B Monitor. To view the activity and steps that occurred during the execution of the
process models, audit the business process in Monitor. You can use this tool to
monitor and manage business processes. For more information about webMethods
Monitor 6.0.1, see the webMethods Monitor User’s Guide. For more information about
webMethods Monitor 6.1, see the webMethods Integration Platform Installation Logging
and Monitoring Guide.

B Trading Networks Transaction Analysis screen. To view the transactions of documents
processed by webMethods SWIFT FIN Module, use the Transaction Analysis function in
Trading Networks. You can use this log to query and analyze results of documents
that are sent or received by Trading Networks. For more information about the
Trading Networks Transaction Analysis screen, see the webMethods Trading Networks
User’s Guide.

For more information about monitoring business processes in the webMethods SWIFT
FIN Module, refer to the chapter about monitoring business processes in the webMethods
SWIFT FIN Module Installation and User’s Guide.

View Activity on the Monitor

If the sample was sent successfully, you can use Monitor to find activity/audit log
information for the business process. Monitor’s Recent Activity area displays all business
processes that have run within the last two weeks, organized into sections by status
(Recently Failed, Recently Completed, Recently Created, and Recently Suspended). Each section
lists up to 20 business processes, with the most recent processes listed at the top.

For more information about Monitor and viewing processes, see the documentation for
Monitor. If you are using webMethods Modeler 6.0.1, see the webMethods Monitor User’s
Guide. If you are using webMethods Modeler 6.1, see the webMethods Integration Platform
Installation Logging and Monitoring Guide.

Perform the following steps in Monitor to audit the sample business process.

I o monitor the business process
1 Open Monitor, if it is not already running.

2 In the Monitor Navigation panel, under the Processes heading, click Recent Activity.
Monitor displays all recent processes.
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Recent Activity Screen

Processes
P Recent Activity

Monitor Processes Recent Activity

Search Recently Failed Processes
Errars
Process Models Marne 10
Refresh Process Mames null {11; 1.0.D0039) wmG20926cEa489db4es6f69304db53
null {11; 1.0.00039) wmbc41afid3zZ4208aff694d8a7eb
Services null {11; 1.0.D0039) wm6fdB8aa9c22f28615f6948baa74

Search
Errors
Search d.x

CorphActions AccountServicer 9cf2fof49d10382df6932f98d0
CorpActions AccountServicer 6aBc77c0delGeac?f69321act3
CorpActions AccountServicer 20bael891947c60cf69304d41F
CorpActions AccountServicer 53db54594983ff61f694d8a78d

Documents

Searan Broker null {11; 1.0.00038) wmbfl0dccZeel149c67f54dcDaefe
Search Trading Netwarks null {11; 1.0.D0038) wmbfl0dccZeel149ch7f54dcDaefe
null {11; 1.0.00039) wmb70a2011cd0edl 3b6f54c60bB7a
Accounts null {11; 1.0.D0039) wmb670aZ?011cdied]l 3b6f54c60b87a
Sroup Access null {11; 1.0.00031) wmb68089e62f73cifdlef54d7182c3
User Access null {11; 1.0.D0031) wm68089e62f73c1fdlef54d7182c3
- null {11; 1.0.00039) wmb6695adeS5b1b3bl1872f54c6b4aba
SetLings null {11; 1.0.00039) wm6695adeSb1b3b1872f54c6bdaba

Preferences

3 In the Recently Created Processes section, click one the ID for one of the Corporate
Action processes.

CorphActions AccountServicer a6a715b2115944b2f6948bab70

Recently Created Processes Screen

Recently Created Processes

Marme D Status Tirne Started

CorphActions AccountOwner 1c783af7542b1099f69e6e28b3 Started  Z003-07-03 14:42:4
CorpActions AccountServicer 232fd1323c0c3fa3if69e6e?lsd Started  2003-07-03 14:42:
CorphActions AccountOwner faZffce9ilcda7ec4f69eaf3dib Started  Z2003-07-03 14:41:4
CorpActions AccountServicer 60691c?676ac?fddf69e60e293 Started  2003-07-03 14:41:
CorphActions AccountOwner Sdaf6ea7Z2f1a95dfaf693a82173 Started  2003-07-02 16:41:
CorphActions AccountServicer 10cfldcc4Z2db68bbf693a811c3 Started  2003-07-02 16:40:
CorpActions AccountOwner 54341664125e?e44f693b49cce Started 2003-07-02 16:10:
CorpActions AccountServicer adfZ2a68c71des9d7f693b48561 Started  2003-07-02 16:10:
CorphActions AccountOwner d52914f9a43b7888f6938F35Fd Started  2003-07-02 15:535:
CorpActions AccountServicer 75aa%elacBcfibadfe938fZa4dc Started  2003-07-02 15:55:
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Step 7: View the Business Process

4 Monitor displays the business process, as shown below. A check mark (v ) next to
individual steps on the page illustrates the progress of the business process.

Process Instance Status Screen

Monitor

e Reload Process

Processes

® \Miew Services for this Process

Process Name
Process ID
Parent Process ID
Process Iteration
Status
Timestamp
Conversation ID

Suspend E Stop

Process Instance Status

Process Instance Status

CorpActions_AccountOwner
1c783af7542b1099f69e6e28b3

1
Started
2003-07-03 14:42:41.761 EDT
UBSWUS3NXXX-91000000bidinkou

CorpActions_AccountOwner

F T
Account Servicer

Receive Corporate
Action Motification
MTSE4 fram
Account Setvicer

d.

Send Corporate
Action Instruction
MTEE5 to Account

MTSEZI_“-E,

Action Meszages

@

Wizt For MTS64

3: 8

Inbound alidation
MTS64

Process Offer
Motification

B
E
Wizt for Internal
Instruction

Send Carporate
Action Instruction
MTSES

Outbound Map
MTSES

*ntemal Corparala

Instructi
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The bottom portion of this screen displays the status of individual steps, activity
messages, and information about custom fields.

Bottom of Process Instance Status Screen

Step Status

Marne Status PiBIEEss S Time Ended
Iteration Iteration

Wait forSignal waiting 1 1 000703 135509288

EDT
Wait For Corporate Action Marrative W aitin 1 1 2003-07-03 14:43:05.254
{(MT568) g ECT
Send Corporate Action Instruction 2003-07-03 14:43:03.111
MT565 Completed 1 1 EDT
Outbound Map MT565 Comnpleted 1 1 Egn:g-n?-m szt
Wait for Internal Instruction Completed 1 1 EE)EIFS-D?-DS LA L, e
Process Offer Motification Completed 1 1 EE)EIFS-D?-DS st s,ole
Inbound Yalidation MT564 Completed 1 1 Eg’f'm'm LeiiterLUee
Wait For MT564 Completed 1 1 Eg’f'm'm LEBVEteL,00.0

Activity Messages

Custom Fields

View Transactions via the Trading Networks Console

You can view transactions (that is, the individual documents in the webMethods SWIFT
FIN Module business process) that occurred during the execution of the process by using
Trading Networks. For more information about viewing transactions with the Trading
Networks Console, see the webMethods Trading Networks User’s Guide.

To view transactions using the Trading Networks Console, perform the following steps.

P 1o view transactions via the Trading Networks Console
1 Start Trading Networks, if it is not already running.
2 In the Trading Networks Console, complete one of the following steps:

®  Click the Enterprise radio button to view the data that are associated with
EuroClear, or

B Click the Partner radio button to view the data that are associated with UBS
Warburg.
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Step 7: View the Business Process

3 Select View » Transaction Analysis.

4 If the query panels are not displayed, select Transactions » Show/Hide Query to display
the query panels.

5 Using the query panels, specify the criteria you want to use to search for the
documents within the business process. To use a criterion, you first must select the
check box for the criterion, then fill in related fields. For example, you can search by
selecting the Conversation ID criterion and then entering a valid Conversation ID
number.

Example Transaction Analysis Query

Transaction Analysis: EuroClear

@ | (e8| e B -] f (6 A%

Basic Criteria | Custom Criteria | Detail View | Summary View |

[ Sender: IEurDCIear LI [ Document [0 Ii
[ Receiver: IEurDCIear LI [ Group I Ii
|_ Type: Ilnternal Corpaorate Action Confirmation LI |_ Conversation |0 Ii
[T Processing Status: I LI [ Date Received: Im

[ Lzer Status: I [ Bet
r
Date Received Document Type Sender Receiver Processing Sts
2003-06-30 18:36:44 593 MTSES EuroClear BS Yarburg MEWY
2003-06-30 18:36:39.607 Irternal Corporate Action M. [EuroClear LB Warburg MEW
2003-06-30 158:32:06.493 |r-.-1T5I35 BS Yarburg EuroClear MEWY

6  Select Transactions » Run Query. Trading Networks updates the display in the bottom
panel, as illustrated in the following figure.

Example Transaction Analysis Query Results

Date Received Document Type Sender Receiver Proces=ing 3
2003-06-25 20:37.01 447 Irternal Corporate Action C... |EuroClear LB Warburg MEW
2003-06-27 15:52:59.75 |Ir|terna| Carporate Action C... |EuroClear LB Warburg MEW
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7  To see the contents of a document, click the row for the document, and select
Transactions » View Document. Trading Networks displays the Document Details screen,
as illustrated in the following figure.

Document Details Screen

@ Document Details m

Attributes Activity Log | Tasks |

Parts (3 total)

Mame Lencth Storage Type Storage Reference
wimldata
DFD Data 2,832 tetlx
swifthlzg 675 flat it
B T ittt

Part: xmidata (572 bytes)

="fxml wersion="1.0"7=
=InternalCorporstedctionConfirmation=
<ik=MGTCBEBEECL -55000000jgejdiou=Ad=
=zender=MGTCBEBEECL =fzender=
=receiver=UBSWISIMNE R <ireceiver=
=refhlum=CAD0000253456 3530 rethum=
=euroRefMum=CAD0000234 56 30=/euraRefMum=
=fininztrMum=15IM US57E3692033 < finlnstrMutmn=
=fininstrDetl=TATA TEA LTD (REGS GDE)=HMininstrDetl=
=denCurr=UsD=/dencurr=
=gcctinfo=90000=facctinfo=
=option=SECL=foption=
=payDate=hMay 5, 2001 =hayDate=
=cd=CRED=icd=
=payamount=1676=hay Amount=
=valDate=May 5, 2001 =falDate=
=internalCorporatesctionConfirmation=

OK |
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